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About this publication

This publication describes how a business enterprise that uses SAP R/3 can use
either InfoPrint® Manager for AIX® or InfoPrint Manager for Windows® to manage
its print environment. This document is divided into four parts that you can use to
plan, implement, and print to InfoPrint Manager. Some of these topics repeat
sections of installation procedures. You should determine whether you want to run
an OMS or a non-OMS configuration, and then decide which topics best fit your
installation’s print needs. For a description of the benefits provided by and
configuration tasks associated with an OMS configuration, see “An overview of
SAP R/3 and OMS” on page 11.

Previously, this information was published as InfoPrint Manager: SAP R/3
Configuration and Printing Tasks, a web-only publication.

Who should read this publication

This publication contains information for administrators who create and configure
both the InfoPrint environment and the SAP R/3 environment. We recommend
that users possess a detailed knowledge of an SAP R/3 environment, as well as
experience administering and maintaining either AIX or Windows operating
systems. In addition to using this publication, you should also consult:
v SAP R/3 online documentation whenever appropriate
v InfoPrint Manager for AIX: Installation Instructions for information about installing

the InfoPrint Manager for AIX 4.3 product
v InfoPrint Manager for Windows: Getting Started for information about installing the

InfoPrint Manager for Windows 2.3 product

Once you have installed the appropriate components on both your InfoPrint
server(s) and your SAP server(s), see InfoPrint Manager: Reference for information
about the various InfoPrint commands, utilities, and attributes available to you
while maintaining the system. For more information about the InfoPrint Manager
documentation that is available to you, see “The InfoPrint publication library.”

Most recent information

For the most recent information about InfoPrint Manager, go to the InfoPrint
Solutions Company Web site at http://www.infoprint.com and click Support and
downloads. Select your software product from the Software support list.

The InfoPrint publication library

For the most current information, see the InfoPrint Solutions Company Web site at
http://www.infoprint.com.

InfoPrint Manager common publication library

These publications are common to both InfoPrint Manager for AIX and InfoPrint
Manager for Windows:
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v InfoPrint Manager: SAP R/3 Planning and Configuration Guide, S550-1051. For print
administrators who need to create and configure both the SAP R/3 environment.
we recommend that users possess a detailed knowledge of a SAP R/3
environment, as well as administering and maintaining either AIX or Windows
operating systems. This publication describes how a business enterprise that
uses SAP R/3 can use either InfoPrint Manager for AIX or InfoPrint Manager for
Windows to manage its print environment.

v InfoPrint Manager: Reference, S550-1052. For print administrators, operators, and
application programmers with the need to do command-line functions. This
publication describes the commands, utilities, transforms, attributes, and
attribute values associated with InfoPrint.

v InfoPrint Manager: PSF and Server Messages, G550-1053. This publication lists the
PSF and Server messages and explanations from InfoPrint Manager.

v InfoPrint Manager Print-on-Demand Feature: Submit Express User’s Guide, S550-1054.
This publication is for the user who installs, configures, and uses Submit Express
on a Windows or Macintosh workstation. Although you can use this publication
for general guidance in using Submit Express, you should use the online Help to
find more detailed instructions.

v InfoPrint Job Ticketer: Job Ticketer User’s Guide, S550-1055. This publication is a
guide for using the InfoPrint Job Ticketer Web application. This guide provides
descriptions of tasks and procedures that an end-user needs to know to set up
their workstation to use the application, and then to create, layout, store, retrieve
print jobs, and submit the jobs to a print server for printing.

v InfoPrint Job Ticketer: Administrator’s Guide, S550-1056. This publication is a guide
for system administrators who are responsible for the InfoPrint Job Ticketer Web
application. This guide provides information about the Job Ticketer system
requirements, installation and configuration, system maintenance, security, and
problem determination.

InfoPrint Manager for AIX publication library

InfoPrint Manager for AIX includes publications in PDF format on a CD-ROM
supplied with the product.

The publications for InfoPrint Manager for AIX are:
v InfoPrint Manager for AIX: Introduction and Planning Guide, G550-1060. This

publication gives an overview of InfoPrint Manager for AIX, introduces the
concepts, and helps you prepare to use it. It addresses migration from previous
versions of the product. And it explains the differences between the AIX and
Windows versions of InfoPrint Manager.

v InfoPrint Manager for AIX: Installation Instructions, G550-1059. This publication
describes how to install InfoPrint Manager for AIX 4.3. These instructions
explain the procedures for local and remote installations.

v InfoPrint Manager for AIX: Getting Started, G550-1061. This publication helps you
install and configure InfoPrint Manager for AIX. It focuses on the software
configuration of server and client system.

v InfoPrint Manager for AIX: Configuration and Tuning Guide, S550-1062. This
publication provides information about configuring and tuning the InfoPrint
Manager for AIX, Version 4.3. This book is designed for the InfoPrint Manager
administrator who needs to understand how to configure and tune an InfoPrint
Manager system. It helps administrators to evaluate, develop, and maintain both
a logical and hardware configuration for their environment.
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v Guidelines for Installing InfoPrint Manager for AIX 4.2 in an HACMP Configuration,
G550-1063. This publication helps you install and configure HACMP™ with
InfoPrint Manager for AIX. It also describes how to use HACMP with InfoPrint
Manager for AIX.

v InfoPrint Manager for AIX: Using Generalized Fax, S550-1064. This publication
describes how to configure and use the Generalized Fax support that is included
with InfoPrint Manager for AIX. This publication includes information about
sending and receiving faxes from an InfoPrint Manager server.

v InfoPrint Manager for AIX: Procedures, G550-1066. This publication describes how
to set up an InfoPrint environment, to submit print jobs, to schedule jobs, and to
manage the print environment.

InfoPrint Manager for Windows publication library

InfoPrint Manager for Windows includes publications in PDF format on a
CD-ROM supplied with the product.

The publications for InfoPrint Manager for Windows are:
v InfoPrint Manager for Windows: Introduction and Planning Guide, G550-1071. This

publication gives an overview of InfoPrint Manager for Windows, introduces its
concepts, and helps you prepare to use it. It describes features of this product.
Finally, this publication explains the differences between the AIX and Windows
versions of InfoPrint.

v InfoPrint Manager for Windows: Getting Started, G550-1072. This publication helps
you install and configure InfoPrint Manager for Windows. It focuses primarily
on server and client system software configuration.

v InfoPrint Manager for Windows: Procedures, G550-1073. This publication describes
the primary tasks necessary for setting up an InfoPrint environment, submitting
print jobs, scheduling jobs, and managing the print environment.

Related publications

The related publications are:
v AFP Conversion and Indexing Facility User’s Guide, S550-0436.
v Page Printer Formatting Aid: User’s Guide, S550-0801.
v Using OpenType Fonts in an AFP System, G544-5876.

About this publication xi
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Chapter 1. Overview of the SAP R/3 print feature

This section describes the benefits derived by business enterprises that use SAP
R/3 and either InfoPrint Manager for AIX, Version 4 Release 3, or InfoPrint
Manager for Windows, Version 2 Release 3, to manage their print environments.

InfoPrint Manager and SAP R/3
A large international corporation is committed to an SAP R/3 enterprise to manage
their data processing across all departments. They especially appreciate the SAP
R/3 option provided by InfoPrint Manager. InfoPrint Manager and SAP R/3
combine to provide a robust solution that manages all printing the way SAP R/3
manages and keeps track of their entire business, from external documents sent to
customers, to reports created for internal distribution and printed at the desktop.
Because InfoPrint Manager can manage both the high-end production printers and
the low-end desktop (network) printers, it meets their needs like no other print
application on the market today.

SAP R/3 has become a popular choice for medium to large-sized companies that
require an integrated software product to provide basic business automation. The
R/3 client/server application provides business a series of integrated modules that

Figure 1. SAP R/3 product logo

SAP

R/3 Server

AFP

Resources

InfoPrint Manager

Server

Network Printers InfoPrint 60

Highlight Color

InfoPrint 4000

Figure 2. An InfoPrint Manager SAP R/3 configuration
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span the major functions of finance, manufacturing, sales distribution, and human
resources. InfoPrint’s four decades of experience in printing and data management
translates into billions of pages printed annually in more that 130 countries,
solidifying our leadership position in the enterprise printing environment.
Integrate InfoPrint’s printing expertise with SAP’s leading business application
software for a winning combination.

Reliable notification of job status to SAP users

SAP R/3 (Release 4 and later) provides support to closely integrate an external
Output Management System (OMS) with an SAP system. Both InfoPrint Manager
for AIX and InfoPrint Manager for Windows provide SAP OMS support.

Using InfoPrint Manager SAP OMS support, your SAP users can receive
notifications on the jobs that they have submitted for printing. It also provides
support to allow an SAP user to:
v Cancel one or more jobs
v Query the status of one or more jobs
v Query the status of an InfoPrint printer and its jobs

Adding electronic forms, logos, and electronic signatures to text
documents

The Advanced Function Presentation™ (AFP™) data stream that emerges from the
InfoPrint SAP transform contains text records that you can enhance through the
addition of electronic forms, logos, and electronic signatures. In addition to the
AFP resources, the InfoPrint Manager SAP transform has been enhanced to
support both raw image data (bitmap images) and box shading. The expanded
support for different levels of box shading and the print images that SAP R/3
users have come to expect and appreciate provides a strong, industry standard for
printing from SAP R/3. Print SAP color images in black and white, using the
native Output Text Format (OTF) data stream in either one-, four-, or eight-bit
pixel images: InfoPrint Manager can handle it all. And InfoPrint Manager’s
globalization enablement supports the these scripts:
v Latin
v Japanese (Shift-JIS encoding)
v Korean
v Simplified Chinese
v Traditional Chinese
v Cyrillic

Even if you are printing on PCL and PPDS non-impact printers, the SAP Print
Feature provides benefit by allowing you to print bar codes without installing
expensive bar code SIMMs on each printer. InfoPrint Manager allows a world-class
set of business application modules designed for a client-server environment the
ability to achieve world-class printing.

Reliable management of the print environment
With InfoPrint Manager, you can manage printers and devices from a single point
of control. You can track and manage jobs across your enterprise from job
submission to printed output. When output does not print, operators no longer
have to determine whether a spool request was generated. Instead of having to
walk over to the printer, they can use the InfoPrint Manager graphical user
interface (GUI) to pinpoint where in the process the job is delayed and determine
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the appropriate action to resolve the problem. InfoPrint Manager provides
automatic workload balancing among printers that you have defined with the
same characteristics. For more information about how to configure printers and
monitor printing across an installation, see either InfoPrint Manager for AIX:
Procedures or InfoPrint Manager for Windows: Procedures.

The InfoPrint Manager SAP OMS support also lets you easily:
v Switch the InfoPrint Manager system to which you are sending jobs
v Send jobs to multiple InfoPrint Manager systems
v Failover to other InfoPrint Manager servers in the same InfoPrint Manager

system

Scalability of printing across an enterprise
InfoPrint Manager allows SAP R/3 customers to access the full range of InfoPrint
printers (low-speed to high-speed. simplex or duplex, continuous forms, or cut
sheet) as well as other printers, such as Hewlett-Packard and Lexmark. You can
leverage your investment in printers by sharing your InfoPrint-managed printers
with other host, and LAN-based applications. InfoPrint Manager provides the SAP
R/3 enterprise with comprehensive print management across an enterprise of any
size, providing print integrity through built-in error recovery.

SAP clients and features
InfoPrint Manager provides client support for SAP systems running on AIX,
HP-UX, Linux®, Sun Solaris, and Windows. By installing an InfoPrint Manager
SAP client, you can always print PCL and PostScript® jobs, but to gather the
additional support cited in Table 1, you must install the SAP Print Feature on your
InfoPrint server. The InfoPrint Manager for AIX and the InfoPrint Manager for
Windows SAP Print Features contain both the SAP Output Management support
and the SAP transform that allows SAPGOF device type output to be transformed
to AFP for printing on PCL and IPDS™ printers. The InfoPrint Manager for AIX
SAP Print Feature also includes SAPconnect fax support.

Table 1. SAP Print Feature functions and operating systems

InfoPrint Manager
server systems

OMS support SAPconnect fax support SAPGOF device type
(OTF and ABAP)
Support

AIX yes yes yes

Windows yes no yes

How to use this publication
To make sure that your SAP application servers are correctly integrated with the
InfoPrint server, you must install the InfoPrint Manager SAP client(s) wherever a
Spool Work Process (SWP) is located that will make print requests to InfoPrint
Manager logical destinations. The InfoPrint Manager SAP Clients include
everything needed to be installed on the SAP application servers. In addition, you
need to install the SAP Print Feature on the InfoPrint server or servers.

Note: At a minimum, on every AIX system on which you will be running the SAP
(sap2afp) transform (on your InfoPrint servers), you must have the ipsc-psf.icu.rte
(InfoPrint Manager UCONV) fileset installed.
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This document consists of these four parts:
1. Part 1, “Introduction,” on page 1.

This topic consists of this overview chapter, a review of the publications
available for InfoPrint Manager, and an overview of InfoPrint Manager’s SAP
Print Feature that describes the benefits available to SAP R/3 users.

2. Part 2, “Installing and configuring InfoPrint Manager’s OMS,” on page 9.
This topic provides instructions for installing, configuring, and using InfoPrint
Manager when defined as an Output Management System (OMS) with SAP
R/3, Release 4 and later. The InfoPrint Manager Output Management System
provides enhanced status reporting for SAP R/3 jobs. Your SAP systems can
reside on AIX, HP-UX, Linux, Sun Solaris, or Windows, and you can have
either InfoPrint Manager for AIX or InfoPrint Manager for Windows.

3. Part 3, “InfoPrint Manager non-OMS support,” on page 51.
This topic provides instructions for installing, configuring, and printing to
InfoPrint Manager when not using Output Management System (OMS)
support. Your SAP systems can reside on AIX, HP-UX, Linux, Sun Solaris, or
Windows; your InfoPrint server can reside on either AIX or Windows and SAP
access method L is recommended. You can, however, use access method U
when your SAP applications reside on non-AIX systems, or access method C if
you are submitting jobs from an SAP Windows system to an InfoPrint
Windows server. For more information about these methods, see Appendix B,
“Alternate access methods for submitting SAP jobs to InfoPrint Manager,” on
page 123.

4. Part 4, “Customizing your print environment,” on page 73.
This topic provides additional configuration information that you can either
choose or not choose to implement. The fax options are available only if you
are using InfoPrint Manager for AIX, while the InfoPrint Manager SAP
transform options apply whether you are using InfoPrint Manager for AIX or
InfoPrint Manager for Windows.
InfoPrint Manager provides two distinct methods for providing fax support to
SAP users: either the SAPcomm interface or the SAPconnect interface, as
described in Chapter 14, “Fax support in SAP R/3,” on page 75. The SAPcomm
interface applies to all SAP releases until SAP Web Server Release 6.10 and 6.20,
providing you the ability to send faxes (fax-out) and works with the OMS
support. The SAPconnect interface supports future releases of SAP R/3 and
provides you with the capability to both send (fax-out) and receive (fax-in)
faxes from your SAP user interface, using your InfoPrint Manager AIX server,
but is independent of the OMS support.
You can use the collection of procedures for customizing the InfoPrint Manager
SAP data stream transform (sap2afp) and related SAP R/3 print options that
are described in both Chapter 15, “Print support that applies to both InfoPrint
Manager AIX and Windows servers,” on page 95 and Chapter 16, “Using bar
codes with SAP R/3,” on page 113. These procedures apply for both InfoPrint
Manager AIX servers and InfoPrint Manager Windows servers.

SAP R/3 GUI keyboard shortcuts
Table 2 on page 7 provides a list of keyboard shortcuts that can be used while
doing some of the procedures described in this book. Because this is an InfoPrint
Manager manual, these shortcuts are not a complete list of all options available on
the SAP R/3 GUI for all releases. The SAP R/3 GUI Window(s) column lists
particular windows in the SAP R/3 GUI where these shortcuts work, but does not
imply that the shortcut is exclusive for a particular panel or task. In addition, the

6 InfoPrint Manager: SAP R/3 Planning and Configuration Guide



SAP R/3 GUI might change keyboard shortcuts from release to release. We
recommend that you consult the SAP R/3 online documentation that comes with
the product to verify keyboard shortcuts for your particular SAP R/3 release.

Table 2. SAP R/3 keyboard shortcuts

Shortcut key or combination Task SAP R/3 GUI window(s)
where applicable

F2 Choose (checkmark with a
clock) icon

Spool Administration
windows

F2 Change (pencil) icon SAPconnect: Administration
(view) windows

F5 Events icon Status Description window

F6 Extended Admin.: Spool Administration
windows

F7 View a Node SAPconnect: Administration
(view) windows

F8 Change (red pencil) icon Spool Administration
windows

F8 Query icon Status Description pop-up
window (derived from Spool
Output Requests for Spool
Request XXXXXX)

F8 Test RFC connection RFC Destination dest_name
window

F8 View jobs SAPconnect: Administration
(view) windows

F11 Save RFC Destination dest_name
window

Ctrl + S Save (open folder) icon SAP R/3 GUI

Ctrl + F1 Extended config. (photo film
with two cards
superimposed on top) icon

Spool Administration
windows

Ctrl + F5 Create (piece of paper) icon SAPconnect: Administration
(view) windows

Ctrl + F7 Start the send process to test
sending faxes out

SAPconnect: Administration
view) windows

Ctrl + F10 SAPconnect Test routes SAPconnect: Administration
view) windows

shift + F2 Trash can icon Spool Output Requests for
Spool Request XXXXXX

shift + F5 Transport (truck) icon Spool Admin.: Real Output
Management System

shift + F6 Transport all (truck) icon Spool Admin.: Real Output
Management System

shift + F6 Spool Requests icon Spool Administration: List of
Output Devices window
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Part 2. Installing and configuring InfoPrint Manager’s OMS
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Chapter 2. InfoPrint Manager’s OMS support

SAP R/3 Release 4 and later provides support to closely integrate an external
output management system (OMS) with an SAP system. Both InfoPrint Manager
for AIX and InfoPrint Manager for Windows are SAP OMSs that provide
synchronous functions for submitting jobs, canceling jobs, querying jobs, and
querying devices, as well as asynchronous event information. The InfoPrint
Manager SAP Callback daemon (on AIX) or process (on Windows) collects and
delivers these events to the R/3 system.

Notes:

1. This support is not currently available on an SAP R/3 Release 3 system. If you
are either using an SAP R/3 Release 3 system or do not want to use the OMS
support, see Part 3, “InfoPrint Manager non-OMS support,” on page 51.

2. Support for SAP R/3 Release 3.1h is still available. For more information,
contact your InfoPrint Solutions Company representative.

An overview of SAP R/3 and OMS
The InfoPrint Manager SAP OMS support consists of a command-line interface and
either an SAP callback daemon (on AIX) or an SAP callback process (on Windows)
that logs onto an SAP system and delivers InfoPrint Manager notifications back to
SAP R/3 by making RFCs (remote function calls). As print, cancel job, query job,
and device query requests are made by SAP users, the SAP Spool Work Process
(SWP) invokes the InfoPrint Manager commands. As the job progresses through
the InfoPrint Manager system, notifications are sent back to SAP through the
InfoPrint Manager SAP Callback daemon (sapcbd) or the SAP Callback process
(sapcbd.exe). Only one SAP Callback daemon or process needs to be started for
each SAP system, regardless of how many application servers make up that
system. The SAP Callback daemon or process runs on the same server where
InfoPrint Manager is running.

In InfoPrint Manager for AIX 4.3 and InfoPrint Manager for Windows 2.3, the
InfoPrint Manager SAP Print Feature contains:
v Command-line interface
v SAP Callback daemon (sapcbd) on AIX and the SAP Callback process

(sapcbd.exe) on Windows
v SAPconnect daemon (sapconnectd), which is available on AIX only
v SAP (sap2afp) transform

The InfoPrint Manager SAP Clients contain the command-line interface.

To allow either the sapcbd daemon or the sapcbd.exe process to deliver InfoPrint
Manager notifications to an SAP system, you must install the SAP Print Feature on
at least one system where the InfoPrint Manager servers are running. To allow
SAPGOF device type output (both OTF and ABAP data streams) to be transformed
and processed by InfoPrint Manager, you must install the SAP Print Feature on
every system where InfoPrint Manager actual destinations are going to transform
SAP data.
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To install the SAP Print Feature on an InfoPrint server, see Chapter 9, “Installing
the SAP print feature on the InfoPrint server,” on page 55.

To allow SAP to issue the InfoPrint Manager commands, you must install a
InfoPrint Manager SAP Client on every SAP server where an SAP application
server will issue the commands. This includes every application server with an
SWP managing R/3 devices that have been configured to use the InfoPrint
Manager OMS. If you have configured your SAP R/3 system to use alternate
servers, you must repeat these installation tasks on the alternate servers as well.

To install and configure InfoPrint Manager as an SAP R/3 OMS when SAP:
v Runs on other HP-UX, Linux, or Sun Solaris servers, follow the procedures

described in Chapter 4, “Installing the InfoPrint Manager OMS support when
SAP runs on HP-UX, Linux, or Sun Solaris,” on page 19

v Runs on an AIX operating system, follow the procedures described in Chapter 5,
“Installing the InfoPrint Manager OMS support when SAP runs on AIX,” on
page 23

v Runs on a Windows operating system, follow the procedures described in
Chapter 6, “Installing the InfoPrint Manager OMS support when SAP runs on
Windows,” on page 25

Notes:

1. The SAP Print Feature is available on both InfoPrint Manager for AIX and
InfoPrint Manager for Windows as a separately-priced feature that can be
installed from the InfoPrint Manager: SAP Print Feature CD-ROM, LCD4-5646.

2. The AIX and Windows SAP clients are available to install from the InfoPrint
Manager: Common Clients CD-ROM, LCD4-5642.
The SAP clients for HP-UX, Linux, and Sun Solaris systems are available on the
SAP Print Feature and are specific to either InfoPrint Manager for AIX servers
or InfoPrint Manager for Windows servers.

Note: If you are using an InfoPrint Windows server, use FTP to send the files
to the HP-UX, Linux, or Sun Solaris system before editing the files as described
in “Configuring the SAP system server” on page 21. If you edit the files on a
Windows system, the format will not be correct for the HP-UX, Linux, or Sun
Solaris systems.

3. These procedures presume that you have already installed and configured
InfoPrint Manager on either a separate AIX or Windows server.

4. An SAP OMS interface restriction requires that your InfoPrint server (pdserver)
name be no longer than nine characters.
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Chapter 3. Installing the SAP Print Feature on the InfoPrint
server

To run either an InfoPrint Manager for AIX SAP callback daemon or an InfoPrint
Manager for Windows SAP callback process, you must install the SAP Print
Feature on at least one of your InfoPrint servers, if you have not already done so.

If you are printing either Output Text Format (OTF) or Advanced Business
Application Programming (ABAP) data, make sure that you have installed the
sap2afp transform and the fonts necessary for printing. To install the transform,
you must install the SAP Print Feature on each InfoPrint Manager AIX server or
InfoPrint Manager Windows server with actual destinations that will be
transforming data.

Note: At a minimum, on every AIX system on which you will be running the SAP
(sap2afp) transform (on your InfoPrint servers), you must have the ipsc-psf.icu.rte
(InfoPrint Manager UCONV) fileset installed.

To install the InfoPrint Manager for AIX SAP Print Feature on your AIX server, see
InfoPrint Manager for AIX: Installation Instructions.

To install the SAP Print Feature on your InfoPrint Manager Windows server, follow
the directions under the Installing InfoPrint Manager server software topic in the
InfoPrint Manager for Windows: Getting Started manual. The install program will
guide you through installing the SAP Print Feature from the InfoPrint Manager:
SAP Print Feature CD-ROM, LCD4-5646.

To install the necessary fonts and configure the SAP transform on both the
InfoPrint Manager AIX server and the InfoPrint Manager Windows server, see the
rest of this chapter.

Installing Infoprint fonts for printing with the SAP transform on an
InfoPrint Manager AIX server

To print output from the sap2afp transform, you must install the Gothic fonts that
are specified in the fonts.tab configuration file in the /usr/lpp/psf/bin directory,
as well as the required code pages.
v ABAP data requires raster fonts.
v OTF data can be printed with either raster or outline fonts.

You can obtain these resources from either of these IBM® product CD-ROMs:
v AFP Font Collection: Fonts for AIX, Windows NT®, Windows 2000, and OS/2,

LK2T-9269 (program number 5648-B45). This product includes both raster and
outline fonts. For more information about purchasing this product, see either
your sales representative or access the AFP Font Collection home page
(http://www.printers.ibm.com/internet/wwsites.nsf/vwwebpublished/
afpfonthome_m_ww) on the World Wide Web.

Notes: AFP Font Collection delivers multi-byte fonts on these optional
CD-ROMs:
– Japanese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9276
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– Korean Fonts for AIX, Windows NT, and Windows 2000, LK2T-9278
– Simplified Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9280
– Traditional Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9282

v Infoprint Fonts for Multiplatforms, LCD4-5587 (program number 5648-E77). This
product includes outline fonts only. For more information about purchasing this
product, see either your sales representative or access the AFP Font Collection
home page (http://www.printers.ibm.com/internet/wwsites.nsf/
vwwebpublished/ ipfontshome_m_ww) on the World Wide Web.

Notes: Infoprint® Fonts for Multiplatforms delivers multi-byte fonts on these
optional CD-ROMs:
– Japanese Font Library, LCD4-5589
– Korean Font Library, LCD4-5591
– Simplified Chinese Font Library, LCD4-5593
– Traditional Chinese Font Library, LCD4-5595

To load the fonts that are required to transform OTF or ABAP data from SAP R/3
on an InfoPrint Manager system, use this procedure:
1. Load the appropriate font CD-ROM into the CD-ROM drive on your AIX

server.
2. Create a mount point from which to add fonts from this CD-ROM by typing

smitty cdrfs from the AIX command line and taking this path: CDROM File
Systems --> Add a CDROM File System.

3. Press F4 to set the DEVICE name field to the system-generated name (usually
cd0).

4. For the MOUNT POINT field, specify /cdrom.
5. Press the F10 key to exit SMIT.
6. From the AIX command line, mount the CD-ROM to your RS/6000® by

specifying these two commands in sequence:
a. mount /cdrom

b. cd /cdrom

7. From the AIX command line, specify From the AIX command line, specify
8. For the INPUT device /directory for software field, specify

/cdrom/aix

9. To make sure that you install the correct fonts without over writing any
existing resources on your system, specify no for the COMMIT software
updates? field and yes for the SAVE replaced files? field.

10. Specify the F4 key to list all font options.
11. Use the F7 key to select these four options:

v afpfonts.bookmstr
v afpfonts.compats
v afpfonts.codepage
v afpfonts.ocr

12. To install the fonts, press Enter. These fonts should take approximately 43 MB
on your AIX server.

13. Verify that the fonts cited in your fonts.tab configuration file have been
installed.

14. InfoPrint Manager installs these fonts in the /usr/lpp/afpfonts directory.
15. To remove the IBM AFP Font Collection CD-ROM, specify these two

commands in sequence:
a. cd /cdrom
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b. umount /cdrom

16. Then you can remove the CD-ROM from your CD-ROM drive.

Installing Infoprint fonts for printing with the SAP transform on an
InfoPrint Manager Windows server

To print output from the sap2afp transform, you must install the Gothic fonts that
are specified in the fonts.tab configuration file in the install_path\sap2afp directory,
as well as the required code pages.
v ABAP data requires raster fonts.
v OTF data can be printed with either raster or outline fonts.

You can obtain these resources from either of these IBM product CD-ROMs:
v AFP Font Collection: Fonts for AIX, Windows NT, Windows 2000, and OS/2,

LK2T-9269 (program number 5648-B45). This product includes both raster and
outline fonts. For more information about purchasing this product, see either
your sales representative or access the AFP Font Collection home page
(http://www.printers.ibm.com/internet/wwsites.nsf/vwwebpublished/
afpfonthome_m_ww) on the World Wide Web.

Notes: AFP Font Collection delivers multi-byte fonts on these optional
CD-ROMs:
– Japanese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9276
– Korean Fonts for AIX, Windows NT, and Windows 2000, LK2T-9278
– Simplified Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9280
– Traditional Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9282

v Infoprint Fonts for Multiplatforms, LCD4-5587 (program number 5648-E77). This
product includes outline fonts only. For more information about purchasing this
product, see either your sales representative or access the AFP Font Collection
home page (http://www.printers.ibm.com/internet/wwsites.nsf/
vwwebpublished/ ipfontshome_m_ww) on the World Wide Web.

Notes: Infoprint Fonts for Multiplatforms delivers multi-byte fonts on these
optional CD-ROMs:
– Japanese Font Library, LCD4-5589
– Korean Font Library, LCD4-5591
– Simplified Chinese Font Library, LCD4-5593
– Traditional Chinese Font Library, LCD4-5595

To load the fonts that are required to transform OTF or ABAP data from SAP R/3
on an InfoPrint Manager system, use this procedure:
1. Load the appropriate font CD-ROM into the CD-ROM drive on your InfoPrint

Manager Windows server.
2. If autorun does not start the install, double-click My Computer on your

desktop.
3. From the My Computer window, double-click your CD-ROM drive and then

double-click on the NT folder icon.
4. From the NT folder window, double-click the stapedes executable to begin the

install.
5. Select the drive where you have installed InfoPrint Manager to install these

fonts. For example, if InfoPrint is installed on the D drive, the fonts should be
installed in the D:\afpfonts path.
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6. While we recommend that you use the full installation option, if you select a
customized install, you should be certain to select these four options:
v BookMaster® Fonts
v Compatibility Fonts
v OCR Fonts
v Symbols Fonts

7. To install the fonts, press Next.
When the fonts finish loading, you will see a Font Collection pop-up dialog
with the message:
Installation of Font Collection 2.1.0.1 is complete.

8. Verify that the fonts cited in your fonts.tab configuration file (which is
installed in the install_path\sap2afp directory).
You can use a Notepad editor to both view and change this file.

9. InfoPrint Manager installs these fonts in the install_path\afpfonts directory.
10. Remove the CD-ROM from your CD-ROM drive.

Configuring the SAP R/3 transform

Depending upon the types of data you are printing, you might need to configure
some of the files that are provided with the SAP transform. For example:
v To use form definitions that are mapped to SAP Formats (Paper Types), you

must configure the pagedef.tab file as described in “Changing document print
orientation” on page 96.

v If you have created a new font in an SAP R/3 document, you must configure
the fonts.tab file as described in “Setting up your SAP R/3 system to support
new OTF user fonts” on page 107.

v To expand or shorten the width of a barcode for printing, you must configure
the barcode.tab file as described in “Bar codes and printing from SAP R/3
through InfoPrint Manager” on page 115.

The SAP transform includes two types of files:
v An executable named sap2afp, which converts Output Text Format (OTF) data

into MO:DCA-P output data and Advanced Business Application Programming
(ABAP) list format data into line data. On an InfoPrint Manager AIX server, this
file is installed in the /usr/lpp/psf/bin directory. On an InfoPrint Manager
Windows server, this file is installed in the install_path\bin path.

v Table 3 shows the configuration files that are installed in either the
/usr/lpp/psf/sap2afp directory on an InfoPrint Manager AIX server or the
install_path\sap2afp path on an InfoPrint Manager Windows server.

Table 3. SAP (sap2afp) transform configuration files for AIX

Configuration file Purpose Use

barcode.tab Provides list of valid SAP bar
codes.

OTF data only

xxxxyyyy.tab Maps ASCII code pages to
EBCDIC code pages.

OTF data only

fonts.tab Provides a list of raster fonts
with the appropriate
character set and code page.

OTF data only
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Table 3. SAP (sap2afp) transform configuration files for AIX (continued)

Configuration file Purpose Use

6400fonts.tab Provides a list of raster fonts
that apply exclusively to the
6400 printer, with the
appropriate character set and
code page.

OTF data only

image.tab Defines the dither matrix for
half-tone color print jobs.

OTF data only

pagedef.tab Defines the form definition
(SAP PAPER TYPE) used, as
well as the page definition
and fonts for jobs that go
through ACIF.

ABAP/OTF

pagedef.tab.unicode Processes ABAP files in
Unicode environment.

ABAP data only

pagedef.tab.japan Processes ASCII-encoded
ABAP files containing
Japanese characters in a
non-Unicode environment.

ABAP data only

pagedef.tab.korea Processes ASCII-encoded
ABAP files containing
Korean characters in a
non-Unicode environment.

ABAP data only

pagedef.tab.spchinese Processes ASCII-encoded
ABAP files containing
Simplified Chinese characters
in a non-Unicode
environment.

ABAP data only

pagedef.tab.tdchinese Processes ASCII-encoded
ABAP files containing
Traditional Chinese
characters in a non-Unicode
environment.

ABAP data only

pagedef.tab.cyr Processes ASCII-encoded
ABAP files containing
Cyrillic characters in a
non-Unicode environment.

ABAP data only

defcp.tab Converts ASCII into EBCDIC
characters.

ABAP data only

defcp.tab.unicode Processes ABAP files in
Unicode environment.

ABAP data only

defcp.tab.japan Processes ASCII-encoded
ABAP files containing
Japanese characters in a
non-Unicode environment.

ABAP data only

defcp.tab.korea Processes ASCII-encoded
ABAP files containing
Korean characters in a
non-Unicode environment.

ABAP data only
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Table 3. SAP (sap2afp) transform configuration files for AIX (continued)

Configuration file Purpose Use

defcp.tab.spchinese Processes ASCII-encoded
ABAP files containing
Simplified Chinese characters
in a non-Unicode
environment.

ABAP data only

defcp.tab.tdchinese Processes ASCII-encoded
ABAP files containing
Traditional Chinese
characters in a non-Unicode
environment.

ABAP data only

defcp.tab.cyr Processes ASCII-encoded
ABAP files containing
Cyrillic characters in a
non-Unicode environment.

ABAP data only

userenv Specifies the environment for
the ASCII-encoded ABAP
files

ABAP
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Chapter 4. Installing the InfoPrint Manager OMS support when
SAP runs on HP-UX, Linux, or Sun Solaris

SAP R/3 installations that run on HP-UX, Linux, or Sun Solaris systems work with
InfoPrint Manager when these installations are configured to invoke commands
remotely on the InfoPrint server.

To use the OMS support of the SAP Print Feature with an SAP R/3 system
running on a non-AIX UNIX® system, you must install the SAP feature on the
InfoPrint server and do these tasks:
1. “Configuring the InfoPrint Manager Server”
2. “Configuring the SAP system server” on page 21

Configuring the InfoPrint Manager Server

Follow the appropriate procedure depending on which version of InfoPrint
Manager you are using:
v “Configuring the InfoPrint Manager Windows server”
v “Configuring the InfoPrint Manager AIX server” on page 20

Configuring the InfoPrint Manager Windows server

The rshd and rexecd services are prerequisites for HP-UX, Linux, and Sun Solaris
SAP client support.

Use this procedure to configure the Windows server that has already installed
InfoPrint Manager Version 2 Release 3 with the SAP Print Feature:
1. Install both an rshd and rexecd service on your InfoPrint Manager Windows

server.
While Windows systems natively support both rcp and rexec commands as a
client, you just add these services to make sure that these command requests
are honored by the InfoPrint Manager Windows server. One company which
sells software that provides rshd and rexecd services for Windows is Denicomp
Systems (http://www.denicomp.com).

Note: During the installation of these services, make sure that remote users are
defined users on the InfoPrint Manager for Windows 2.3 system so that it is
possible to write to this server from the Windows SAP client system.

2. From the Start menu, access the Programs → Administrative Tools → User
Manager path.

3. Create a new user named sapuser.

Note: This user does not have to be part of any special groups.
4. Authorize the sapuser userid to issue remote commands by adding this entry

to the .rhosts or equivalent file: +sapuser.
5. Authorize all remote servers running the SAP R/3 applications to specify

remote commands on the InfoPrint Manager Windows server by specifying:
fully_qualified_server_name +
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where fully_qualified_server_name is either the IP address (in dotted decimal
format) or the host name of the server.

Note:

a. If you use a host name, TCP/IP must be able to resolve that name through
either the security file or through a Domain Name Server (DNS).

b. If a DNS is not being used, but the host name is specified in the hosts file,
specify the fully qualified name in the .rhosts or equivalent file.

c. If a DNS is not being used, and the host name is not specified in the hosts
file, you must specify an IP address in the .rhosts or equivalent file (for
example, 172.16.8.10 +).

For added accountability among SAP systems and print jobs, you can create
separate users for each SAP system or SAP R/3 application server. Repeat steps
two through five below to create new user IDs that you can map to each SAP
application server from which you plan to use InfoPrint Manager to print.

Turning off GOCA support on a Windows server

By default, the SAP client requests Graphics Object Content Architecture (GOCA)
support. GOCA is an AFP data architecture used to represent pictures generated by
computer. If your installation uses older printers (for example, 3900 printers as
opposed to InfoPrint 4000 printers), GOCA support can cause the printers to print
at less than rated speed. If your applications do not require GOCA support
features, such as box shading, you might want to improve performance by turning
off the GOCA support.

If your HP-UX, Linux, or Sun Solaris client is connected to an InfoPrint Manager
Windows server, access the ipmcfg file from the directory where you installed
InfoPrint Manager. When you click this file, it displays the IPM Server Settings
dialog. From here, you can click IPM GOCA Support to remove the check.

You can also turn off this support at a later date, as described in “Adding box
shading values to printed output” on page 111.

Configuring the InfoPrint Manager AIX server

Use this procedure to configure the AIX server that has already installed InfoPrint
Manager Version 4 Release 3 with the SAP Print Feature:
1. Add a user called sapuser. This user does not have to be part of any special

groups.
2. Authorize the sapuser userid to issue remote commands by adding this entry

to the /etc/hosts.equiv file:
+ sapuser

3. Authorize all remote servers running the SAP R/3 application to specify remote
commands on the InfoPrint Manager AIX server as sapuser by doing this
procedure:
a. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.
b. Edit the .rhosts file and add a line for each non-AIX server running an SAP

R/3 application with a plus (+) sign appended to it.
If a Domain Name Server is being used, specify the fully qualified name to
the .rhosts file as shown below:
/home/sapuser/.rhosts: sol.infoprint.com +
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If a Domain Name Server is not being used, you must also add the host
name and its IP address to the /etc/hosts file as show below:
/home/sapuser/.rhosts: sol.infoprint.com +
/etc/hosts: 172.16.8.10 sol.infoprint.com +

For added accountability among SAP systems and print jobs, you can create
separate AIX users for each SAP system or SAP R/3 application server. Follow the
three steps specified in this topic to create additional users (like sapuser) that are
mapped to each application server from which you will be using InfoPrint
Manager to print.

For more information about using the rsh and rcp commands to connect to the
InfoPrint Manager AIX server and send files between servers, see your AIX
Operating System documentation.

Turning off GOCA support on an AIX server

By default, the SAP client requests Graphics Object Content Architecture (GOCA)
support. GOCA is an AFP data architecture used to represent pictures generated by
computer. If your installation uses older printers (for example, 3900 printers as
opposed to InfoPrint 4000 printers), GOCA support can cause the printers to print
at less than rated speed. If your applications do not require GOCA support
features, such as box shading, you might want to improve performance by turning
off the GOCA support.

If your HP-UX, Linux, or Sun Solaris client is connected to an InfoPrint Manager
AIX server, go to the AIX server and use this procedure:
1. Access the ipm_submit file that reside in the /usr/lpp/pd/bin directory.
2. Using your AIX editor of choice, comment out the othertoptions="other-

transform-options='-g'"; line by placing a hash mark (#) in front of the line.

You can also turn off this support at a later date, as described in “Adding box
shading values to printed output” on page 111.

Configuring the SAP system server

To allow SAP on HP-UX, Linux, or Sun Solaris to issue the InfoPrint Manager
commands, you must install the InfoPrint Manager SAP Client on every SAP
server where an SAP application server will issue the commands. This includes
every application server with a spool work process (SWP) managing R/3 devices
that have been configured to use the InfoPrint Manager OMS. If you have
configured your SAP R/3 system to use alternate servers, you must repeat these
installation tasks on the alternate servers as well.

Use this procedure to configure remote servers (HP-UX, Linux, Sun) running the
SAP R/3 application so you can print with InfoPrint Manager:
1. Obtain access to each HP-UX, Linux, or Sun Solaris server running SAP R/3

and log on.
2. Verify that you can ping the InfoPrint Manager server by host name:

ping -c 3 hostname

where hostname is the unqualified name for the InfoPrint Manager server, such
as nwser.
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If the response shows that a good communication path exists, you will see
this:
----tcpip_addr PING Statistics----
packets transmitted, 3 packets received, 0% packet loss
round-trip min/avg/max = 7/7/7 ms

3. If you cannot ping the InfoPrint Manager server by host name, edit the
/etc/hosts file and add the host name and IP address of the InfoPrint
Manager server:
/etc/hosts: 9.99.11.109 nwser

4. Create a directory named /usr/lpp/pd/bin:
mkdir /usr/lpp/pd/bin

5. Use the file transfer protocol (FTP) client of your choice to copy either the
/usr/lpp/pd/bin/ipm.omsdesc file from the InfoPrint Manager AIX server or
the install_path\bin\ipm.omsdesc from the InfoPrint Manager Windows server
to at least one of the SAP R/3 servers running the SAP R/3 application.
This file contains the InfoPrint Manager OMS definition that is loaded into the
SAP R/3 System. Make sure that the file is readable by the sysadmin (where
sys is the three-character SAP system name) on the SAP R/3 application
system.

6. Use the FTP client of your choice to copy these files from the InfoPrint
Manager server to an SAP R/3 application server in your configuration. If you
are using an InfoPrint Manager AIX server, these files reside in the
/usr/lpp/pd/bin directory. If you are using an InfoPrint Manager for
Windows server, these files reside in the install_path\bin folder:
v ipm_submit.sys
v ipm_job_cancel.sys
v ipm_job_query.sys
v ipm_dev_query.sys

For the secondary qualifier (sys), specify the name of the system where your
SAP applications are running, hp for HP-UX, linux for Linux, or sun for Sun
Solaris.
If your SAP System Server is running on Linux, you should also copy the
sap_client_lnx.cfg file from the InfoPrint Manager server to an SAP R/3
application server in your configuration.
The sap_client_lnx.cfg file is used to configure the SAP Client for Linux to use
either the rsh or ssh commands. If the configuration file is not found in the
directory where the scripts reside, the scripts will use the rsh command.

7. Make sure that each file copied in step 6 is executable.
8. On the SAP application server in your installation, edit the four files so they

specify the name of the user (sapuser) and host name where InfoPrint
Manager is running.

9. Copy the four edited SAP command files to any other SAP application servers
in your installation that use the InfoPrint Manager server.

10. To complete the configuration, complete the procedures in Chapter 7,
“Configuring and using the OMS,” on page 27.
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Chapter 5. Installing the InfoPrint Manager OMS support when
SAP runs on AIX

To allow SAP on AIX to issue the InfoPrint Manager commands, you must install
the InfoPrint Manager SAP Client on every SAP server where an SAP application
server will issue the commands. This includes every application server with an
SWP managing R/3 devices that have been configured to use the InfoPrint
Manager OMS. If you have configured your SAP R/3 system to use alternate
servers, you must repeat these installation tasks on the alternate servers as well.

To install the SAP Client for AIX on your SAP application servers, use this
procedure:
1. Log into the AIX system as root.
2. Insert the InfoPrint Manager: Common Clients CD-ROM, LCD4-5642 into the

CD-ROM reader.
3. Open a terminal window.

If you are using the Common Desktop Environment (CDE), you can open a
terminal window by clicking on the terminal icon contained in the front panel.
(The front panel is the task bar that appears at the bottom of the screen.) By
default, the terminal icon is contained in a pop-up menu above the text editor
icon that appears on the front panel.

4. The first time you run the Installer, follow this procedure:
a. Type this on the command line:

smit cdrfs

b. Select Add a CDROM File System from the list of choices presented.
c. Click the List button and select your CD-ROM device name (cd0, for

example).
d. Type this in the MOUNT POINT field:

/cdrom

e. Click OK. The running person will raise his arms to indicate success. If he
instead falls down and you see crfs: 0506-909 /cdrom file system
already exists, do not interpret this as a failure. (The existing /cdrom file
system should be usable.)

f. Press the F12 key to exit SMIT.
5. Type this on the command line:

mount /cdrom

6. The SAP Client package (ipr.sapclient) is installed at the command line by
specifying setup —x.
During the course of the install, you are prompted to specify values for both
PDHOST and PD_SOCKET.
These environment variables become effective the next time you reboot the
system. To start using the OMS support without rebooting, edit these four files
that are found in the /usr/lpp/pd/bin directory:
v ipm_submit
v ipm_job_query
v ipm_job_cancel
v ipm_dev_query

Locate and uncomment the lines:
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#export PDHOST
#export PD_SOCKET

Specify the same values that you specified during the install.

For another way to specify or change the InfoPrint Manager host and socket
information to point to another InfoPrint Manager system or server, see “Switching
InfoPrint Manager servers” on page 41. You can also provide a failover connection
to another InfoPrint Manager server in the same InfoPrint Manager system
(see“Failing over to other servers in the same InfoPrint Manager system” on page
43 ) and how to send jobs to more than one InfoPrint Manager system at the same
time (see “Supporting multiple InfoPrint Manager systems” on page 38).

Notes:

1. The SAP Client package cannot be installed if other ipr* filesets reside on an
SAP application server.

2. If your installation uses older printers (for example, 3900 printers instead of
InfoPrint 4000 printers), the GOCA support can cause the printers to print at
less than rated speed. If your applications do not require GOCA support
features, such as box shading, you might want to improve performance by
turning off the GOCA support. For instructions on turning off this support after
installing the SAP Client, see “Adding box shading values to printed output”
on page 111.

To complete the configuration, complete the procedures described in Chapter 7,
“Configuring and using the OMS,” on page 27.
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Chapter 6. Installing the InfoPrint Manager OMS support when
SAP runs on Windows

To allow SAP on Windows to issue the InfoPrint Manager commands, you must
install the InfoPrint Manager SAP Client on every SAP server where an SAP
application server will issue the commands. This includes every application server
with an SWP managing R/3 devices that have been configured to use the InfoPrint
Manager OMS. If you have configured your SAP R/3 system to use alternate
servers, you must repeat these installation tasks on the alternate servers as well.

To install the InfoPrint Manager SAP Client for Windows on your Windows SAP
system, use this procedure:
1. Log in as the Administrator user.
2. Insert the InfoPrint Manager: Common Clients CD-ROM, LCD4-5642 into your

CD-ROM drive.
3. From the InfoPrint Manager: Common Clients window, click Install InfoPrint

Manager Products.
4. Click InfoPrint Manager SAP Clients.
5. Select a location for installing the clients (the default is install_path \Infoprint

Manager SAP Clients\).
6. From the IPM Server Settings pop-up dialog, specify either the fully qualified

host name or the IP address of the InfoPrint Manager server to which you will
be sending jobs. The IPM Hostname field defaults to showing the loop back
address and must be changed.
The IPM Server Port Number field defaults to 6874, which you do not need to
change.
For another way to specify or change the InfoPrint Manager host and socket
information to point to another InfoPrint Manager system or server, see . You
can also provide a failover connection to another InfoPrint Manager server in
the same InfoPrint Manager system (see “Failing over to other servers in the
same InfoPrint Manager system” on page 43 ) and how to send jobs to more
than one InfoPrint Manager system at the same time (see “Supporting multiple
InfoPrint Manager systems” on page 38).

Notes:

a. Do not check the IPM Debug Mode checkbox unless instructed to do so by
technical support.

b. Remove the check in the IPM GOCA Support checkbox only if you want to
turn off GOCA support in the SAP transform.
By default, the SAP client requests Graphics Object Content Architecture
(GOCA) support. GOCA is an AFP data architecture used to represent
pictures generated by computer. If your installation uses older printers (for
example, 3900 printers instead of InfoPrint 4000 printers), the GOCA
support can cause the printers to print at less than rated speed. If your
applications do not require GOCA support features, such as box shading,
you might want to improve performance by turning off the GOCA support.
For instructions on turning off this support after installing the SAP Client,
see “Adding box shading values to printed output” on page 111.

Once you have set the appropriate values, click OK to close this dialog.
7. When the SAP client has been installed, click Finish.
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8. To exit the install process, click Back, and then Exit maon the next screen.
9. To complete the OMS configuration, complete the tasks in Chapter 7,

“Configuring and using the OMS,” on page 27.
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Chapter 7. Configuring and using the OMS

These sections describe how you can configure, customize, and use your SAP R/3
InfoPrint Manager environment to report enhanced job status that meet the
particular criteria of your installation.

The first set of topics (“Required configuration tasks” ) must be done on both the
SAP application servers and the InfoPrint Manager servers for enhanced status
reporting to work correctly. The second set of topics (“Using OMS support tasks”
on page 34 ) describes how to use the OMS to get more information about your
print jobs, including obtaining job status, device status, and the capability to cancel
jobs. The third set of topics (“Optional OMS configuration tasks” on page 36 )
cover a variety of useful administration functions, including:
v “Activating end-user pop-ups” on page 36
v “Selecting event report levels” on page 37
v “Organizing OMS output devices into LOMSs” on page 37
v “Moving OMS definitions among SAP systems” on page 40
v “Switching InfoPrint Manager servers” on page 41
v “Failing over to other servers in the same InfoPrint Manager system” on page 43
v “Customizing an SAP daemon error log on AIX” on page 45
v “Customizing an SAP callback process error log on Windows” on page 46
v “Shutting down the callback daemon on AIX” on page 47
v “Shutting down the callback process on Windows” on page 48
v “Deleting an SAP callback process on Windows” on page 48

Use these topics with relevant SAP R/3 online product documentation.

Required configuration tasks

This section consists of the required configuration tasks that you must do to
receive OMS callback reports.

When you finish defining the InfoPrint Manager OMS to your SAP R/3 system,
you can define devices so you can print or fax from SAP R/3 with InfoPrint
Manager as described in “Defining devices for InfoPrint Manager that use the
InfoPrint OMS” on page 33.

Defining the InfoPrint Manager OMS to SAP R/3 on the SAP
system server

InfoPrint Manager provides a configuration file (ipm.omsdesc) to assist in defining
InfoPrint Manager as an OMS on your R/3 system. These two procedures are
performed on your SAP application server to:
v Define InfoPrint Manager as a real output management system (ROMS) for your

SAP R/3 installation
v Define your first logical output management system (LOMS) so you can define

access method E devices in SAP R/3

Defining a real output management system

Use this procedure to define a real output management system (ROMS) for SAP
R/3:
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1. Log onto your SAP R/3 Release 4 or later system.
2. Import the InfoPrint Manager OMS configuration file by entering transaction

SA38.
3. From the ABAP: Execute Program window, specify RSPOXOMS in the Program

field and click Execute (checkmark with a clock).
4. From the Spool: Saving and Loading of Definitions window, do one of these

tasks:
v If configuring for SAP on UNIX, make these changes to the Spool: Saving

and Loading of Definitions window:
– Specify /usr/lpp/pd/bin/ipm.omsdesc in the Export/Import file name

field.
– Set the File system info pane to Server.
– Set the Operation pane to Import.
– Check both the Execute import and Generate log options in the Options

pane.
Once you have set these options, click Execute (checkmark with a clock).

v If configuring for SAP on Windows, make these changes to the Spool: Saving
and Loading of Definitions window:
– Make sure that the Operation pane is set to Import.
– Specify C:\Program Files\IBM\InfoPrint Manager SAP

Clients\ipm.omsdesc in the Export/import file name field.
– Make sure that the File system info pane is set to Frontend computer.
– Check both the Execute import and Generate log options in the Options

pane.
Once you have set these options, click Execute (checkmark with a clock).

5. Running the report displays a list of the ROMS and LOMS that have been
imported into the system.

Defining a logical output management system

Use this procedure to define a logical output management system (LOMS) for SAP
R/3:
1. From the SAP R/3 graphical user interface, complete the logical output

management system definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin

and click Logical OMS from the Output management systems pane to obtain a
list of the logical output management systems (LOMS) available on your
installation.

3. From the Spool Administration: List of Logical Output Management Systems
window, select the IPM001 LOMS and click Choose (checkmark with a clock).

4. From the Spool Administration: Logical Output Management (Display)
window, click Change (red pencil).

5. From the Spool Administration: Logical Output Management (Change) window
on the SAP Configuration tab:
v Select a value from the pulldown list of all SAP application servers for both

the Tasking target field and the Callback target field in the format:
hostname_systemname_instanceID, such as sap12_MBS_00.
The Tasking target field, specifies where the commands are invoked, while
the Callback target field specifies where the asynchronous callbacks are
delivered.
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v Click Extended config. (photo film with two cards superimposed on top)
icon and specify a value for the Event report level field in the SAP
configuration pane.

Note: Once you click Extended config., it disappears from the view and the
Event report level field is always displayed.
You must select one of these values:
– Final messages
– Also problems
– Also warnings
– Also status changes
– Also information
– All information options

In earlier versions of the SAP GUI, the Event report level field consists of
numeric message levels. For the earlier SAP GUI, use the down arrow to
determine the message level you want (1 is the least and 5 is the most).

6. To make sure that users on your SAP R/3 system receive pop-up windows for
both problem and completion notification messages about a job’s status, check
the Status dialog box field in the Jobs pane.

Note: Until SAP R/3 Release 4.5B, the pop-up message is always reported only
to users in the client where the OMS callback daemon has logged on. You
defined this client when you “Defining an SAP user for the OMS callback
daemon or process.” Beginning with SAP R/3 Release 4.5B, SAP delivers
asynchronous pop-ups to users who are logged onto any SAP client.

7. From the OMS Configuration tab, you can specify how often (Send period
field) in seconds or how many (Number of events field) notification events the
InfoPrint Manager callback daemon should collect before delivery to the SAP
R/3 system. In other words, the callback daemon will only deliver events for
jobs on printers associated with this LOMS if it has collected x number or x
seconds have passed since the last delivery.

8. Save this information by clicking Save (diskette) icon.
9. Now you can use the SAP GUI for “Defining an SAP user for the OMS callback

daemon or process.”

Defining an SAP user for the OMS callback daemon or
process

Because the OMS callback daemon must logon to the SAP system and its external
management interface (XMI) to make RFC requests, you must define a user for it.
You will need this user information when “Starting the SAP callback daemon or
process” on page 30.

The user should be a CPIC (or System) type and requires XOMI permissions to log
into the CCMS system management XOM application programming interface.
These authorizations can be provided in the S_XMI_XOM_A profile.

Note: If you ever change or modify this SAP user, remember to make the changes
where the SAP callback daemon is running:
v If on InfoPrint Manager for AIX, edit the rc.iprsap file in the /etc directory
v If on InfoPrint Manager for Windows, use the InfoPrint Manager Management

Console to left-click SAP Callback Processes from the Objects view. This step
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lets you access the SAP Callback Processes in the main view. From the main
view, you can right-click and select Open.

Collecting information necessary to start an SAP callback
daemon or process

This tables display the variables needed to start an SAP callback daemon or
process. All variables in the tables are examples and will differ from values that
you specify, unless otherwise noted. These variables are grouped into two
categories:
1. SAP R/3 instance where the callback daemon logs on

Table 4. SAP R/3 instance where the callback daemon or process (sapcbd) logs on

Variable Explanation

MBS The three-character system name

sap12 The host name

00 The instance ID

Note: If you are starting multiple SAP callback daemons and SAP callback
processes to run on different SAP application servers, you must make sure that
there is a unique SAP R/3 instance (system name, host name, and instance ID)
for each SAP callback userid as shown in Table 5.
If you don’t know what values you can specify for these variables, you can
refer to the drop-down list for the Callback target field from the Spool
Administration: Change Logical Output Management System window (for an
example, see step 5 on page 28 of “Defining a logical output management
system” on page 28).

2. Callback daemon or process user ID information

You defined the information for Table 5 when you did the step described in
“Defining an SAP user for the OMS callback daemon or process” on page 29.

Table 5. Callback daemon or process user ID information

Variable Explanation

infoprint The User value. This value and the two that
follow were originally defined when you
created an SAP userid for the OMS callback
daemon.

030 The Client value

newname The Password value

En The Language value: in this example,
English
Note: If you are creating an SAP callback
process on Windows, this value is not
required.

Starting the SAP callback daemon or process

Each SAP R/3 system using the InfoPrint Manager callback support needs to have
one callback daemon running. If your callback support runs on an InfoPrint AIX
server, you must do both of these procedures:
v “Starting the SAP callback daemon on AIX” on page 31
v “Configuring to start callback daemons at system reboot on AIX” on page 31

30 InfoPrint Manager: SAP R/3 Planning and Configuration Guide



If your callback support runs on an InfoPrint Manager Windows server, you must
complete the “Starting the SAP callback process on Windows” on page 32
procedure.

Note: If your logical destination does not receive a job sent from your SAP device,
delete and recreate the SAP callback daemon with the same settings on the
InfoPrint Manager server.

Starting the SAP callback daemon on AIX

To start the SAP callback daemon, you must edit and run the /etc/rc.iprsap file
from the AIX command line from your InfoPrint Manager AIX server.
1. From the AIX command line, access the rc.iprsap file in the /etc directory. Edit

the file to copy and uncomment these two lines of code for callback daemons:
a. An echo statement that states that the callback daemon has been started:

echo Starting sapcbd SystemName

b. The startcbd command at the top of the file (see “Defining an SAP user for
the OMS callback daemon or process” on page 29):
/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User \
Client Password Language

Note: This file also contains two lines of code for starting the SAPconnect
daemon. For more information, see “Configuring the SAPconnect daemon
on InfoPrint Manager” on page 84.

2. Specify the same values for the items in italics that you collected in “Collecting
information necessary to start an SAP callback daemon or process” on page 30.

3. Verify that you can ping the SAP server by host name:
ping -c3 hostname

where hostname is the unqualified name for the SAP server, such as nwser.
If you cannot ping the SAP server by host name, edit the /etc/hosts file and
add both the host name and the IP address of the SAP server (for example,
9.99.11.109 nwser).

4. Once you have saved and exited the file, start the SAP callback daemon from
the command line by specifying:
/etc/rc.iprsap

If the callback daemon has started correctly, you should see this response:
0 Successfully\started\SAPCBD

If you receive any other message, the daemon has not started correctly. To
resolve the problem, refer any messages displayed in either the message
column or by selecting the Server Log object from the left pane of the InfoPrint
Manager Management Console to access the Server Log view. Correct the
problems cited, and try to start the callback daemon again. If it still does not
start correctly, contact your InfoPrint Solutions Company technical support
representative.

Configuring to start callback daemons at system reboot on AIX

The SAP callback daemon needs to run all the time. A monitor makes sure that it
is restarted if it ever stops after it is started. However, to make sure that both the
daemon and its monitor are restarted if the AIX system that it runs on is rebooted,
you need to do one more step to add the rc.iprsap file to the /etc/inittab directory.
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To make sure that the SAP callback daemon(s) are restarted automatically
whenever the system they are running on is restarted, use the InfoPrint SMIT
interface on your InfoPrint Manager AIX server: InfoPrint Solutions → InfoPrint
Utilities → SAP Daemons.

From the SAP Daemons panel, select the Start SAP daemons at reboot option.

If you prefer the command line, you can enter this at the AIX command line
instead:
mkitab "rciprsap:2:once:/etc/rc.iprsap.out 2>&1 # Autostart of Infoprint sapcbd"

Both the SMIT interface and this command make sure that the SAP daemons
(sapcbd) are restarted automatically whenever the systems they are running on are
restarted.

As you add more callback daemons to your InfoPrint configuration, you do not
have to do this step, but you do need to add a new entry in the /etc/rc.iprsap file
and type /etc/rc.iprsap on the command line. Your new callback daemons will
start and any SAP callback daemons that are already running will report that they
are running.

Starting the SAP callback process on Windows

Each SAP R/3 system using the InfoPrint Manager callback support needs to have
one callback process running. To start the SAP callback process on an InfoPrint
Manager Windows server, you must access the SAP Callback Processes from the
InfoPrint Manager Management Console.

The SAP Callback Processes object is only visible if you have installed the
optional InfoPrint Manager: SAP Print Feature, LCD4-5646.
1. Verify that you can ping the SAP server by host name:

a. From a either a Command or a Command Prompt window, specify ping
hostname, where hostname is the unqualified name for the SAP server, such
as nwser.

b. If you cannot ping the SAP server by host name, edit the Hosts file in the
C:\WINNT\system32\drivers\etc folder and add both the host name and
the IP address of the SAP server (for example, 9.99.11.109 nwser).

2. From the Start menu, select Programs → InfoPrint Manager → Management
Console.

3. Right-click SAP Callback Processes in the Objects view in the left pane of this
window and click New.

4. Specify the values that you gathered in “Collecting information necessary to
start an SAP callback daemon or process” on page 30, click OK, and wait.

5. If the callback process has started correctly, the main panel should show a state
of RUNNING.
v If the state shows Failed To Start, the process has not started correctly. To

resolve the problem, if the message displayed does not provide enough
information to correct the problem, you can switch to the Server Log view
for additional messages.

v See “Expanding server ports for SAP callback processes” on page 33 if you
receive this message:
5010-760: There are no available port numbers
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v For all other messages, correct the problems cited, and try to start the
callback process again. If it still does not start correctly, contact your
InfoPrint Solutions Company technical support representative.

Note: If you are running the callback process on InfoPrint Manager for Windows,
you do not need to configure to start SAP Callback Processes on a system reboot
because at reboot the InfoPrint Manager SAP service is always started and the
service will restart any SAP callback process that was not manually stopped.

Expanding server ports for SAP callback processes:

Creating and managing SAP callback processes on your InfoPrint Manager for
Windows server might require that you increase the number of server
communication ports available on your system. This procedure shows how to do
this task.

Use this procedure to increase the number of server ports available on your
InfoPrint Manager for Windows server.
1. From the InfoPrint Manager Management Console, stop the InfoPrint Manager

server by selecting File → Stop Server from the main menu.
2. Select Edit → Service Configuration → Communication Ports.
3. In the Server Interface Ports field, increase the range to include twenty ports

and save your results.
The server interface ports default values range from 6880 to 6889. To make sure
that you have enough server communication ports for all SAP callback
processes, you should increase the final number in the range to 6899.

4. Use the InfoPrint Manager Management Console to start the InfoPrint Manager
server by selecting File → Start Server from the main menu.

Defining devices for InfoPrint Manager that use the InfoPrint
OMS

Use this procedure to define devices to SAP R/3. For more information, consult the
“Connecting a Printer to an External Output Management System” topic in the
SAP R/3 online documentation.
1. Make sure that you have a logical destination defined in InfoPrint Manager

that sends jobs to your actual destination device.
2. From the SAP R/3 graphical user interface, specify the spad transaction.
3. From the Spool Administration: Initial screen (Change) window:
v Click Devices/servers

v Click Output devices

v Click Create next to the trash can icon
4. From the Spool Administration: Create Output Device window, fill in these

pieces of information for device attributes and access method:

Field Explanation Example value

Output device Specify a long name for the
device.

Device Number 1

Short name Specify a short name.
Note: Optionally, you can
allow the system to generate
a short name.

DEV1

Chapter 7. Configuring and using the OMS 33



Field Explanation Example value

Device type Specifies the driver that
generates the output data
stream.

SAPGOF

Host printer Specify the InfoPrint
Manager logical destination.

printer-ld

Access method to host spool Make sure you specify this
Access Method.

E

LOMS Specify the LOMS to which
this device should be
assigned. You specified this
value on the Spool
Administration: Logical
Output Management System
window under Define the
InfoPrint Manager OMS to
SAP R/3.

IPM001

Spool server Select an applicable spool
server from the entries list on
the field.

sap12_MBS_00

5. Save this information by clicking on the Save (diskette) icon, then exit the
interface.

Once you have saved these changes, you have a device that will print to InfoPrint
Manager using Access Method E.

Note: If your logical destination does not receive a job sent from your SAP device,
delete and recreate the SAP callback daemon with the same settings on the
InfoPrint Manager server.

Once you have defined this device to send jobs to InfoPrint Manager, you can do
these tasks:
v “Viewing enhanced job status, job events, and querying jobs”
v “Displaying device status” on page 35
v “Canceling jobs” on page 35

Using OMS support tasks

This section contains the procedures that are available once you have configured
your SAP OMS to obtain job status about your print environment.

Viewing enhanced job status, job events, and querying jobs

This procedure describes OMS support for obtaining information about a print job
sent to InfoPrint Manager. By using this feature, you can see asynchronous events
and synchronous queries about jobs reported to your SAP R/3 system.

To view the status of an output request, use this procedure from the SAP R/3
graphical user interface:
1. From the Output Requests for Spool Request xxxxxx window (where xxxxxx

refers to the SAP spool ID), double-click the output request you want to view
in the Status column on the far right.
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2. From the Status Description pop-up window, you can see current information
about the job, including the last event received.

3. Click Events on the Status Description window to get the Events for Output
Requests window. From the Events for Output Requests pop-up window and,
you can view all the events concerning this job.
This Events for Output Requests pop-up window is displayed twice to show
(1) the right side of the window with the date, time, and current status of the
job, and (2) the left-side of the window with its message text.

4. From the Status Description pop-up window, you can also click Query and
issue a query to return the current information for a job, including its position
in the queue. For example, the Status Description window displays the result of
a query for a job that has been successfully submitted for printing. Notice that
the first line shows the job’s position in the print queue.
When you close this query Status Description window, the system updates the
latest status for that job in other displays.

Displaying device status

To display the status of InfoPrint Manager printers and the queue of jobs that have
been sent to an InfoPrint printer, use this procedure from the SAP R/3 graphical
user interface:
1. From the R/3 main menu, access the Spool Administration: Initial Screen

window by selecting the Tools main menu and then selecting the Tools →
Administration → Spool → Spool Administration path or typing /nSPAD in the
ok-Code field.

2. From the Spool Administration: Initial Screen window, click Output devices
from the Configuration area.

3. From the Spool Administration: List of Output Devices window, do this:
a. Highlight your InfoPrint printer from the Devices column.
b. Click the Output device pull-down menu and select Choose.

4. From the Spool Administration: Change Output Device (Display) window, click
External jobs.

5. The Device Information of Host Spool pop-up window displays the status of
this device.
The Device Information of Host Spool pop-up window is displayed twice to
capture both the right and the left sides. (1) This section indicates that there are
six jobs in the InfoPrint Manager queue, two of which are being processed by
printers. (2) This section shows information about each job, including its
current status in InfoPrint Manager.

Canceling jobs

This procedure describes how you can cancel SAP print jobs that you have sent to
the InfoPrint Manager AIX server. Use this procedure from the SAP R/3 graphical
user interface. This procedure provides only one of many methods for accessing
the Spool Output Requests for Spool Request XXXXXXXXXX window, where
XXXXXXXXXX is the number of your SAP spool request.
1. From the R/3 main menu, access the Spool Administration: Initial Screen

window by typing /nspad in the ok-Code field.
2. From the Spool Administration: Initial Screen window, click Output devices

from the Configuration area.
3. From the Spool Administration: List of Output Devices window, do this:
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a. From the Devices column, use the mouse to highlight the SAP device that
you used to send your job to InfoPrint Manager.

b. Click Spool Requests .
4. From the Spool Requests for Device XXX window (where XXX is the name of

the device that you selected), double-click the spool request of the output
request that you want to cancel.

5. From the Spool: Attributes window, click Output requests.
6. From the Spool Output Requests for Spool Request XXXXXXXXXX window

(where XXXXXXXXXX is the number of your SAP spool request), click the
output request you want to cancel to highlight it and then click the trash can
icon to delete the output request from InfoPrint Manager.
This step invokes the InfoPrint Manager command for canceling a job (pdrm).

Optional OMS configuration tasks
These sections describe useful administrative functions, including ways of
configuring your OMS to improve performance. Be sure to consult your SAP R/3
Release 4 documentation with any procedures described in this section.

Activating end-user pop-ups

InfoPrint Manager delivers information to SAP R/3 about output requests (print
jobs) as they process. SAP will alert job owners about problem and job completion
information delivered from InfoPrint Manager through end-user pop-up messages.

Note: Until SAP R/3 Release 4.5B, the pop-up message is always reported only to
users in the client where the OMS callback daemon has logged on. You defined
this client when you “Defining an SAP user for the OMS callback daemon or
process” on page 29. In SAP R/3 Release 4.5B, SAP delivers asynchronous pop-ups
to users who are logged onto any SAP client.

To activate this support, make sure that you have done these steps while installing
and configuring InfoPrint Manager with SAP R/3:
1. From the SAP R/3 graphical user interface, modify the logical output

management system (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin

and click Logical OMS from the Output management systems pane to obtain a
list of the logical output management systems (LOMS) available on your
installation.

3. From the Spool Administration: List of Logical Output Management Systems
window, select IPM001 LOMS or another appropriate LOMS and click Choose.

4. From the Spool Administration: Logical Output Management (Display)
window, click Change.

5. From the Spool Administration: Logical Output Management System window
that is displayed below, check the Status dialog box field in the Jobs pane and
save the changes.

6. Once you have specified this setting, information from the InfoPrint Manager
sent back to your SAP R/3 application server will be delivered in the form of a
pop-up window. For example, if an output request was canceled, a pop-up Info
window should appear on the output requesters’ SAPGUI.
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Note: All pop-up window text is scrollable, however an SAP R/3 limitation
limits the text of the InfoPrint Manager messages (as well as those received
from any OMS) to 50 characters.

Selecting event report levels

This procedure describes how you can specify the level of events that the callback
daemon reports for jobs submitted through InfoPrint Manager:
1. From the SAP R/3 graphical user interface, modify the logical output

management system (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin

and click Logical OMS from the Output Management Systems pane to obtain a
list of the logical output management systems (LOMS) available on your
installation.

3. From the Spool Administration: List of Logical Output Management Systems
window, select IPM001 LOMS and click Choose (checkmark with a clock).

4. From the Spool Administration: Logical Output Management (Display)
window, click Change (red pencil).

5. From the Spool Administration: Logical Output Management (Change) window
displayed below, specify a value for the Event report level field in the SAP
configuration tab. Use the menu field to select the most appropriate value for
your installation.
When you have finished, be sure to save your changed LOMS definition by
clicking the Save folder icon.

Organizing OMS output devices into LOMSs

While you can assign all of your R/3 OMS output devices to a single logical
output management system (LOMS), it might be useful to group output devices
into separate LOMS, each with different SAP devices assigned to them. After you
define one or more LOMS on your system (see “Defining another logical output
management system”), you can assign different SAP devices to each one,
depending on the functions they perform, such as:
v “Using different report levels or event delivery criteria” on page 38
v “Using different OMS services” on page 38
v “Distributing the callback workload” on page 38
v “Supporting multiple InfoPrint Manager systems” on page 38

Defining another logical output management system

Use this procedure to define another logical output management system for SAP
R/3:
1. From the SAP R/3 graphical user interface, copy a logical output management

system (LOMS) definition by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin

and click Logical OMS from the Output Management Systems pane to obtain a
list of the logical output management systems (LOMS) available on your
installation.

3. From the Spool Administration: List of Logical Output Management Systems
window, click Change (red pencil).

4. From the Spool Administration: List of Logical Output Management Systems
(Change) window:
a. Highlight the Name field of the LOMS from which you want to copy.

Chapter 7. Configuring and using the OMS 37



b. Specify the Logical OMS → Create using template path.
c. From the Spool Administration: Copy Logical OMS from OMS_Name

window, specify the name for your new LOMS in the Logical OMS field
and click the Save (Diskette) icon.

5. By returning to the Spool Administration: List of Logical Output Management
Systems window, you can see your new LOMS displayed.

Using different report levels or event delivery criteria

You can define LOMSs to specify different report levels on the Spool
Administration: List of Logical Output Management Systems (Change) window, as
described in “Selecting event report levels” on page 37. On the second screen of
this same window, you can also define LOMSs to specify different Event Delivery
Criteria. This allows you to determine how often and how many events are
delivered together by the callback daemon to your SAP system. Before
implementing this feature, consult both “Defining another logical output
management system” on page 37 and the online documentation about LOMS that
is provided with your SAP R/3 system.

Using different OMS services

You can define LOMSs to allow for the use of different OMS services by a group of
printers. For example, you can restrict access to a particular ROMS feature like job
cancellation. By creating a LOMS and turning off job cancellation, you can prevent
SAP R/3 users from deleting output requests that are sent to the devices of the
LOMS. Before implementing this feature, consult both“Defining another logical
output management system” on page 37 and the online documentation about
LOMS that is provided with your SAP R/3 system.

Distributing the callback workload

You can define separate LOMSs to distribute the workload of processing status
reports from the InfoPrint callback daemon. For each LOMS, specify a different
R/3 server as the callback target. Before implementing this feature, consult
both“Defining another logical output management system” on page 37 and the
online documentation about LOMS that is provided with your SAP R/3 system.

Supporting multiple InfoPrint Manager systems

InfoPrint Manager provides you with the ability to send jobs to multiple InfoPrint
systems from the same SAP system. An InfoPrint Manager system consists of one
or more InfoPrint Manager servers residing on either the same or different
machines that are set up to interoperate by sharing the same namespace. If your
print installation is large, with many printers distributed across a wide area and
managed by different InfoPrint Manager systems, this function can help you to
manage your installation more efficiently by defining separate LOMS to send jobs
to separate systems.

You can implement this support by using the SAP GUI to add an optional flag
with values in the form host:socket to your InfoPrint Manager OMS commands:
ipm_submit, ipm_dev_query, ipm_job_query, and ipm_job_cancel.

host represents the host name where the InfoPrint server is running and socket the
socket for the InfoPrint server on that host.
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Using the procedure described in “Defining another logical output management
system” on page 37, you can define a new LOMS for every InfoPrint Manager
system to which you want to send jobs. For example, in the procedure below, you
might want to create an LOMS1 and an LOMS2, one for each InfoPrint Manager
system to which you want to send jobs. In Figure 3, LOMS1 points to the New
York system, while LOMS2 points to the London system.

To modify the OMS commands from your SAP GUI, use this procedure:
1. From the SAP R/3 graphical user interface, modify the logical output

management system (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin

and select Logical OMS from the Output Management Systems pane to obtain
a list of the logical output management systems (LOMS) available on your
installation.

3. From the Spool Administration: List of Logical Output Management Systems
window, select the appropriate LOMS (for example, the LOMS1) and click
Commands.
SAP displays a list of operating systems.

Figure 3. Sending jobs to multiple InfoPrint Manager instances
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4. From the list of operating systems, double-click the operating system where
your SAP system is running to access the OMS commands.
From the Spool Administration: Operating System Commands (Change)
window, you can modify the OMS commands to switch from one InfoPrint
system to another. For example, to change the ipm_submit command to send
jobs to an InfoPrint system that is located in New York (ny1 at socket 6874),
you can change the ipm_submit command field as follows:

Original ipm_submit command
ipm_submit &P &F &EI &Eg &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1'
"&T" "&D" '&t'

Modified ipm_submit command
ipm_submit -c ny1:6874 &P &F &EI &Eg &Es '&O' '&o' '&R' '&f' '&C'
'&Y' '&E1' "&T" "&D" '&t'

Notes:

a. Even though this example shows only changes to the ipm_submit
command, make sure that you make the same change to all InfoPrint
Manager OMS commands.

b. Do not make changes to any other part of the commands; these parameters
are positional and must not be modified.

5. Save your changes by clicking the Save (diskette) icon.

If you wanted another set of devices from this same SAP system to send jobs to
another InfoPrint system that is located in London, (lon at socket 6874), you can
return to Step 3 on page 39, access another LOMS on this SAP system, and proceed
to change the ipm_submit command fields for this LOMS as follows:

Original ipm_submit command
ipm_submit &P &F &EI &Eg &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1'
"&T" "&D" '&t'

Modified ipm_submit command
ipm_submit -c lon:6874 &P &F &EI &Eg &Es '&O' '&o' '&R' '&f' '&C'
'&Y' '&E1' "&T" "&D" '&t'

As before, remember to save your changes before exiting the Spool Administration:
Operating System Commands (Change) window by clicking on the Save (diskette)
icon.

Moving OMS definitions among SAP systems

You can maintain OMS definitions on a single application by replicating your
InfoPrint Manager OMS definitions in other SAP R/3 systems. To make changes to
OMS definitions, you can transport the OMS objects from the maintenance system
to your other systems.

If you decide to transport the OMS objects from this maintenance system, you
must use only logical spool servers in these:
v OMS ROMS and LOMS definitions
v InfoPrint Manager Output device definitions

Logical servers allow you to organize your printing architecture and manage
printers. By using only logical spool servers, you will not have to change server
names in the OMS definitions after you have transported them. For more
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information about Logical servers, see the “Spool Server Definitions: Classifying
Servers, Using Logical Servers, and Using Alternate Servers” topic in your SAP
R/3 documentation.

This procedure describes how you can use the R/3 logistics (transport) system to
move OMS definitions between SAP R/3 systems:
1. From the R/3 main menu, access the Real OMS window by using this path

Tools → CCMS → and Spool → Spool Administration or type spad in the
ok-Code field.

2. From the Spool Administration: Initial Screen window, click Extended admin
and select Real OMS from the Output Management Systems pane to obtain a
list of the real output management systems (ROMS) available on your
installation.

3. From the Spool Administration: List of Real Output Management Systems
window, select Change mode from the ROMS list and double-click ROMS
definition that you want to transport.

4. From the Spool Administration: Real Output Management System window,
select the appropriate transport function:
v To transport only the ROMS definition, push the Transport (truck) icon.
v To transport both the ROMS definition and all LOMS definitions that

reference it, push the Transport all (truck) icon to the right.
In either case, a transport request is created for transporting the OMS definition
objects to other R/3 systems.

5. To transport your OMS definitions, type /SE09 in the ok-Code field so you can
complete this task from the R/3 software logistics transport system.

Switching InfoPrint Manager servers

InfoPrint Manager provides you with the ability to switch the InfoPrint server to
which your SAP system is sending commands. This can be a valuable feature to
use if a particular InfoPrint command processor fails and you want to switch to
one that is still active, or when switching from an InfoPrint test system to an
InfoPrint production system (as shown in Figure 4 on page 42). An InfoPrint
Manager system consists of one or more InfoPrint Manager servers residing on
either the same or different machines that are set up to interoperate by sharing the
same namespace.

Note: If switching from one InfoPrint Manager system to another, you must make
sure that the same logical destination names have been defined on both systems.

You can implement this support by using the SAP GUI to add an optional flag
with values in the form host:socket to your InfoPrint Manager OMS commands:
ipm_submit, ipm_dev_query, ipm_job_query, and ipm_job_cancel.

host represents the host name where the InfoPrint server is running and socket the
socket for the InfoPrint server on that host.
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To modify the OMS commands from your SAP GUI, use this procedure:
1. From the SAP R/3 graphical user interface, modify the logical output

management system (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin

and select Logical OMS from the Output Management Systems pane to obtain
a list of the logical output management systems (LOMS) available on your
installation.

3. From the Spool Administration: List of Logical Output Management Systems
window, select the appropriate LOMS (for example, the IPM001 LOMS) and
specify the Commands icon.
SAP displays a list of operating systems.

4. From the list of operating systems, double-click the operating system where
your SAP system is running to access the OMS commands.
From this panel, you can modify the OMS commands to switch from one
InfoPrint server to another. For example, to change the ipm_submit command
to send jobs to the InfoPrint server info1 at socket 6874, you can change the
ipm_submit command field as follows:

Figure 4. Switching from one InfoPrint Manager server to another
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Original ipm_submit command
ipm_submit &P &F &EI &Eg &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1'
"&T" "&D" '&t'

Modified ipm_submit command
ipm_submit -c info1:6874 &P &F &EI &Eg &Es '&O' '&o' '&R' '&f'
'&C' '&Y' '&E1' "&T" "&D" '&t'

Notes:

a. Even though this example only shows changes to the ipm_submit.
command, make sure that you make the same change to all InfoPrint
Manager OMS commands.

b. Do not make changes to any other part of the commands; these parameters
are positional and must not be modified.

Failing over to other servers in the same InfoPrint Manager
system

InfoPrint Manager provides you with the ability to send jobs to destinations in
multiple InfoPrint servers through any InfoPrint Manager server in that InfoPrint
Manager system. An InfoPrint Manager system consists of one or more InfoPrint
Manager servers residing on either the same or different machines that are set up
to interoperate by sharing the same namespace. A distributed installation that uses
an InfoPrint server (pdserver) as a command processor might want to define
another pdserver as a backup command processor to fail over to if the primary
command processor goes down so you can continue to send jobs to the
destinations. As shown in Figure 5 on page 44, you might want to specify either
the InfoPrint Manager server with the actual destination or the InfoPrint Manager
server with the logical destination as the backup server.

You can implement this support by using the SAP GUI to add an optional flag
with values in the form host:socket to your InfoPrint Manager OMS commands:
ipm_submit, ipm_query, ipm_job_query, and ipm_job_cancel.

host represents the host name where the InfoPrint server is running and socket the
socket for the InfoPrint server on that host.

Before using this function, make sure that you understand that:
v Even though this example only shows changes to the ipm_submit. command,

make sure that you make the same change to all InfoPrint Manager OMS
commands.

v Do not make changes to any other part of the commands; these parameters are
positional and must not be modified.

Chapter 7. Configuring and using the OMS 43



To modify the OMS commands from your SAP GUI, use this procedure:
1. From the SAP R/3 graphical user interface, modify the logical output

management system (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin

and select Logical OMS from the Output Management Systems pane to obtain
a list of the logical output management systems (LOMS) available on your
installation.

3. From the Spool Administration: List of Logical Output Management Systems
window, select the appropriate LOMS (for example, the IPM001 LOMS) and
specify the Commands icon.
SAP displays a list of operating systems.

4. From the list of operating systems, double-click the operating system where
your SAP system is running to access the OMS commands.
From this panel, you can modify the OMS commands to switch from one
InfoPrint server to another. For example, to change the ipm_submit command
to failover to another InfoPrint (pdserver) that is located in the same InfoPrint
Manager system, you can change the ipm_submit command field as follows:

Original ipm_submit command
ipm_submit &P &F &EI &Eg &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1'
"&T" "&D" '&t'

Modified ipm_submit command for InfoPrint server failover
ipm_submit -c 'info1:6874 info1:5157' &P &F &EI &Eg &Es '&O' '&o'
'&R' '&f' '&C' '&Y' '&E1' "&T" "&D" '&t'

Notes:

a. Even though this example only shows changes to the ipm_submit
command, make sure that you make the same change to all InfoPrint
Manager OMS commands.

b. Do not make changes to any other part of the commands; these parameters
are positional and must not be modified.

Figure 5. Failing over from one InfoPrint Manager server to another on the same system
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Customizing an SAP daemon error log on AIX

By default, the SAP daemon error logs (whether SAPconnect or SAP Callback) start
when you create them. When you create a SAP Callback daemon, InfoPrint
Manager creates a SAP directory (sapcbd.sysname, where sysname is the SAP
application server) under /var/pd for each daemon. Use this procedure to
customize the SAP error log:

Note: Any SAP daemons running on this AIX server are changed by this
customization.
1. Find the sap_error.cfg file from the /usr/lpp/pd/bin directory where the file is

installed and copy it into the /var/pd directory:
cp /usr/lpp/pd/bin/sap_error.cfg /var/pd/sap_error.cfg

Note: If you already customize your SAP daemon error logs, remember to
change the name or move the current sap_error.cfg file in /var/pd so that your
customization values can be copied over into the newer version of the file.

2. Open the copy of the sap_error.cfg file that you created and specify the settings
for the log attributes that you want (as shown in Figure 6). For example, you
can modify the log-backup-number attribute, which allows you to specify the
number of backup logs that InfoPrint saves, including the initial error.log.BAK
file.

When you start either a SAP Callback daemon or a SAPconnect daemon after a
shutdown, it backs up the first error log by creating an error.log.BAK file. With
each successive restart, it creates an additional .BAK file, adding a timestamp
as a fourth qualifier. By default, the log-backup-number attribute specifies a
value of 10, meaning that you can have nine back up files with timestamps and
the initial .BAK file. You can reduce this number as low as 1 or increase it as
high as 999.
For a complete list of the error log attributes that you can customize, see the
InfoPrint Manager: Reference.

3. Once you have finished defining your options, save and close the
/var/pd/sap_error.cfg file.

Note: If you do not need the customization change to take effect immediately,
you can skip the final two steps and just wait until the next time the SAP
daemon is restarted.

4. From an AIX command line, you must do one of these tasks for either the SAP
Callback daemon or the SAPconnect daemon to shut down so that these
customization changes can take effect.

#
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10

Figure 6. Sample sap_error.cfg file provided by InfoPrint Manager
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v For the SAP Callback daemon, type stopcbd sysname (where sysname is the
three-character SAP R/3 system name).

v For the SAPconnect daemon, type stopsapconnectd sysname (where sysname
is the three-character SAP R/3 system name).

5. To restart the SAP Callback daemons and the SAPconnect daemons, enter this
from an AIX command line:
/etc/rc.iprsap

All SAP daemons restart automatically if you have followed the configuration
directions in “Configuring to start callback daemons at system reboot on AIX”
on page 31

Customizing an SAP callback process error log on Windows

By default, the SAP process error logs start when you create them. Use this
procedure to customize the SAP error log(s). Note that any SAP processes running
on this server are changed by this customization.
1. Find the sap_error.cfg file in the bin directory that is located under the

directory where the file is installed
2. Copy it into the workspace_path\sap directory.

The workspace_path is specified on the Workspace path field. From the InfoPrint
Manager Management Console, select Edit → Service Configuration to verify
the setting of the Workspace path field. For these examples, workspace_path
signifies the fully qualified path where the error log is located, such as
C:\Program Files\InfoPrint Manager\var\pd\.

Note: If you already customize your SAP error logs, remember to change the
name or move the current sap_error.cfg file in workspace_path\sap so that your
customization values can be copied over into the newer version of the file.

3. Open a copy of the sap_error.cfg file in the workspace_path\sap directory, and
edit it to specify the settings for the log attributes that you want (as shown in
Figure 7). For example, you can modify the log-backup-number attribute, which
lets you specify the number of backup logs that InfoPrint saves, including the
initial error.log.BAK file.

When you start a SAP Callback process after a shutdown of the InfoPrint
Manager server, it backs up the first error log by creating an error.log.BAK file.
With each successive restart, it creates an additional .BAK file, adding a
timestamp as a fourth qualifier. By default, the log-backup-number attribute

#
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10

Figure 7. Sample sap_error.cfg file provided by InfoPrint Manager
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specifies a value of 10, meaning that you can have nine back up files with
timestamps and the initial .BAK file. You can reduce this number as low as 1 or
increase it as high as 999.
For a complete list of the error log attributes that you can customize, see
InfoPrint Manager: Reference.

4. Once you have finished defining your options, save and close the file.

Note: If you do not need the customization change to take effect immediately,
you can skip the final four steps and just wait until the next time the InfoPrint
Manager server is restarted.

5. From the Management Console, you must stop all SAP processes so that these
customization changes can take effect:
a. Start the InfoPrint Manager Management Console.
b. In the Objects view in the left pane of this window, click SAP Callback

Processes.
c. Stop all the SAP Callback processes that display in the main view by doing

either of these options on each icon:
v Right click and select Stop SAP Callback.
v Highlight each icon and select these from the menu bar: Actions → Stop.

6. Once all SAP processes have been shut down, you must stop the SAP services:
a. Click Start → Settings → Control Panel → Services.
b. Highlight SAP Services and click Stop.

7. To restart the SAP Services:
a. Click Start → Settings → Control Panel → Services.
b. Highlight SAP Services and click Start.

8. Once the SAP Services have been restarted, you can restart the SAP Callback
processes:
a. Start the InfoPrint Manager Management Console.
b. In the Objects view in the left pane of this window, click SAP Callback

Processes.
c. Restart individual SAP Callback processes that display in the main view by

right-clicking on each icon and selecting Start SAP Callback.

Shutting down the callback daemon on AIX

This procedure describes how you can shut down the SAP callback daemon. This
procedure is useful if you are migrating the SAP callback daemon from one
InfoPrint Manager server to another or if the SAP R/3 system it supports is not
going to be used for awhile.

From an AIX command line on the system where the SAP callback daemon is
currently running, type:
stopcbd systemname

where systemname is your three-character SAP R/3 system name.

If you do not want a reboot of the system to restart the SAP callback daemon,
remove its entry from the /etc/rc.iprsap file. If you remove its entry from the file,
you do not have to do this task, which would also prevent any SAPconnect fax
daemons from restarting automatically.
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To make sure that no SAP callback daemons are restarted automatically whenever
the systems they are running on are restarted, use the InfoPrint SMIT interface:
InfoPrint Solutions → InfoPrint Utilities → SAP Daemons.

From the SAP Daemons panel, select the Do not start SAP daemons at reboot
option.

If you are moving the SAP callback daemon to another system, remember to follow
the instructions for both “Starting the SAP callback daemon or process” on page 30
and “Configuring to start callback daemons at system reboot on AIX” on page 31.

Shutting down the callback process on Windows

This procedure describes how you can shut down the SAP callback process. This
procedure is useful if you are migrating the SAP callback daemon from one
InfoPrint Manager server to another or if the SAP R/3 system it supports is not
going to be used for awhile.

To shut down the SAP callback process on an InfoPrint Manager Windows server,
you must access the SAP Callback Processes from the InfoPrint Manager
Management Console.
1. From the Start menu, select Programs → InfoPrint Manager → Management

Console.
2. From the Objects view in the left pane of this window, click on SAP Callback

Processes to switch the main view to SAP Callback Processes.
3. Select the particular SAP Callback Process you want to stop from those shown

in the main view. You can do either one of these options:
v Right-click and select Stop SAP Callback.
v From the menu bar, select Actions → Stop.

If you are moving the SAP callback process to another system, remember to follow
the instructions for “Starting the SAP callback process on Windows” on page 32.

Deleting an SAP callback process on Windows

This procedure describes how you can delete an SAP callback process. This
procedure is useful if you are removing one SAP callback process and replacing it
with another, or if the SAP R/3 system it supports is not going to be used for
awhile. If you accidentally created an SAP callback process for the wrong host or
instance ID and you want to remove it from the InfoPrint Manager Management
Console and the InfoPrint Manager namespace, you would use this procedure:

To delete the SAP callback process on an InfoPrint Manager Windows server, you
must access the SAP Callback Processes from the Management Console.

Note: Before deleting a particular SAP callback process, you must first stop it as
described in “Shutting down the callback process on Windows.”
1. From the Start menu, select Programs→InfoPrint Manager → Management

Console path.
2. Select the SAP Callback Process object.
3. From here, you can do either one of these actions to remove the process from

the system:
v Specify Edit → Delete → SAP Callback Process.
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v Right-click on the SAP Callback Process object and select Delete.
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Part 3. InfoPrint Manager non-OMS support
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Chapter 8. Understanding SAP access method L support

If you either cannot or choose not to use SAP Output Management System (OMS)
support, we recommend using SAP’s local access method L (InfoPrint Manager’s
ipm_print command) to send jobs to the InfoPrint Manager server. InfoPrint
Manager provides a command-line client interface for SAP to submit jobs to
InfoPrint Manager with job attribute information and to query for jobs to
determine when they have completed.

The InfoPrint Manager ipm_print command provides SAP job information to
InfoPrint Manager. For example, each SAP userid can be used to track a job
through the system. The corresponding ipm_query command allows InfoPrint
Manager to provide job status to SAP. A job is not identified as complete until it
actually prints or is deleted from the print queue. You can also use the ipm_print
command to fax jobs from SAP.

For an alternative method of submitting jobs from non-AIX SAP R/3 application
servers that provide no feedback to the SAP servers, see Appendix B, “Alternate
access methods for submitting SAP jobs to InfoPrint Manager,” on page 123.

To use the InfoPrint Manager SAP Transform, you must install the SAP Print
Feature and fonts on every InfoPrint Manager server with actual destinations that
transforms either SAP OTF or ABAP data. For information on installing the SAP
Print Feature and fonts on the InfoPrint Manager server, see Chapter 9, “Installing
the SAP print feature on the InfoPrint server,” on page 55.

Depending on the platform that your SAP system runs on, see the appropriate
chapter from the list below to install and then see Chapter 13, “Configuring your
SAP system to use the InfoPrint Manager Client command,” on page 69 to
configure your SAP system to use InfoPrint Manager’s SAP access method L client:
v For installing InfoPrint Manager’s client when SAP runs on HP-UX, Linux, or

Sun Solaris servers, see Chapter 10, “Installing InfoPrint SAP Client support
when SAP runs on HP-UX, Linux,or Sun Solaris,” on page 61.

v For installing InfoPrint Manager’s client when SAP runs on AIX servers, see
Chapter 11, “Installing the SAP Client when SAP runs on AIX,” on page 65.

v For installing InfoPrint Manager’s client when SAP runs on Windows systems,
see Chapter 12, “Installing the SAP Client when SAP runs on Windows,” on
page 67.

Once you have installed the InfoPrint Manager’s client for the appropriate
operating system, see Chapter 13, “Configuring your SAP system to use the
InfoPrint Manager Client command,” on page 69 to configure your SAP system to
use the InfoPrint Manager command.
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Chapter 9. Installing the SAP print feature on the InfoPrint
server

If you are printing either Output Text Format (OTF) or Advanced Business
Application Programming (ABAP) data, make sure that you have installed the
sap2afp transform and the fonts necessary for printing. To install the transform,
you must install the SAP Print Feature on each InfoPrint Manager Windows server
or InfoPrint Manager Windows server with actual destinations that will be
transforming data.

Note: At a minimum, on every AIX system on which you will be running the SAP
(sap2afp) transform (on your InfoPrint servers), you must have the
ipsc-psf.icu.rte(InfoPrint Manager UCONV) fileset installed.

To install the InfoPrint Manager for AIX SAP Print Feature on your AIX server, see
InfoPrint Manager for AIX: Installation Instructions.

To install the SAP Print Feature on your InfoPrint Manager Windows server, follow
the directions under the “Installing InfoPrint Manager server software” topic in the
InfoPrint Manager for Windows: Getting Started manual. The install program will
guide you through installing the SAP Print Feature from the InfoPrint Manager:
SAP Print Feature CD-ROM, LCD4-5646.

To install the necessary fonts and configure the SAP transform on both the
InfoPrint Manager AIX server and the InfoPrint Manager Windows server, see the
rest of this chapter.

Installing Infoprint fonts for printing with the SAP transform on an
InfoPrint Manager AIX server

To print output from the sap2afp transform, you must install the Gothic fonts that
are specified in the fonts.tab configuration file of the /usr/lpp/psf/bin directory
on an InfoPrint Manager AIX server, as well as the required code pages.
v ABAP data requires raster fonts.
v OTF data can be printed with either raster or outline fonts.

You can obtain these resources from either of these IBM product CD-ROMs:
v AFP Font Collection: Fonts for AIX, Windows NT, Windows 2000, and OS/2,

LK2T-9269 (program number 5648-B45). This product includes both raster and
outline fonts. For more information about purchasing this product, see either
your sales representative or access the AFP Font Collection home page
(http://www.printers.ibm.com/internet/wwsites.nsf/vwwebpublished/
afpfonthome_m_ww) on the World Wide Web.

Notes: AFP Font Collection delivers multi-byte fonts on these optional
CD-ROMs:
– Japanese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9276
– Korean Fonts for AIX, Windows NT, and Windows 2000, LK2T-9278
– Simplified Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9280
– Traditional Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9282
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v Infoprint Fonts for Multiplatforms, LCD4-5587 (program number 5648-E77). This
product includes outline fonts only. For more information about purchasing this
product, see either your sales representative or access the AFP Font Collection
home page (http://www.printers.ibm.com/internet/wwsites.nsf/
vwwebpublished/ ipfontshome_m_ww) on the World Wide Web.

Notes: Infoprint Fonts for Multiplatforms delivers multi-byte fonts on these
optional CD-ROMs:
– Japanese Font Library, LCD4-5589
– Korean Font Library, LCD4-5591
– Simplified Chinese Font Library, LCD4-5593
– Traditional Chinese Font Library, LCD4-5595

To load the fonts that are required to transform OTF or ABAP data from SAP R/3
on an InfoPrint Manager system, use this procedure:
1. Load the appropriate font CD-ROM into the CD-ROM drive on your AIX

server.
2. Create a mount point from which to add fonts from this CD-ROM by typing

smitty cdrfs from the AIX command line and taking this path: CDROM File
Systems→Add a CDROM File System.

3. Press F4 to set the DEVICE name field to the system-generated name (usually
cd0).

4. For the MOUNT POINT field, specify /cdrom.
5. Press the F10 key to exit SMIT.
6. From the AIX command line, mount the CD-ROM to your RS/6000 by

specifying these two commands in sequence:
a. mount /cdrom

b. cd /cdrom

7. From the AIX command line, specify
smitty install_latest

8. For the INPUT device /directory for software field, specify
/cdrom/aix

9. To make sure that you install the correct fonts without over writing any
existing resources on your system, specify no for the COMMIT software
updates? field and yes for the SAVE replaced files? field.

10. Specify the F4 key to list all font options.
11. Use the F7 key to select these four options:

v afpfonts.bookmstr
v afpfonts.compats
v afpfonts.codepage
v afpfonts.ocr

12. To install the fonts, press Enter.
These fonts should take approximately 43 MB on your AIX server.

13. Verify that the fonts cited in your fonts.tab configuration file have been
installed.

14. InfoPrint Manager installs these fonts in the /usr/lpp/afpfonts directory.
15. To remove the IBM AFP Font Collection CD-ROM, specify these two

commands in sequence:
a. cd /cdrom

b. umount /cdrom
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16. Then you can remove the CD-ROM from your CD-ROM drive.

Installing Infoprint fonts for printing with the SAP transform on an
InfoPrint Manager Windows server

To print output from the sap2afp transform, you must install the Gothic fonts that
are specified in the fonts.tab configuration file in the install_path\sap2afp directory,
as well as the required code pages.
v ABAP data requires raster fonts.
v OTF data can be printed with either raster or outline fonts.

You can obtain these resources from either of these IBM product CD-ROMs:
v AFP Font Collection: Fonts for AIX, Windows NT, Windows 2000, and OS/2,

LK2T-9269 (program number 5648-B45). This product includes both raster and
outline fonts. For more information about purchasing this product, see either
your sales representative or access the AFP Font Collection home page
(http://www.printers.ibm.com/internet/wwsites.nsf/vwwebpublished/
afpfonthome_m_ww) on the World Wide Web.

Notes: AFP Font Collection delivers multi-byte fonts on these optional
CD-ROMs:
– Japanese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9276
– Korean Fonts for AIX, Windows NT, and Windows 2000, LK2T-9278
– Simplified Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9280
– Traditional Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9282

v Infoprint Fonts for Multiplatforms, LCD4-5587 (program number 5648-E77). This
product includes outline fonts only. For more information about purchasing this
product, see either your sales representative or access the AFP Font Collection
home page (http://www.printers.ibm.com/internet/wwsites.nsf/
vwwebpublished/ ipfontshome_m_ww) on the World Wide Web.

Notes: Infoprint Fonts for Multiplatforms delivers multi-byte fonts on these
optional CD-ROMs:
– Japanese Font Library, LCD4-5589
– Korean Font Library, LCD4-5591
– Simplified Chinese Font Library, LCD4-5593
– Traditional Chinese Font Library, LCD4-5595

To load the fonts that are required to transform OTF or ABAP data from SAP R/3
on an InfoPrint Manager system, use this procedure:
1. Load the appropriate font CD-ROM into the CD-ROM drive on your InfoPrint

Manager Windows server.
2. If autorun does not start the install, double-click My Computer on your

desktop.
3. From the My Computer window, double-click your CD-ROM drive and then

double-click the NT folder icon.
4. From the NT folder window, double-click setup.exe to begin the install.
5. Select the drive where you have installed InfoPrint Manager to install these

fonts. For example, if InfoPrint is installed on the D drive, the fonts should be
installed in the D:\afpfonts path.

6. While InfoPrint recommends that you use the full installation option, if you
select a customized install, you should be certain to select these four options:
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v BookMaster Fonts
v Compatibility Fonts
v OCR Fonts
v Symbols Fonts

7. To install the fonts, press Next.
When the fonts finish loading, you will see a Font Collection pop-up dialog
with the message:
Installation of Font Collection 2.1.0.1 is complete.

8. Verify that the fonts cited in your fonts.tab configuration file (which is
installed in the install_path\sap2afp directory).
You can use a Notepad editor to both view and change this file.

9. InfoPrint Manager installs these fonts in the install_path\afpfonts directory.
10. Remove the CD-ROM from your CD-ROM drive.

Configuring the SAP R/3 transform
Depending upon the types of data you are printing, you might need to configure
some of the files that are provided with the SAP transform. For example:
v To use form definitions that are mapped to SAP Formats (Paper Types), you

must configure the pagedef.tab file as described in “Changing document print
orientation” on page 96.

v If you have created a new font in an SAP R/3 document, you must configure
the fonts.tab file as described in “Setting up your SAP R/3 system to support
new OTF user fonts” on page 107.

v To expand or shorten the width of a barcode for printing, you must configure
the barcode.tab file as described in “Bar codes and printing from SAP R/3
through InfoPrint Manager” on page 115.

The SAP transform includes two types of files:
v An executable named sap2afp, which converts Output Text Format (OTF) data

into MO:DCA-P output data and Advanced Business Application Programming
(ABAP) list format data into line data. On an InfoPrint Manager AIX server, this
file is installed in the /usr/lpp/psf/bin directory. On an InfoPrint Manager
Windows server, this file is installed in the install_path\bin path.

v Table 6 shows the configuration files that are installed in either the
/usr/lpp/psf/sap2afp directory on an InfoPrint Manager AIX server or the
install_path\sap2afp path on an InfoPrint Manager Windows server.

Table 6. SAP (sap2afp) transform configuration files for AIX

Configuration file Purpose Use

barcode.tab Provides list of valid SAP bar
codes.

OTF data only

xxxxyyyy.tab Maps ASCII code pages to
EBCDIC code pages.

OTF data only

fonts.tab Provides a list of raster fonts
with the appropriate
character set and code page.

OTF data only

6400fonts.tab Provides a list of raster fonts
that apply exclusively to the
6400 printer, with the
appropriate character set and
code page.

OTF data only
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Table 6. SAP (sap2afp) transform configuration files for AIX (continued)

Configuration file Purpose Use

image.tab Defines the dither matrix for
half-tone color print jobs.

OTF data only

pagedef.tab Defines the form definition
(SAP PAPER TYPE) used, as
well as the page definition
and fonts for jobs that go
through ACIF.

ABAP/OTF

defcp.tab Converts ASCII into EBCDIC
characters.

ABAP data only
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Chapter 10. Installing InfoPrint SAP Client support when SAP
runs on HP-UX, Linux,or Sun Solaris

SAP R/3 installations that run on HP-UX, Linux, Sun Solaris or systems work with
InfoPrint Manager when these installations are configured to invoke commands
remotely on the InfoPrint server.

To use the access method L support of the SAP Print feature of InfoPrint Manager
with an SAP R/3 system running on a non-AIX UNIX system, you must do these
tasks:
1. “Configuring the InfoPrint Manager server”
2. “Configuring the SAP system server” on page 63

Configuring the InfoPrint Manager server

Follow the appropriate procedure depending on which version of InfoPrint
Manager you are using:
v “Configuring the InfoPrint Manager Windows server”
v “Configuring the InfoPrint Manager AIX server” on page 62

Configuring the InfoPrint Manager Windows server

The rshd and rexecd services are prerequisites for HP-UX, Linux, and Sun Solaris
SAP client support.

Use this procedure to configure the Windows server that has already installed
InfoPrint Manager Version 2 Release 3 with the SAP Print Feature:
1. Install both an rshd and rexecd service on your InfoPrint Manager Windows

server.
While Windows 2000 systems natively support both rcp and rexec commands
as a client, you just add these services to make sure that these command
requests are honored by the InfoPrint Manager Windows server. One company
which sells software that provides rshd and rexecd services for Windows 2000
is Denicomp Systems (http://www.denicomp.com).

Note: During the installation of these services, make sure that remote users are
defined users on the InfoPrint Manager for Windows 2.3 system so that it is
possible to write to this server from the Windows SAP client system.

2. From the Start menu, access the Programs → Administrative Tools → User
Manager path.

3. Create a new user named sapuser.

Note: This user does not have to be part of any special groups.
4. Authorize the sapuser userid to issue remote commands by adding this entry

to the .rhosts or equivalent file: +sapuser.
5. Authorize all remote servers running the SAP R/3 applications to specify

remote commands on the InfoPrint Manager Windows server by specifying:
fully_qualified_server_name +
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where fully_qualified_server_name is either the IP address (in dotted decimal
format) or the host name of the server.

Notes:

a. If you use a host name, TCP/IP must be able to resolve that name through
either the security file or through a Domain Name Server (DNS).

b. If a DNS is not being used, but the host name is specified in the hosts file,
specify the fully qualified name in the .rhosts or equivalent file.

c. If a DNS is not being used, and the host name is not specified in the hosts
file, you must specify an IP address in the .rhosts or equivalent file (for
example, 172.16.8.10 +).

For added accountability among SAP systems and print jobs, you can create
separate Windows users for each SAP system or SAP R/3 application server.
Repeat Steps 2 on page 61 through 5 on page 61 to create new user IDs that you
can map to each SAP application server from which you plan to use InfoPrint
Manager to print.

Turning off GOCA support on a Windows server

By default, the SAP client requests Graphics Object Content Architecture (GOCA)
support. GOCA is an AFP data architecture used to represent pictures generated by
computer. If your installation uses older printers (for example, 3900 printers as
opposed to InfoPrint 4000 printers), GOCA support can cause the printers to print
at less than rated speed. If your applications do not require GOCA support
features, such as box shading, you might want to improve performance by turning
off the GOCA support.

If your HP-UX, Linux, or Sun Solaris client is connected to an InfoPrint Manager
Windows server, access the ipmcfg file from the directory where you installed
InfoPrint Manager. When you click this file, it displays the IPM Server Settings
dialog. From here, you can click the IPM GOCA Support check box to remove the
check.

You can also turn off this support at a later date, as described in “Adding box
shading values to printed output” on page 111.

Configuring the InfoPrint Manager AIX server

Use this procedure to configure the AIX server that has already installed InfoPrint
Manager Version 4 Release 3 with the SAP Print Feature.
1. Add a user called sapuser. This user does not have to be part of any special

groups.
2. Authorize the sapuser userid to issue remote commands by adding this entry

to the /etc/hosts.equiv file:
+ sapuser

3. Authorize all remote servers running the SAP R/3 application to specify remote
commands on the InfoPrint Manager AIX server as sapuser by doing this
procedure:
a. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.
b. Edit the .rhosts file and add a line for each non-AIX server running an SAP

R/3 application with a plus (+) sign appended to it.
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If a Domain Name Server is being used, specify the fully qualified name to
the .rhosts file as shown below:
/home/sapuser/.rhosts: sol.infoprint.com +

If a Domain Name Server is not being used, you must also add the host
name and its IP address to the /etc/hosts file as show below:
/home/sapuser/.rhosts: sol.infoprint.com +

/etc/hosts: 172.16.8.10 sol.infoprint.com +

For added accountability among SAP systems and print jobs, you can create
separate AIX users for each SAP system or SAP R/3 application server. Follow the
three steps specified in this topic to create additional users (like sapuser) that you
can map to each application server from which you will be using InfoPrint
Manager to print.

For more information about using the rsh and rcp commands to connect to the
InfoPrint Manager AIX server and send files between servers, see your AIX
Operating System documentation.

Turning off GOCA support on an AIX server

By default, the SAP client requests Graphics Object Content Architecture (GOCA)
support. GOCA is an AFP data architecture used to represent pictures generated by
computer. If your installation uses older printers (for example, 3900 printers as
opposed to InfoPrint 4000 printers), GOCA support can cause the printers to print
at less than rated speed. If your applications do not require GOCA support
features, such as box shading, you might want to improve performance by turning
off the GOCA support.

If your HP-UX, Linux, or Sun Solaris client is connected to an InfoPrint Manager
AIX server, go to the AIX server and use this procedure:
1. Access the ipm_print file that reside in the /usr/lpp/pd/bin directory.
2. Using your AIX editor of choice, comment out the othertoptions="other-

transform-options='-g'"; line by placing a hash mark (#) in front of the line.

You can also turn off this support at a later date, as described in “Adding box
shading values to printed output” on page 111.

Configuring the SAP system server

To allow SAP HP-UX, Linux, or Sun Solaris to issue the InfoPrint Manager
commands, you must install the InfoPrint Manager SAP Client on every SAP
server where an SAP application server will issue the commands. This includes
every application server with a spool work process (SWP) managing R/3 devices
that have been configured to use access method L. If you have configured your
SAP R/3 system to use alternate servers, you must repeat these installation tasks
on the alternate servers as well.

Use this procedure to configure remote servers (HP-UX, Linux, or Sun) running the
SAP R/3 application so you can print with InfoPrint Manager:
1. Obtain access to each HP-UX, Linux, or Sun Solaris server running SAP R/3

and log on.
2. Verify that you can ping the InfoPrint Manager server by host name:

ping -c 3 hostname

Chapter 10. Installing InfoPrint SAP Client support when SAP runs on HP-UX, Linux,or Sun Solaris 63



where hostname is the unqualified name for the InfoPrint Manager server, such
as nwser.
If the response shows that a good communication path exists, you will see this:
----tcpip_addr PING Statistics----
packets transmitted, 3 packets received, 0% packet loss
round-trip min/avg/max = 7/7/7 ms

3. If you cannot ping the InfoPrint Manager server by host name, edit the
/etc/hosts file and add the host name and IP address of the InfoPrint Manager
server:
/etc/hosts: 9.99.11.109 nwser

4. Create a directory named /usr/lpp/pd/bin:
mkdir /usr/lpp/pd/bin

5. Use the FTP client of your choice to copy these files from the InfoPrint
Manager server to an SAP R/3 application server in your configuration. If you
are using an InfoPrint Manager AIX server, these files reside in the
/usr/lpp/pd/bin directory. If you are using an InfoPrint Manager for Windows
server, these files reside in the install_path\bin folder:
v ipm_print.sys
v ipm_query.sys

For the secondary qualifier (sys), specify the name of the system where your
SAP applications are running, hp for HP-UX, linux for Linux, or sun for Sun
Solaris.
If your SAP System Server is running on Linux, you should also copy the
sap_client_lnx.cfg configuration file from the InfoPrint Manager server to an
SAP R/3 application server in your configuration:
The sap_client_lnx.cfg file is used to configure the SAP Client for Linux to use
either the rsh or ssh commands. If the configuration file is not found in the
directory where the scripts reside, the scripts will use the rsh command.

6. Make sure that each file copied in Step 5 is executable.
7. On the SAP application server in your installation, edit both files so they

specify the name of the user (sapuser) and host name where InfoPrint Manager
is running.

8. Copy the edited SAP command files to any other SAP application servers in
your installation that use the InfoPrint Manager server.

Once you have completed this procedure, follow the directions for updating the
SAP Profile to activate the SAP Print command and define SAP devices that use
access method L in Chapter 13, “Configuring your SAP system to use the InfoPrint
Manager Client command,” on page 69.
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Chapter 11. Installing the SAP Client when SAP runs on AIX

To allow SAP to issue the InfoPrint Manager commands, you must install the
InfoPrint Manager SAP client on every SAP server where an SAP application
server will issue the commands. This includes every application server with an
SWP managing R/3 devices that have been configured to use access method L for
sending jobs to InfoPrint Manager. If you have configured your SAP R/3 system to
use alternate servers, you must repeat these installation tasks on the alternate
servers as well.

To install the SAP client for AIX on your SAP application servers, use this
procedure:
1. Log into the AIX system as root.
2. Insert the InfoPrint Manager: Common Clients CD-ROM, LCD4-5642 into the

CD-ROM reader.
3. Open a terminal window.

If you are using the Common Desktop Environment (CDE), you can open a
terminal window by clicking on the terminal icon contained in the front panel.
(The front panel is the task bar that appears at the bottom of the screen.) By
default, the terminal icon is contained in a pop-up menu above the text editor
icon that appears on the front panel.

4. The first time you run the Installer, follow this procedure:
a. Type this on the command line:

smit cdrfs

b. Select Add a CDROM File System from the list of choices presented.
c. Click the List button and select your CD-ROM device name (cd0, for

example).
d. Type this in the MOUNT POINT field:

/cdrom

e. Click OK. The running person will raise his arms to indicate success. If he
instead falls down and you see crfs: 0506-909 /cdrom file system
already exists, do not interpret this as a failure. (The existing /cdrom file
system should be usable.)

f. Press the F12 key to exit SMIT.
5. Type this on the command line:

mount /cdrom

6. The SAP Client package (ipr.sapclient) is installed at the command line by
specifying setup —x.
During the course of the install, you are prompted to specify values for both
PDHOST and PD_SOCKET.

Notes:

1. The SAP Client package cannot be installed if other ipr* filesets reside on an
SAP application server.

2. If your installation uses older printers (for example, 3900 printers instead of
InfoPrint 4000 printers), the GOCA support can cause the printers to print at
less than rated speed. If your applications do not require GOCA support
features, such as box shading, you might want to improve performance by
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turning off the GOCA support. For instructions on turning off this support after
installing the SAP Client, see “Adding box shading values to printed output”
on page 111.

Once you have completed this procedure, follow the directions for updating the
SAP profile to activate the SAP Print Command and define SAP devices that use
access method L in Chapter 13, “Configuring your SAP system to use the InfoPrint
Manager Client command,” on page 69.
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Chapter 12. Installing the SAP Client when SAP runs on
Windows

To allow SAP to issue the InfoPrint Manager commands, you must install the
InfoPrint Manager SAP client on every SAP server where an SAP application
server will issue the commands. This includes every application server with an
SWP managing R/3 devices that have been configured to use access method L for
sending jobs to InfoPrint Manager. If you have configured your SAP R/3 system to
use alternate servers, you must repeat these installation tasks on the alternate
servers as well.

To install the InfoPrint Manager SAP Client for Windows on your Windows SAP
system, use this procedure:
1. Log in as the Administrator user.
2. Insert the InfoPrint Manager: Common Clients CD-ROM, LCD4-5642 into your

CD-ROM drive.
3. From the InfoPrint Manager: Common Clients window, click Install InfoPrint

Manager Products.
4. Click on InfoPrint Manager SAP Clients.
5. Select a location for installing the clients (the default is install_path \Infoprint

Manager SAP Clients\).
6. From the IPM Server Settings pop-up dialog, specify either the fully qualified

host name or the IP address of the InfoPrint Manager server to which you will
be sending jobs. The IPM Hostname field defaults to showing the loop back
address and must be changed.
The IPM Server Port Number field defaults to 6874, which you do not need to
change.

Notes:

a. Do not check the IPM Debug Mode checkbox unless instructed to do so by
technical support.

b. Remove the check in the IPM GOCA Support checkbox only if you want to
turn off graphics object content architecture (GOCA support) in the SAP
transform.
By default, the SAP client requests Graphics Object Content Architecture
(GOCA) support. GOCA is an AFP data architecture used to represent
pictures generated by computer. If your installation uses older printers (for
example, 3900 printers instead of InfoPrint 4000 printers), the GOCA
support can cause the printers to print at less than rated speed. If your
applications do not require GOCA support features, such as box shading,
you might want to improve performance by turning off the GOCA support.
For instructions on turning off this support after installing the SAP Client,
see “Adding box shading values to printed output” on page 111.

Once you have set the appropriate values, click OK to close this dialog.
7. When the SAP client has been installed, click Finish.
8. To exit the install process, click Back, and then the Exit button on the next

screen.
9. To complete the configuration, follow the directions for updating the SAP

Profile to activate the SAP print command and define SAP devices that use
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access method L as described in Chapter 13, “Configuring your SAP system to
use the InfoPrint Manager Client command,” on page 69.
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Chapter 13. Configuring your SAP system to use the InfoPrint
Manager Client command

SAP R/3 systems work best with InfoPrint Manager when these installations are
configured to use our ipm_print command.

The InfoPrint Manager ipm_print command provides SAP job information to
InfoPrint Manager. For example, each SAP userid can be used to track a job
through the system. The corresponding ipm_query command allows InfoPrint
Manager to provide job status to SAP. A job is not identified as complete until it
actually prints or is deleted from the print queue. You can also use the ipm_print
jobs to fax jobs from SAP.

Use the “Modifying the print profile for SAP” before “Defining SAP devices to
send jobs to InfoPrint Manager” on page 70.

Modifying the print profile for SAP

To print with access method L from an SAP server, you must edit the print profile
on your SAP application server. From your SAP R/3 graphical user interface, use
this procedure:
1. Enter RZ10 in the OK-Code field to access the Edit Profiles window.
2. Select the Extended maintenance radio button and click Change to access the

Maintain R/3 Profile print_profile window.
3. In the appropriate fields, specify these values, and click Check in the upper left

corner to save the values. You will return to the screen two more times to add
rspo/host_spool/query, and rspo/host_spool/answer_format values:

Parameter name:
rspo/host_spool/print

Parameter val:
ipm_print -P &P -F &F -O '&O' -o '&o' -R '&R' -C &C -Y '&Y' -T
"&T" -D "&D" -t '&t'

Parameter name:
rspo/host_spool/query

Parameter val:
rspo/host_spool/query=ipm_query -P&P

Parameter name:
rspo/host_spool/answer_format

Parameter val:
rspo/host_spool/answer_format=lpstat

Note: For the rspo/host_spool/print values, some parameters are single-quoted
('&o') and some are double-quoted ("&T").

4. Specify the Check icon in the upper left corner to save this data.
The SAP system responds by providing a display that demonstrates how this
print profile has been changed. Note the two highlighted sections to see the
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ipm_print and ipm_query SAP clients:

5. Once you have completed steps 4 and 5 three times to enter all the appropriate
values, you must save these print profile changes. To save these print profile
changes, be sure you check yes for the dialog box about the parameter change.

6. Then make sure that you click yes for the dialog box about the profile change.

Note: If you neglect to specify yes for both dialog boxes, the SAP system might
not save your changes.
Once you verify these changes to the print profile, SAP R/3 might display this
message, which you can ignore:

7. Once you have notified the other SAP R/3 application users, click Save and
restart (bounce) the R/3 application servers.

Once you have completed these procedures, you can create devices to print from
your SAP R/3 system, using InfoPrint Manager to drive the printers. Use the
procedure for “Defining SAP devices to send jobs to InfoPrint Manager.”

Defining SAP devices to send jobs to InfoPrint Manager

This section describes how to create a new output device for printing to InfoPrint
Manager. To enable this support, an SAP R/3 administrator must do this procedure
from the SAP R/3 graphical user interface:
1. Make sure that you have a logical destination defined in InfoPrint Manager,

which will send jobs to your physical printer device.
2. From the R/3 main menu, access the Spool Administration window by clicking

the Tools main menu and then selecting the Tools → Administration → Spool →
Spool Administration path. or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and
click Change

4. Click Create and fill in this information about the Create Output Device
window:

Table 7. Devices that use the InfoPrint Manager OMS

Field Explanation Example value

Output device
Type the name that R/3
users will need to access the
printer.

PRT1

0/12/2001 Active parameters 14:33:04
Parameter name Parameter value

rspo/host_spool/query ipm_query -P &P
rspo/host_spool/print ipm_print -P &P -F &F -O "&O" -o "&o" -R "&R" -C &C -T "&T"
eu/iwb/server_win32 hrmsds1.jones.s10.ca.us
eu/iwb/server_mac hrmsds1.jones.s10.ca.us
eu/iwb/path_mac zdummy
login/system_client 400
SAPLOCALHOST hrmssbx
eu/iwb/path_win32 saphelp\helpdata
:

Figure 8. Active parameters list display from changed print profile
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Table 7. Devices that use the InfoPrint Manager OMS (continued)

Field Explanation Example value

Device type
Select the device type that
has been defined in the R/3
system for the printer model.
POSTSCPT applies to any
PostScript printer, while
HPLJ4 applies to a
Hewlett-Packard LaserJet 4
printer. SAPGOF sends both
OTF and ABAP data to be
transformed into AFP by the
InfoPrint Manager SAP
Transform.

POSTSCPT

Spool server
Select the name of the R/3
application server which will
be the SAP R/3 spool server
(spool work process) that
processes requests for this
device.

us01d2_P40_41

Host printer
Type the name of the
InfoPrint Manager logical
printer.

prt1-lp

Device class
Enter a space so that this
field accepts the default
value of printer, which is P.

Access method in host spool
Select the method that the
spool work process uses to
pass data to the host spool
system.

L

5. From the menu bar, click Back and the system will prompt you to save the new
output device.

Note: If your logical destination does not receive a job sent from your SAP
device, delete and recreate the SAP callback daemon with the same settings on
the InfoPrint Manager server.

Chapter 13. Configuring your SAP system to use the InfoPrint Manager Client command 71



72 InfoPrint Manager: SAP R/3 Planning and Configuration Guide



Part 4. Customizing your print environment
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Chapter 14. Fax support in SAP R/3

InfoPrint Manager provides two distinct methods for providing fax support to SAP
users: either the SAPcommunications (SAPcomm) interface or the SAPconnect
interface. The SAPcomm interface applies to all SAP releases until Release 6 and
only provides you the ability to send faxes (fax-out). The SAPconnect interface
supports future releases of SAP R/3 and provides you with the capability to both
send (fax-out) and receive (fax-in) faxes from your SAP user interface, using your
InfoPrint Manager AIX server.

We recommend using the SAPcomm method if possible, since it combines all the
benefits of using InfoPrint Manager’s OMS support (see Part 2, “Installing and
configuring InfoPrint Manager’s OMS,” on page 9) with the ability to send faxes.
You can also send faxes from your SAP system to InfoPrint Managerr, using access
method L (see Part 3, “InfoPrint Manager non-OMS support,” on page 51).

Note: Fax support is not currently available with InfoPrint Manager for Windows,
unless you are also using InfoPrint Manager for AIX.

Using SAPcomm support for fax-out

Faxing jobs from SAP R/3 to InfoPrint Manager is similar to printing jobs from
SAP R/3 to InfoPrint Manager: you must define an SAP device that is connected to
an InfoPrint Manager destination. However, you must define an SAP device so that
a fax number can be passed to InfoPrint Manager.

To submit faxes from SAP R/3 systems using SAPcomm, you must:
v Configure the InfoPrint Fax support on your InfoPrint Manager AIX server
v Set your SAP system to send print jobs to InfoPrint Manager using either the

OMS support (see Part 2, “Installing and configuring InfoPrint Manager’s OMS,”
on page 9) or access method L (see Part 3, “InfoPrint Manager non-OMS
support,” on page 51)

Once you have verified that these prerequisites have been done, use these two
procedures to implement sending faxes from SAP R/3.

Creating an R/3 fax device

This procedure describes how you can create an SAP R/3 fax device for submitting
jobs to an InfoPrint Manager AIX server:
1. Make sure that you have defined a logical destination in InfoPrint Manager

that will send jobs to the fax destination.
2. From the SAP R/3 graphical user interface, specify either /nspad transaction

in the ok-Code field, or take the Tools → Administration:Spool → Spool
Administration) path from the main menu.

3. From the Spool Administration: Initial Screen window, click Output Devices,
click Change (red pencil), and push Output Devices.

4. From the Spool Administration: List of Output Devices window, click Create
(white paper image to the right of the trash can).

5. From the Spool Administration: Create Output Device window, fill in this
information:
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Field Value

Output device FAX

Type the name that R/3 users will need to
access the device.

Device class F

Select a device class for the fax.

Host printer ip01-sam

Type the InfoPrint Manager logical
destination (printer) name that will send the
job to the InfoPrint fax destination. .

Access method to host spool access method E or access method L .

Make sure that you specify the appropriate
access method, depending upon how you
configure your SAP system to communicate
with InfoPrint Manager.

LOMS (only applies to access method E). IPM001

If you are running with the InfoPrint
Manager OMS support (access method E),
specify the LOMS to which this device
should be assigned. You specified this value
on the Spool Admin.: Logical Output
Management System window when you
defined the InfoPrint Manager OMS (see
“Defining the InfoPrint Manager OMS to
SAP R/3 on the SAP system server” on page
27).

Spool server ibmbtt15_BTF_15

Select an applicable spool server from the
entries list on the field.

6. Save your device definition by specifying Output Device → Save from the
menu options.

7. Specify the /nscon (Tools → Communication → Configuration) transaction.
8. From the SAPcomm: Configuration window, select the Location option from

the Destination pane and click Change.
9. Click on the check box to close the pop-up message window that displays

information about the table’s client independent status.
10. From the SAPcomm: ″destination location″: Overview window, click New

entries and specify the Output Device that you created in step 4 on page 75.

Note: Specify the appropriate country code in the Cntry column. For example,
specify US for an installation in the United States.

11. From the New Entries: Details of Created Entries window, click Save to save
your changes.

12. From the SAPcomm: Configuration window, select the Selection option from
the Destination pane and click Change.

13. Click on the check box to close the pop-up message window that displays
information about the table’s client-independent status.

14. From the SAPcomm: ″destination selection″ window, click New Entries.
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15. From the New Entries: Details of Created Entries window, fill in these values
on the Selection pane:

Field Value

Service TELEFAX

Specify the type of service.

Cntry US

Specify the country code that you specified
in Step 10 on page 76.

Note: The Key, Type, Area Served, and Device group fields should all be left
blank.

16. Under the Destination pane, specify the output device that you created in Step
5 on page 75: FAX.

Note: The Country of location field should be left blank.
17. Save your fax definition by clicking the Save folder icon.

Once you have completed this procedure, you are ready to submit a fax request
from SAP R/3 to InfoPrint Manager.

Submitting a fax from SAP R/3 to InfoPrint Manager

Once you have finished creating an R/3 fax device, you can use this procedure to
submit a fax from your SAP R/3 system to the InfoPrint Manager AIX server:
1. From the SAP R/3 graphical user interface, create a spool request for a

document that you want to fax.

Note: Make sure that the Print immediate button is not selected.
2. Enter /nsp01 in the ok-Code field.
3. From the Spool Requests window, select the spool request that you specified in

Step 1 and click Printer.
4. From the Spool: Output Request window, specify the relevant fields in the Print

parameters and Title page pane, then click Fax.
5. From the Spool: Query FAX Number pop-up window, specify the number to

which you are sending the fax in the Recipient number field and the
appropriate country key in the Country key field.

6. Click Fax.
7. Your fax job will be sent to the InfoPrint Manager fax destination and be faxed.

You can also fax from SAP applications by providing the fax number and
selecting the Fax device.

Using SAPconnect support for fax-out and fax-in
SAPconnect is the successor to the SAP Communications Server (SAPcomm). By
using remote function call (RFC) technology SAPconnect allows SAP R/3 users to
access a variety of communication systems—including fax servers—directly from
R/3. The Fax function of InfoPrint Manager allows the InfoPrint Manager for AIX
server to act as a fax server.
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With InfoPrint Manager SAPconnect support, an SAP user can log onto an SAP
system from his or her personal computer and either send or receive a fax through
InfoPrint Manager. This SAP user can create a document in their SAP Office
outbox, select attachments, and send a fax through InfoPrint Manager. When ready,
you can click Fax and enter a fax number. The SAPconnect interface on the SAP
system forwards the job to InfoPrint Manager’s SAPconnect daemon, which passes
the job through an InfoPrint server to an InfoPrint Fax actual destination. For more
information about how to use this support, see “Using SAPconnect for fax-out
support (sending faxes)” on page 80

SAPconnect support also allows an SAP user to receive incoming fax messages
from others through InfoPrint Manager. Another person can fax something to an
SAP user’s fax number, which is being monitored by InfoPrint Manager. InfoPrint
Manager Fax In support forwards the fax through an InfoPrint Manager server to a
sapconnect actual destination, which delivers the fax to the user’s SAP system. The
SAP system receives the fax request for a particular fax number through the
SAPconnect interface and delivers it to that SAP user’s SAP Office in box. For more
information about how to use this support, see “Using SAPconnect for fax-in
support (receiving faxes)” on page 91.

sapconnd
for SJD

p d p r

SAP User

SAP RFC

p d s e r v e r

LD Q FAX
AD

SAP System
SJD

Figure 9. SAPconnect fax-out overview
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Using examples from the New Visual Design SAP GUI on a Release 4.6c system,
this topic provides this information:
1. “Installing the SAPconnect support”
2. “Using SAPconnect for fax-out support (sending faxes)” on page 80

a. “Preparing to connect the SAP System to an InfoPrint Manager SAPconnect
daemon” on page 81

b. “Customizing SAPconnect” on page 82
c. “Using the InfoPrint fax actual destination for fax-out” on page 80
d. “Configuring the SAPconnect daemon on InfoPrint Manager” on page 84
e. “Testing the RFC from SAP R/3” on page 88
f. “Preparing and sending faxes from R/3” on page 89

3. “Using SAPconnect for fax-in support (receiving faxes)” on page 91
a. “Creating a CPIC or system type user ID for the InfoPrint Manager

sapconnect actual destination” on page 92
b. “Creating InfoPrint Manager objects” on page 92
c. “Logging the InfoPrint actual destination onto the SAP system” on page 94
d. “Configure the fax-in lines to feed the SAPconnect actual destination on an

InfoPrint Manager AIX server” on page 94

Installing the SAPconnect support

To use the SAPconnect support for either fax-out or fax-in support, you need to
install and configure these functions on your InfoPrint Manager AIX server(s)
before doing the configuration tasks described in this publication:
v InfoPrint Manager SAP Print Feature.

IPM Fax In Process

p d p r

SAP User

SAP RFC

p d s e r v e r

LD Q sapconnect
AD

SAP System
SJD

Figure 10. SAPconnect fax-in overview
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You must install this feature through the InfoPrint Installer to use the
SAPconnect daemon for fax-out support and the sapconnect DSS for fax-in
support. For more information about installing the SAP Print feature, see
Chapter 3, “Installing the SAP Print Feature on the InfoPrint server,” on page 13.

v InfoPrint Fax function.
See the InfoPrint Manager for AIX: Configuring and Using InfoPrint Fax publication
to do the necessary configuration tasks on your InfoPrint Manager AIX server.

Note: If you have multiple interoperating AIX servers running InfoPrint servers,
the InfoPrint Fax feature can be installed on a different InfoPrint Manager AIX
server than the server that runs the SAP Print feature.

Using SAPconnect for fax-out support (sending faxes)

By configuring SAP to use the new InfoPrint Manager SAPconnect support, the
SAP System sends the request in the form of an SAP RFC call to the InfoPrint
Manager SAPconnect daemon that is running on the InfoPrint Manager AIX server.
The SAPconnect daemon converts the RFC call into a print request (an InfoPrint
Manager pdpr command), which is sent to an InfoPrint Manager Fax destination.
The Fax destination faxes this job to the fax number specified by the SAP user.

An InfoPrint Manager SAPconnect daemon supports a single SAP system. Start
one SAPconnect daemon for each SAP system that you plan to support.

Once you have made sure that the prerequisites are installed on your InfoPrint
Manager AIX server (see “Installing the SAPconnect support” on page 79), you
must complete these configuration tasks for SAP users to send faxes:
1. “Using the InfoPrint fax actual destination for fax-out”
2. “Preparing to connect the SAP System to an InfoPrint Manager SAPconnect

daemon” on page 81
3. “Customizing SAPconnect” on page 82
4. “Configuring the SAPconnect daemon on InfoPrint Manager” on page 84
5. “Testing the RFC from SAP R/3” on page 88
6. “Preparing and sending faxes from R/3” on page 89

Note: To make this task more manageable, you might want to access Appendix A,
“SAPconnect fax-out configuration worksheet,” on page 121 and print out copies
so you can keep track of the different values specified throughout your
configuration.

Using the InfoPrint fax actual destination for fax-out

Before you configure the SAPconnect daemon, you must have an InfoPrint actual
destination to send fax output. To send faxes through InfoPrint Manager, you must
first configure the InfoPrint Fax support, using the InfoPrint Manager for AIX:
Configuring and Using InfoPrint Fax publication to do the necessary configuration
tasks on your InfoPrint Manager AIX server. Make sure that this Fax DSS InfoPrint
actual destination works correctly. Use the InfoPrint logical destination that feeds
this actual destination or create a new one for SAPconnect fax output. Record the
name of this destination for use later when you define the start command for the
SAPconnect daemon. You specify the name of this destination for the
IPMLogicalDestinationName parameter value in “Starting the SAPconnect
daemon from the InfoPrint Manager AIX server” on page 86.
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Preparing to connect the SAP System to an InfoPrint Manager
SAPconnect daemon

These three procedures must be completed in sequence before your InfoPrint
Manager Fax support can be connected to your SAP R/3 system:
1. “Creating a CPIC or system type user for the InfoPrint Manager SAPconnect

daemon”
2. “Creating an SAP RFC destination”
3. “Activating fax function in SAP Office” on page 82

Creating a CPIC or system type user for the InfoPrint Manager SAPconnect
daemon:

Because the InfoPrint Manager SAPconnect daemon (sapconnd) daemon must log
onto the SAP system to make RFC calls to the SAP system sending fax output, you
must create a user for it. This user ID allows the SAPconnect daemon to send
asynchronous data about the results of the fax back to the SAP system.

To create a user for the InfoPrint Manager SAPconnect daemon (sapconnd)
daemon, use transaction su01 to access the User Maintenance: Initial Screen
window.

The user must be either a CPIC or System type and have authorizations provided
in the S_A.SCON profile. Record the user, password, and client values for use later
when you define the start command for the SAPconnect daemon in “Starting the
SAPconnect daemon from the InfoPrint Manager AIX server” on page 86.

If you ever modify this SAP user, remember to make the changes to the rc.iprsap
file in the /etc directory on the InfoPrint Manager AIX server where the
SAPconnect daemon is running.

Creating an SAP RFC destination:

Before you can submit faxes from SAP R/3 using InfoPrint Manager fax support,
you must create a Remote Function Call (RFC) destination. You will need this
destination for “Configuring the SAPconnect daemon on InfoPrint Manager” on
page 84.
1. Log into the SAP R/3 GUI.
2. Type SM59 in the field on the left side of the menu bar.

If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar between the Enter (green checkmark) and diskette icons.

3. From the Display and Maintain RFC Destinations window, click Create.
4. From the RFC Destination window, you must:

a. Enter the name of the destination in the RFC destination field.
Record the destination name for use later when you define the start
command for the SAPconnect daemon in “Starting the SAPconnect
daemon from the InfoPrint Manager AIX server” on page 86 and in
“Configuring the RFC initialization file on InfoPrint Manager” on page 84.
This value must match the DEST= parameter value in the saprfc.ini file
that is located on your InfoPrint Manager AIX server.

b. Specify T in the Connection type field to indicate an external TCP/IP
connection.

c. Specify a short description (such as IPM FAX destination) in the
Description field.
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d. Press the Enter key.
5. From the RFC Destination window for registration, access the Activation Type

and press the Registration button next to Activation Type.
6. Enter a Program ID field value for the InfoPrint Manager SAPconnect daemon

in the format sysname.program_name, such as info1.sapconnd, where info1 is
the name of the InfoPrint Manager AIX server where the SAP Print feature
was installed and sapconnd is the name of the program.
Record this value for use in “Configuring the RFC initialization file on
InfoPrint Manager” on page 84. This value must match the PROGID=
parameter value in the saprfc.ini file that is located on your InfoPrint Manager
AIX server.

7. From the RFC Destination NEW_DEST827 window main menu, take the
Destination → Gateway options path.

8. From the RFC Destination NEW_DEST827 pop-up dialog, specify values for
both the Gateway host and the Gateway service fields.
Record this value for use in “Configuring the RFC initialization file on
InfoPrint Manager” on page 84. These values must match the GWHOST= and
the GWSERV= parameter values respectively in the saprfc.ini file that is
located on your InfoPrint Manager AIX server.

9. Click OK to save these values.
10. Use F11 to save your entries.

At the very bottom of the window to the right of the green checkbox, you
should see a message similar to this:
Destination NEW_DEST827 saved

Activating fax function in SAP Office:

You must activate the Fax function in the SAP Office component of your SAP R/3
application using this procedure if you are running with an SAP R/3 Release 4.0. If
you are using an SAP R/3 Release 4.5 system or higher, this procedure is
unnecessary, but you should still verify the fax component is selected after
customizing SAPconnect for faxing.
1. Log into the SAP R/3 GUI.
2. Type SO16 in the field on the left side of the menu bar.

If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar, between the Enter (green checkmark) and diskette icons.

3. From the Shared office settings window, click Send and select the Fax
component checkbox.

4. Press the F11 key to save your entries.

Customizing SAPconnect

Before you can use the InfoPrint SAPconnect daemon to send faxes from an SAP
R/3 system, you must do these two customization tasks on your SAP system:
1. “Customize SAPconnect for faxing”
2. “Creating a SAPconnect node” on page 83

Customize SAPconnect for faxing:

1. From the SAP R/3 GUI, type SCOT in the field on the left side of the menu bar.
If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar between the Enter (green checkmark) and diskette icons.
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2. From the SAPconnect:Administration (jobs) window, take the Settings →
Communication methods options path.

3. From the Change View ″SAPconnect: Maintenance view—communication
methods″:.. window,
v Set the Typ field value to FAX.
v Set the Method field value to SAPCONNECT.

4. Press the F11 key to save your entries.

Creating a SAPconnect node:

In R/3, a node is a logical view of a communication system that can represent a
fax system, an e-mail system, or another R/3 system. This SAP node is being
created to represent the InfoPrint Manager fax server.
1. Log into the SAP R/3 GUI.
2. From the SAP R/3 GUI, type SCOT in the field on the left side of the menu bar.

If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar between the Enter (green checkmark) and diskette icons.

3. From the SAPconnect: Administration (jobs) window, take the View → Node
options path.

4. From the SAPconnect: Administration (nodes) window, click Create (piece of
paper) on the far left.

5. From the Create nodes pop-up dialog:
v Set the Node field value to the name you select for this node, such as

IPMFAX.
v Set the Description field value to IPMFAX Node for Fax Support.

6. Click Continue and specify the object you created in “Creating an SAP RFC
destination” on page 81 (NEW_DEST827) in the RFC destination field.
If defined correctly, you should be able to click the circular icon of two
superimposed pages to the right of this field to select this value instead of just
typing it into the field.

7. Click Continue and make sure that the Fax radio button is selected.
8. Click Continue and make sure that the Address area field contains a *.

By specifying a *, you ensure that this node will send faxes to any series of
numbers. If you were limiting this node to a particular number, you would
specify it in the form of ctry num where ctry specifies the abbreviation for
faxes sent to a particular country and num specifies the fax number without
any special characters. To make sure that you correctly specify these fax
numbers, we recommend that you click the Click here for further
information.... link.

9. Click Continue, make sure that the Only the fll formats radio button is
clicked, and type in each of these as separate entries in the Format table:
PDF
PS
RAW
GIF
JPEG
PCL

10. Click Continue and specify a valid PostScript device type, such as POST2, in
the Dev. type field.
This defines the SAP device type for which SAPscript documents are prepared
if SAPconnect data is converted into a print format.
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11. Click Continue and select the check box next to Country so you can use the
drop down list to select the appropriate country code for sending fax output.
From the Country key pop-up dialog, use the cursor to select the appropriate
country abbreviation, then click Enter (green checkmark) to save your value
and exit the dialog.
Before deciding on whether to check the Node-specific fax number changes
check box, we recommend that you click the Click here for further
information... link. Selecting this check box allows you to define general
replacement rules for nodes that replace one row of digits with another, such
as deleting the area code for all faxes submitted from the local area.

12. Click Continue and select the radio button N next to the question Set
further address types?

13. Click Continue and specify the Maximum waiting time for repeat send
attempt procedure: in the Hours and Minutes fields.

14. Click Continue and specify the appropriate radio buttons to indicate that this
node cannot resolve path references.

15. Click Continue and specify the Node is ready for use radio button.
Once you set this value, you receive a status panel that shows your node
defined to the SAP R/3 system.

Configuring the SAPconnect daemon on InfoPrint Manager

Before you can begin to send faxes from your SAP R/3 system to InfoPrint
Manager, you must do these steps to configure the SAPconnect daemon on your
InfoPrint Manager AIX server:
1. “Configuring the RFC initialization file on InfoPrint Manager”
2. “Starting the SAPconnect daemon from the InfoPrint Manager AIX server” on

page 86
3. “Configuring to start SAPconnect daemons on system reboot” on page 87

Configuring the RFC initialization file on InfoPrint Manager:

Before your InfoPrint Manager AIX server can begin to receive SAPconnect RFC
requests from a particular SAP R/3 system, you must edit and configure both the
RFC Server Information (see step 2) and the RFC Client Information (see step 4 on
page 85) found in the saprfc.ini file.

Use this procedure to do this task on your InfoPrint Manager AIX server:
1. From an AIX command line, copy the default saprfc.ini file from its default

location to the /var/pd directory where it must be installed by typing :
cp /usr/lpp/pd/bin/saprfc.ini /var/pd/saprfc.ini

If you are reinstalling, make sure that you copy any customization you’ve
made from your existing /var/pd/saprfc.ini file to the new file so it is not lost.

2. From the /var/pd directory, edit the saprfc.ini file and copy this sample block
of server information to the bottom of the file:
# RFC Server Information

#DEST=<SAP defined Destination>
#TYPE=R
#PROGID=<SAP defined Program ID>
#GWHOST=<HostName of the SAP Gateway>
#GWSERV=<Service Name of the SAP Gateway>
#RFC_TRACE=1
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3. Remove the comment indicator (#) in front of each line that follows the # RFC
Server Information line and fill in the appropriate values for these fields by
replacing the terms defined in the angle brackets with the actual values that
you used on your SAP R/3 system in “Creating an SAP RFC destination” on
page 81.
These values must match exactly the values you used in creating your RFC
Destination:
# RFC Server Information

DEST=NEW_DEST827
TYPE=R
PROGID=info1.sapconnd
GWHOST=cpmat00
GWSERV=sapgw10
RFC_TRACE=1

4. Copy one of these sample blocks of SAP client information to the bottom of the
file.
If you copy the Load Balancing block, SAP R/3 will determine which SAP
application server the SAPconnect daemon logs onto at runtime, using the load
balancing feature of SAP R/3.
Copy the Specific Application Server block if you have only one SAP
application server:
# RFC Client Information - Specific Application Server

#DEST=<SAP System Name>
#TYPE= A
#ASHOST=<SAP Application Server Host>
#SYSNR=<SAP System Number>
#GWHOST=<optional, default: gateway on Application Server>
#GWSERV=<optional, default: gateway on Application Server>
#RFC_TRACE=1
#ABAP_DEBUG=0
#USE_SAPGUI=0

Copy the Load Balancing block if you have more than one SAP application
server and you want the SAP R/3 system to determine which SAP application
server the SAPconnect daemon logs onto at runtime:
# RFC Client Information - Load Balancing

#DEST=<SAP System Name>
#TYPE=B
#R3NAME=<SAP System Name>
#MSHOST=<Host Name of the Message Server>
#GROUP=<Application Servers group name, optional, default: PUBLIC>
#RFC_TRACE=1
#ABAP_DEBUG=0
#USE_SAPGUI=0

5. Remove the comment indicator (#) in front of each line that follows the # RFC
Server Information line, and fill in the appropriate values for these fields by
replacing the terms defined in the angle brackets with the actual values that
you used on your SAP R/3 system.
These values must match exactly to those set on the SAP system. The only
exception to this rule are the GWHOST and GWSERV parameters, which can
be left commented out.
# RFC Client Information - Specific Application Server

DEST=SJD
TYPE=A
ASHOST=cpmat00
SYSNR=10
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#GWHOST=cpmat00
#GWSERV=sapgw10
RFC_TRACE=1
ABAP_DEBUG=0
USE_SAPGUI=0

6. Exit the saprfc.ini file and save your changes.
7. To make sure that the InfoPrint SAPconnect daemon will be able to

communicate with whatever SAP application server, SAP Gateway server, and
SAP Message server that you refer to in the saprfc.ini file, you must be able to
issue a ping command against these servers by name (not an IP address in
dotted decimal notation format).
If you cannot ping the various SAP hosts by name (for example, ping cpmat00),
you must
a. From an AIX command line, move to the /etc directory: cd /etc

b. Using your AIX editor of choice, edit the hosts file and copy the host names
of the SAP Gateway (GWHOST=cpmat00), the SAP application server
(ASHOST=cpmat00), and the message server (MSHOST=cpmat00 ) in the format:
ip_address cpmat00 # SAP Gateway hostname address

Note: It is not sufficient to be able to issue a ping command using the
dotted decimal notation IP address of the SAP application server.

Starting the SAPconnect daemon from the InfoPrint Manager AIX server:

Each SAP R/3 system using the InfoPrint Manager SAPconnect Fax support needs
to have one SAPconnect daemon running. To start the SAPconnect daemon, you
must edit and run the /etc/rc.iprsap file from the AIX command line on your
InfoPrint Manager AIX server.
1. From the AIX command line, copy these lines of this file from the

/usr/lpp/pd/bin/rc.iprsap that you just installed to the /etc/rc.iprsap file,
being careful not to overwrite any previous definitions:
# echo Starting sapconnectd <System Name>

# /usr/lpp/pd/bin/startsapconnectd <SAPDestinationName <SAPSystemName>
<IPMLogicalDestinationName> <User> <Client> <Password> <Language>

2. From the AIX command line, access the rc.iprsap file in the /etc directory. Edit
the file to copy and uncomment the two lines for the :
a. An echo statement that states that the SAPconnect daemon has been started:

echo Starting sapconnectd <System Name>

b. The startsapconnectd command:
/usr/lpp/pd/bin/startsapconnectd <SAPDestinationName <SAPSystemName>
<IPMLogicalDestinationName> <User> <Client> <Password> <Language>

3. Specify the appropriate values for the items in angle brackets.

SAPDestinationName
Specifies the name of the destination that you defined in “Creating an
SAP RFC destination” on page 81 and put in the server DEST= field
value in the saprfc.ini file.

SAPSystemName
Specifies the three-character name of the SAP system. This value must
match the client DEST= field value in the saprfc.ini file.
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IPMLogicalDestinationName
Specifies the name of the logical destination on your InfoPrint Manager
AIX server that feeds faxes to the InfoPrint Manager fax actual
destination.

User The SAP user name defined in “Creating a CPIC or system type user
for the InfoPrint Manager SAPconnect daemon” on page 81.

Client The SAP client name.

Password
The SAP R/3 system password.

Language
The two-character language value.

4. Once you have saved and exited the file, start the SAPconnect daemon from
the command line by specifying:
/etc/rc.iprsap

If the SAPconnect daemon starts correctly, you should see this response:
Starting sapconnectd SJD
5010-405 Successfully started server sapconnd.SJD

where SJD represents the name of your SAP system.
If you receive any other message, the daemon has not started correctly. To
resolve the problem, see the /var/pd/sapconnd.sysname/error.log file (where
sysname is the SAP R/3 system name to which the SAPconnect daemon is
connected), correct the problems cited, and try to start the SAPconnect daemon
again. If it still does not start correctly, contact your InfoPrint Solutions
Company technical support representative.

Configuring to start SAPconnect daemons on system reboot:

The SAPconnect daemon needs to run all the time. To make sure that the daemon
is restarted if the AIX system that it runs on is rebooted, you need to do one more
step to add the rc.iprsap file to the /etc/inittab directory, if it has not already been
added.

To make sure that the SAPconnect daemons are restarted automatically whenever
the system they are running on is restarted, use the SMIT interface: InfoPrint
Solutions → InfoPrint Utilities → SAP Daemons.

From the SAP Daemons panel, select the Start SAP daemons at reboot option. This
action affects SAP Callback daemons (sapcbd) as well and only needs to be done
once.

If you prefer the command line, you can enter this at the AIX command line
instead:
mkitab "rciprsap:2:once:/etc/rc.iprsap.out 2>&1 # Autostart of Infoprint SAP \
daemons"

Both the SMIT interface and this command make sure that the SAP daemons
(sapconnectd) are restarted automatically whenever the systems they are running
on are restarted.

As you add more SAPconnect daemons to your InfoPrint Manager configuration,
you do not have to do this step, but you do need to add a new echo and
startsapconnectd entry in the /etc/rc.iprsap file and type /etc/rc.iprsap on the
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AIX command line. This line starts your new SAPconnect daemons and causes any
running SAPconnect daemons or SAP Callback daemons to report that they are
already running.

Shutting down the SAPconnect daemon

This procedure describes how you can shut down the SAPconnect daemon. This
procedure is useful if you are migrating the SAPconnect daemon from one
InfoPrint Manager AIX server to another, or if the SAP R/3 system it supports is
not going to be used for a while.

From an AIX command line on the system where the SAPconnect daemon is
currently running, type:
stopsapconnectd systemname

where systemname is your three-character SAP R/3 system name.

If you do not want a reboot of the system to restart the SAPconnect daemon,
remove its entry from the /etc/rc.iprsap file.

To make sure that neither SAPconnect daemons or SAP Callback daemons are
restarted automatically whenever the systems they are running on are restarted,
use the InfoPrint SMIT interface: InfoPrint Solutions → InfoPrint Utilities → SAP
Daemons.

From the SAP Daemons panel, select the Do not start SAP daemons at reboot
option.

Note: Remember that this action also means that the SAP Callback daemon
(sapcbd) is not restarted when the InfoPrint Manager AIX server reboots.

Testing the RFC from SAP R/3

Once you have done the configuration tasks on both the SAP R/3 system and your
InfoPrint Manager AIX server for sending Remote Function Calls (RFCs) consisting
of fax data, it is time to test your installation. Use these two procedures:
1. “Verify your RFC connection”
2. “Verify that node can route fax numbers”

Once you have verified that your InfoPrint Manager AIX server and your SAP R/3
server can communicate, you can begin sending faxes from your SAP R/3 system.

Verify your RFC connection:

From the RFC Destination NEW_DEST827 window main menu, take the Test →
Connection options path to verify the connection. The RFC—Connection Test
pop-up dialog will display either a working connection or provide an error
message to indicate the source of the problem.

Verify that node can route fax numbers:

To verify that SAP can route fax numbers to the node you created in “Creating a
SAPconnect node” on page 83, use this procedure to perform a routing test. For
our example, we defined an unrestrictive value of *, so all numbers should
correctly resolve:
1. Log into the SAP R/3 GUI.
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2. Type SCOT in the field on the left side of the menu bar.
If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar, between the Enter (green checkmark) and diskette icons.

3. From the SAPconnect: Administration (view) window (where view specifies one
of a series of views; it does not matter which view you select), select the
Utilities → Routing test path.

4. From the SAPconnect: Test routes window, fill in these field values:

Sender
Specifies the SAP sender ID from which the fax is to be submitted.

RecipientAddr.type
Select or type in FAX.

Recipient addr.
Specify the complete fax number to which you are submitting the fax
job, prepended with the destination country abbreviation.

5. Once you have specified these values, press the Enter key to test these values.
If the number is provided in the correct format (which you defined in Step 8 on
page 83 of “Creating a SAPconnect node” on page 83), the Outbound node and
modified recipient address portion of the window displays the node to be used
in the Node field and the number as it is sent to InfoPrint Manager in the
Recipient addr. field. No message appears in the text block at the bottom of the
window.
If the number provided is not in the correct format, the text block at the bottom
of the page displays a red circle embossed with a white X and a message
similar to this: No delivery to 99999, invalid recipient address.

6. If you receive an error, click the magnifying glass icon on the upper-left side of
the window to access the SAPconnect: Explanation of Routing and Address
Conversion window.
This window explains each step in the SAP routing process and shows any
errors where they appeared. Use this window to diagnose problems connecting
to SAP fax numbers.

7. Once you discover the source of your error, to modify the node’s address area,
you should access your Node definition by:
a. Typing the SCOT transaction.
b. Clicking the View → Node path.
c. Clicking the Change (pencil) icon.
d. Double-clicking on the value under FAX (for our example *) and specifying

a different set of criterion in the SAPconnect: Maintain address area pop-up
dialog.

Once changed, repeat this procedure until you stop receiving an error.

Preparing and sending faxes from R/3

Once you have verified the connection, you should use these procedures from your
SAP R/3 system to make sure that you can prepare and send faxes:
1. “Creating addresses” on page 90
2. “Creating documents” on page 90
3. “Configuring to send faxes automatically” on page 91

Once these steps have been verified, you can assign the necessary fax numbers and
permissions to SAP users on the system so they can submit faxes through InfoPrint
Manager.
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Creating addresses:

Before sending faxes, an SAP administrator must assign a personal fax number to
any SAP user who plans to use this feature. To do this task, use this procedure:
1. Log into the SAP R/3 GUI.
2. Type SU01 in the field on the left side of the menu bar.

If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar between the Enter (green checkmark) and diskette icons.

3. From the User Maintenance: Initial Screen window, specify the ID from which
you will be faxing output in the User field and click Change (pencil) on the left
side of the menu.

4. From the Maintain User window, click the Address tab, scroll down to the Fax
field, and type your number.
For all outgoing calls, this fax number is used as the originator address.

5. Click Save (diskette) to save this data.

Creating documents:

To create a document either with or without attachments in the SAPoffice Outbox,
use this procedure:
1. Log into the SAP R/3 GUI.
2. Type SBWP in the field on the left side of the menu bar.

If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar between the Enter (green checkmark) and diskette icons.

3. Start the Business Workplace application from the Business Workplace of ...
window, and then access the Workplace pane on the left side, click open the
Outbox, and double-click Documents.

4. From the resulting right pane view, click Create Document (second icon to the
left).

5. From the Create Document pop-up dialog, access the Documents contents tab
and type in your message.

6. To add an attachment to this document, take the Document → Create
attachment options path.
Once selected, you can access the Attachments tab and see the result.

7. Click on the Send icon (envelope sticking out of a mail slot on far left).
8. From the Send Document window, you can specify a single recipient for a fax

or create a distribution list to use to send the fax. Remember to start with the
country code for each recipient. For example, specify us9303123456 and then
click the Send icon (envelope sticking out of a mail slot on far left) at the
bottom of the window.
SAP R/3 submits your job to the SAPconnect queue and puts a message at the
bottom of the Business Workplace™ of ... window. This message indicates that
the document has been sent to the SAPconnect queue. To move the document
to the InfoPrint server, you must follow the procedure in “Starting the send
process.”

Starting the send process:

Any fax jobs that you have submitted to the SAPconnect queue will be available
for selecting. To test fax documents that have been received in the SAPconnect
queue on the SAP system are successfully sent onto the InfoPrint Manager AIX
server, use this procedure.
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1. Log into the SAP R/3 GUI.
2. Type SCOT in the field on the left side of the menu bar.

If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar between the Enter (green checkmark) and diskette icons.

3. From the SAPconnect: Administration (jobs) window (the particular view does
not matter), select the Utilities → Start send process path from the menu bar.

4. On the Start send process pop-up dialog, select an Addr. type field value of FAX
and click the green checkmark in the lower left corner.

5. From the SAPconnect Send Process: List of Objects Selected window, click
Choose.
The Express information pop-up dialog provides status on your job.

Configuring to send faxes automatically:

Once you have verified that you can send faxes through the manual process
described in “Starting the send process” on page 90, you should configure your
SAP system so the send processes are scheduled as a background process that
executes automatically on a periodic basis. To schedule the sending of faxes as a
background job, use this procedure:
1. Log into the SAP R/3 GUI.
2. Type SCOT in the field on the left side of the menu bar.

If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar between the Enter (green checkmark) and diskette icons.
Make sure that you select View → Jobs from the drop-down menu.

3. From the SAPconnect: Administration (jobs) window, click Dispatch (piece of
paper with upper-right corner folded).

4. From the Schedule send process pop-up dialog, enter a name to represent the
batch job for sending faxes and click Enter.

5. To schedule, you can either:
v Click on FAX and then click Schedule job.
v From the SAPconnect send process: Variants window, highlight the Fax

variant and click Schedule job (second from left).
6. From the SAPconnect send process Scheduling: Start Time window, you can

specify the sending characteristics of this job by clicking on the Schedule
Periodically button and set values for how often you want the fax requests to
be sent.

7. From the Period duration window, set a time, being sure to move the radio
button to select the time designation that you are setting.
For example, the Repeat period window sets the Months field value.
Once you have set your value, be sure that it is saved by checking the green
checkbox at the bottom of the dialog and then accessing the settings again to
verify.

Using SAPconnect for fax-in support (receiving faxes)

By configuring SAP to use the new InfoPrint Manager SAPconnect support, the
SAP System receives the request in the form of an SAP RFC call. The SAP user’s
fax line uses InfoPrint Manager’s fax in support to send incoming faxes to an
InfoPrint Manager logical destination, which forwards faxes to a sapconnect actual
destination that is running on the InfoPrint Manager AIX server. The sapconnect
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actual destination makes SAP RFC calls to the SAP system. When the SAP System
receives the fax request for a particular fax number, it delivers the job to that user’s
In box.

One sapconnect actual destination can deliver faxes for all users on one SAP
system who have defined fax lines. Create one sapconnect destination for each SAP
system you plan to support.

Once you have made sure that the prerequisites are installed on your InfoPrint
Manager AIX server (see “Installing the SAPconnect support” on page 79), you
must complete these configuration tasks to send faxes to an SAP user:
1. “Creating a CPIC or system type user ID for the InfoPrint Manager sapconnect

actual destination”
2. “Creating InfoPrint Manager objects”
3. “Logging the InfoPrint actual destination onto the SAP system” on page 94
4. “Assigning fax numbers to SAP users” on page 94
5. “Configure the fax-in lines to feed the SAPconnect actual destination on an

InfoPrint Manager AIX server” on page 94
6. “Test sending faxes to SAP system” on page 94

Creating a CPIC or system type user ID for the InfoPrint Manager
sapconnect actual destination

Because the InfoPrint Manager sapconnect actual destination must logon to the
SAP system to deliver RFC requests to the SAP system that is receiving fax input,
you must create an SAP user ID for it. This user ID allows the sapconnect actual
destination to send data to the SAP system.

To create a user for the sapconnect actual destination, use transaction su01 to
access the User Maintenance: Initial Screen window.

The user must be a CPIC or System type and have authorizations provided in the
S_A.SCON profile. Remember to record the user ID, password, and client values
for when you create the sapconnect actual destination in “Creating InfoPrint
Manager objects.”

If you ever modify this SAP user ID, remember to make the same changes to the
sapconnect actual destination on the InfoPrint Manager AIX server.

Creating InfoPrint Manager objects

To create the objects on an AIX InfoPrint Manager server necessary to send fax jobs
to the SAP system, use this procedure.

Note: The InfoPrint Manager Administration GUI provides a wizard to accomplish
Steps 2 on page 93 through 7 on page 93. You can either use the command line
procedure described below, or access the GUI and create the appropriate printer
and objects. For more information about using the GUI, see both the InfoPrint
Manager Administration GUI online help and the “Creating and managing actual
destinations” chapter of the InfoPrint Manager for AIX: Procedures manual.
1. Collect the information you require to define this actual destination to

communicate with an SAP system:

Required information Example

SAP system name SJD
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Required information Example

SAP system host name cpmat00

SAP system number 01

CPIC user ID sapuser1

CPIC user ID password password

CPIC user ID client 095

SAP Gateway Service (for future use)

SAP Gateway Host (for future use)

Program ID (for future use)

2. Use the pdcreate command to define both a queue and a logical destination to
feed the sapconnect actual destination:
v For example, to create a queue named sjd-faxin-queue on the server IPM1,

type:
pdcreate —c queue IPM1:sjd–faxin-queue

v For example, to create a logical destination named sjd-faxin-ld that is
associated with the sjd-faxin-queue queue, type:
pdcreate -x "associated-queue=sjd–faxin-queue" IPM1:sjd-faxin-ld

3. From an AIX command line, access the SAPconnect attributes file from the
/usr/lpp/pd/attr directory.

4. Copy and rename this file in another directory on your system:
cp /usr/lpp/pd/attr/SAPconnect /var/pd/SAPconnect1

5. Use your AIX editor of choice to edit the file (in this case, SAPconnect1) and fill
in the values you collected in Step 1 on page 92 and the name of the queue that
you created in Step 2.
This contains a copy of the SAPconnect attributes file that is provided with
InfoPrint Manager:
# This attribute file contains all the attributes you need to
# create a SAPConnect Actual Destination.
# Copy this file and add in the required information.
#
#
device-support-system = sapconnect
printer-realization = physical
associated-queue =
sap-system-name =
sap-system-hostname =
sap-system-number =
sap-logon-user ID =
sap-logon-password =
sap-logon-client =
sap-gateway-service =
sap-gateway-host =
sap-program-id =

6. From an AIX command line, enter this command to create the sapconnect
actual destination.
pdcreate -X SAPconnect1 IPM1:sjd-faxin

where IPM1 is the name for your InfoPrint Manager AIX server and sjd-faxin
is the name of the sapconnect actual destination.

7. From the AIX command line, enable the logical destination:
pdenable sjd-faxin-ld
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Logging the InfoPrint actual destination onto the SAP system

Before the InfoPrint Manager Fax and SAPconnect support can deliver incoming
faxes to SAP, the sapconnect actual destination must be enabled. Issue a pdenable
command on this actual destination:
pdenable -c destination sjd-faxin

When enabled, the sjd-faxin actual destination logs onto the SAP system. Once the
sapconnect DSS actual destination is enabled and logged onto the SAP system, the
SAP users on that system can begin receiving faxes.

Note: The SAP logon might appear to work even if the logon information is
incorrect. When the first fax is processed, if the sapconnect actual destination on
the InfoPrint Manager AIX server becomes disabled, look at the problem message
attribute on the actual destination to see the cause of the problem.

Assigning fax numbers to SAP users

Before receiving faxes, an administrator must assign a personal fax number to any
SAP user who plans to use this feature. To do this task, use this procedure:
1. Log into the SAP R/3 GUI.
2. Type SU01 in the field on the left side of the menu bar.

If this field is closed, you might need to click the right-facing arrow on the left
side of the menu bar between the Enter (green checkmark) and diskette icons.

3. From the User Maintenance: Initial Screen window, specify the ID from which
you will be faxing output in the User field and click Change (pencil) on the left
side of the menu.

4. From the Maintain User window, click Address, scroll down to the Fax field,
and type your number.
For all outgoing calls, this fax number is used as the originator address.

5. Click Save to save this data.

These fax numbers are those that must be mapped to channel numbers in
“Configure the fax-in lines to feed the SAPconnect actual destination on an
InfoPrint Manager AIX server.”

Configure the fax-in lines to feed the SAPconnect actual
destination on an InfoPrint Manager AIX server

To receive incoming faxes through InfoPrint Manager, you must first purchase,
configure, and install the InfoPrint Fax feature.

To do this task, see the “Configuring Fax In (Receiving)” topic from the
“Configuring and using InfoPrint Manager Fax” in the InfoPrint Manager for AIX:
Configuring and Using InfoPrint Fax publication to do the necessary configuration
tasks on your InfoPrint Manager AIX server.

Test sending faxes to SAP system

To verify that you have configured the system correctly and can send faxes, send a
fax to one of the SAP users defined fax numbers and verify that the fax appears in
their SAP Business Workplace Inbox.
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Chapter 15. Print support that applies to both InfoPrint
Manager AIX and Windows servers

These sections describe SAP R/3 features that can be used by installations running
SAP R/3 Release 4 and later with either InfoPrint Manager for AIX 4.3 or InfoPrint
Manager for Windows 2.3. All interfaces apply to both AIX and Windows
platforms unless clearly identified with a particular operating system.

Customizing print characteristics
These sections describe how you can change output appearance when printing
through InfoPrint Manager by modifying SAP devices and formats.

How InfoPrint processes code pages from ABAP and OTF
jobs

Code page support for OTF jobs is more flexible than for ABAP jobs.

Because OTF jobs request a specific font, the SAP transform compares the specified
font name and point size values with the entries in the fonts.tab configuration file.
If the transform finds a match, it uses both the AFP character set and AFP code
page for the print job.

ABAP jobs can use different character sets, but are confined to using the same code
page. When processing ABAP files, the SAP transform uses:
v The defcp.tab file to map single-byte ASCII code points to EBCDIC code points

before calling the uconv utility.
v The pagedef.tab file to match the Paper parameter value with the PJPAPER

parameter value in the ABAP print job.
Once they are matched, the SAP transform uses the FontNorm and FontBold
parameters on the selected line in the pagedef.tab file to determine which
character sets to use in both normal and bold mode.

As a result, all ABAP jobs sent to a particular InfoPrint server use the same code
page, but potentially different character sets, depending upon the PJPAPER value
specified in the job.

Defining a customized device type

An SAP device type is a collection of table entries that you can access and modify
online to describe the fonts, the printer driver to use to create the data, and the
formats that can be used for SAPscript printing. Every output device must have a
device type that is used to process the output document. An actual destination can
have many output devices, with different device types for each one.

For basic printing, the SAP transform can use existing device types (such as
SAPGOF) and existing formats, such as LETTER or X_65_255. However, if you
plan on customizing any of these print characteristics, you should create a
customized device type so that you will not loose data when you upgrade your
SAP R/3 system.
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To create a customized device type, an SAP R/3 administrator must do this
procedure from the SAP R/3 graphical user interface:
1. From the R/3 main menu, access the Spool Administration window by

selecting Tools main menu and then selecting the Tools → Administration →
Spool → Spool Administration path or typing /nSPAD in the ok-Code field.

2. From the Spool Administration window, select Utilities → Copy device type
pull-down option.

3. From the Copy Device Type window, specify the device type you want to
customize (in this case, SAPGOF) in the Copy device type field and provide a
name for your customized Device Type (in this case, ZDOCGOF) in the to device
type field.

Note: Any customized Device Type must start with the Z character or it will be
overwritten when you upgrade to a new level of SAP R/3.

4. From the menu bar, click Execute.
5. From the Create Object Catalog Entry window, decide whether you want to be

able to copy this customized device type to another SAP system. If you do,
specify a Development class field value.
If you do not need to copy this Device Type to another SAP system, click Local
object:

6. Click Save.

SAP R/3 provides a screen to show the customized Device Type and the original
device type from which it was copied.

Changing document print orientation
The sap2afp transform lets you enhance the quality of your printing from an SAP
R/3 enterprise through the use of form definitions. Form definitions allow you to
use electronic overlays and specify both media orientation (how the page is
printed) and bin selection. The sap2afp transform defines which form definition
should be used for printing through the use of Formats. Every spool job in R/3
requires a Format (Paper type), whether it is ABAP data (X_65_80) or OTF data
(LETTER). SAP R/3 formats are mapped to Advanced Function Presentation (AFP)
form definitions in the pagedef.tab configuration file. You can display the Format
of a spool request in the output controller (SP01).

By default, the sap2afp transform uses “F1SAP form definition” on page 100,
which by default defines duplex, portrait printing. In addition, InfoPrint Manager
provides an assortment of form definitions, which are documented in the InfoPrint
Manager: Reference. Consult this list to find a form definition that meets your
printing needs.

This section describes how to specify landscape media orientation through a form
definition for an entire document and then connect the newly-created format to a
device type. By mapping an SAP Format to a form definition in the pagedef.tab
file, you can define the media style for the entire job. Depending upon the type of
data you wish to print, there are two separate procedures:
v “Defining a customized device type for ABAP jobs”
v “Defining a new OTF format” on page 97

Defining a customized device type for ABAP jobs

If you are printing Advanced Business Application Programming (ABAP) jobs, you
must create a blank ABAP Format in the SAP system by using this procedure:
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1. From the R/3 main menu, access the Spool Administration window by
selecting the Tools main menu and then selecting Tools → Administration →
Spool → Spool Administration path, or typing /nSPAD in the ok-Code field.

2. From the Spool Administration: Initial Screen window, select the Formats
option and click Change.

3. From the Spool Administration: Format window, select an existing Format (in
this case, X_65_255) from which to copy.

Note: All ABAP system formats follow the naming convention of
X_number-of-rows_number-of-columns.

4. From the Spool Administration: Copy Format from X_65_255 window, specify
the name of your customized Format with the naming convention of
Z_number-of-rows_number-of-columns_more-identifying-text.

5. Click the back icon (the left-pointing arrow) and the system prompts you to
save the new ABAP format.

Once you have saved the new ABAP format, you must use “Connecting a new
format to a device type” on page 98.

Defining a new OTF format

If you are printing Output Text Format (OTF) jobs, you must create page format
with the same name as the customized format you plan to apply:
1. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting the Tools → Administration
→ Spool → Spool Administration path. or typing the /nSPAD transaction in the
ok-Code field.

2. From the Spool Administration: Initial Screen window, select the Page formats
option and click Change.

3. Select the page format that you want to copy (in this case, LETTER) and click
copy from.

4. From the Spool Administration: Copy Page Format from LETTER window,
specify the name of the customized paper type that you are creating (in this
case, ZLETDOC).

5. Select the back icon (the left-pointing arrow) and the system prompts you to
save the new page format.

6. Specify /nSPAD in the ok-Code field.
7. From the Spool Administration: Initial Screen window, select the Formats

option and click Change.
8. Select the Format that you wish to copy (in this case, ZLETDOC), and click Copy

from

9. From the Spool Administration: Copy Format from LETTER window, fill in
the values as displayed in Figure 11 on page 98:
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10. Click the Back icon (the left-pointing arrow) and the system prompts you to
save the new OTF format.

Once you have saved the new OTF format, you must use “Connecting a new
format to a device type.”

Connecting a new format to a device type

To use the format you created, you must connect the format to a device type by
doing these steps:
1. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting the Tools → Administration
→ Spool → Spool Administration path. or typing /nSPAD in the ok-Code field.

2. From the Spool Administration: Initial Screen window, select the Device
formats option and click Change.

Figure 11. Spool Administration: Copy Format from LETTER window
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3. From the Spool Administration: Choose Format for Device Type window,
specify the Device Type (link to creating custom device types) and your
customized Format name (in this case, Z_65_255_DOC or ZLETDOC) in the
appropriate fields.

Note: All ABAP customized user Formats follow the naming convention of
Z_number-of-rows_number-of-columns_descriptive-text.

4. Click Execute.
5. From the Maintain Format for Device Type window, the blank left column

indicates that the customized format has not yet been initialized.
6. Click Copy format.
7. From the Spool Administration: Copy Format window, you can see that the

system has filled in the information from the Maintain Format for Device Type
window.

8. Press the Copy from button to initialize your new Format.
9. Click the back icon (the left-pointing arrow) and the system prompts you to

save the new format.
10. Access the pagedef.tab configuration file that is located in the

/usr/lpp/psf/sap2afp directory on an InfoPrint Manager AIX server and the
install_path\sap2afp folder on an InfoPrint Manager Windows server.

11. In the pagedef.tab configuration file, create a new entry for the format that
you just created. If you are printing landscape, specify F1C10011 as the form
definition value.

Note: All fields must be specified in pagedef.tab. However, for OTF printing,
only the form definition value is used, while ABAP printing uses all values.

12. Exit and save the pagedef.tab configuration file.

Changing page print orientation

The sap2afp transform lets you enhance the quality of your printing from an SAP
R/3 enterprise through the use of form definitions. Form definitions allow you to
use electronic overlays and specify both media orientation (how the page is
printed) and bin selection. A form definition can consist of multiple copy groups,
which are also known as media maps.

This procedure shows how you can define a name for each defined page in an
existing Layout Set. If you do not need to change page orientation on a
page-by-page basis, see “Changing document print orientation” on page 96.
Page-by-page mapping is necessary only if different pages in a document are
formatted differently. You should use a custom layout set when making these
changes. If you use a system Layout Set, your changes are overwritten each time
you upgrade your SAP R/3 system. Remember that each media map remains in
effect until SAP R/3 encounters a new media map.

Every spool job in R/3 requires a format (Paper type), whether it is ABAP data
(X_65_80) or OTF data (LETTER). SAP R/3 formats are mapped to Advanced
Function Presentation (AFP) form definitions in the pagedef.tab configuration file.
You can display the format of a spool request in the output controller (SP01).

When mapping an SAP Format to a form definition in the pagedef.tab file, the first
media map in the form definition defines the media style for the entire job. If you
have a job that contains different electronic overlays on each page, you might have
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to switch media styles on each page. The sap2afp transform converts names
defined in SAP Layout Sets in the paper resources for pages to AFP media map
names. For each page that defines a paper resource, the sap2afp transform uses the
AFP media map.

By default, the sap2afp transform uses “F1SAP form definition,” which contains 25
separate media maps for simplex printing, duplex printing, bin selection, and page
orientation. In addition, InfoPrint Manager provides an assortment of form
definitions, which are described in the InfoPrint Manager: Reference.

Use this procedure on your SAP application server to modify the media map on
any page of a job by specifying the media map defined in the F1SAP form
definition for the Resource name field:
1. From the SAP R/3 graphical user interface, access the Layout Set menu screen.

You can access this view from the SAP R/3 main menu by either specifying the
SE71 transaction code in the ok-Code field, or by selecting: Tools → Word
Processing → Layout Set

Note: In SAP R/3 Release 4.6C, the Layout Set menu is the Page menu, which
contains the Resource Name field cited in step 3.

2. From the Layout Set main menu, access the Change Pages option and select
the job for which you are changing page orientation (in this case, ZASORDER1).

3. From the first page of the job, double-click so that it is highlighted and fill in
the Resource Name field (under the Print Attributes pane).

4. Double-click the next page that you intend to modify and fill in the Resource
Name field on the second page.

5. Continue with the same procedure on any page where you want to specify a
new media style.

6. Once you have finished, click Save (open folder) to save this setting.

F1SAP form definition

The form definition specified in the pagedef.tab configuration file is the default
submitted with every Advanced Function Presentation (AFP) data stream
document. F1SAP is the default form definition that each of the media maps
references. Table 8 briefly describes the media maps contained in this form
definition.

Note: The print direction is across and the Page Position in inches from the edge
of the paper is 0.165,0.165 for all 25 media maps.

Table 8. F1SAP Form Definition Values

Media map Bin Sides Presentation mode

F1A10111 1 2 Portrait

S100000P 1 1 Portrait

S200000P 2 1 Portrait

S300000P 3 1 Portrait

S400000P 4 1 Portrait

D100000P 1 2 Portrait

D200000P 2 2 Portrait

D300000P 3 2 Portrait
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Table 8. F1SAP Form Definition Values (continued)

Media map Bin Sides Presentation mode

D400000P 4 2 Portrait

T100000P 1 2 (Tumble) Portrait

T200000P 2 2 (Tumble) Portrait

T300000P 3 2 (Tumble) Portrait

T400000P 4 2 (Tumble) Portrait

S100000L 1 1 Landscape

S200000L 2 1 Landscape

S300000L 3 1 Landscape

S400000L 4 1 Landscape

D100000L 1 2 Landscape

D200000L 2 2 Landscape

D300000L 3 2 Landscape

D400000L 4 2 Landscape

T100000L 1 2 (Tumble) Landscape

T200000L 2 2 (Tumble) Landscape

T300000L 3 2 (Tumble) Landscape

T400000L 4 2 (Tumble) Landscape

Enabling non-Latin character sets

The sap2afp transform supports the use of these non-Latin character sets on both
the AIX and Windows operating systems:
v Japanese (Shift-JIS encoding)
v Korean
v Simplified Chinese
v Traditional Chinese
v Cyrillic

All are multi-byte character sets (MBCS) except Cyrillic, which is single-byte.

The sap2afp transform supports these character sets through the use of the uconv
utility. To use this support, you must run the SAPGOF (or a compatible) device
type on an SAP R/3 system at Release 4.0A or higher.

Before doing these configuration tasks on AIX and Windows systems, you must
first obtain and install the selected AFP fonts that are required for printing.
v ABAP data requires raster fonts.
v OTF data can be printed with either raster or outline fonts.

You can obtain these resources from either of these product CD-ROMs:
v AFP Font Collection: Fonts for AIX, Windows NT, Windows 2000, and OS/2,

LK2T-9269 (program number 5648-B45). This product includes both raster and
outline fonts. For more information about purchasing this product, see either
your sales representative or access the AFP Font Collection home page
(http://www.printers.ibm.com/internet/wwsites.nsf/vwwebpublished/
afpfonthome_m_ww) on the World Wide Web.
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Notes: AFP Font Collection delivers multi-byte fonts on these optional
CD-ROMs:
– Japanese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9276
– Korean Fonts for AIX, Windows NT, and Windows 2000, LK2T-9278
– Simplified Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9280
– Traditional Chinese Fonts for AIX, Windows NT, and Windows 2000, LK2T-9282

v Infoprint Fonts for Multiplatforms, LCD4-5587 (program number 5648-E77). This
product includes outline fonts only. For more information about purchasing this
product, see either your sales representative or access the AFP Font Collection
home page (http://www.printers.ibm.com/internet/wwsites.nsf/
vwwebpublished/ ipfontshome_m_ww) on the World Wide Web.

Notes: Infoprint Fonts for Multiplatforms delivers multi-byte fonts on these
optional CD-ROMs:
– Japanese Font Library, LCD4-5589
– Korean Font Library, LCD4-5591
– Simplified Chinese Font Library, LCD4-5593
– Traditional Chinese Font Library, LCD4-5595

Once you have installed these fonts, make sure that your actual destination uses
the /usr/lpp/psf/fontlib directory as its primary search path for fonts. To modify
the font search path from the InfoPrint Manager Administration GUI:
1. From the InfoPrint Manager Administration Servers window, highlight the

actual destination.
2. Right-click and select Properties from the pop-up menu.
3. From the printer properties window, select the AFP Resources tab and specify
v /usr/lpp/psf/fontlib in the Location of fonts field on InfoPrint Manager

for AIX
v install_path\fontlib in the Location of fonts field on InfoPrint Manager

for Windows

Enabling non-Latin character sets on an InfoPrint Manager AIX
server

To support the printing of box characters, these customized conversion files are
provided with the sap2afp transform:
v For Japanese:

IBM-939-SAP2AFP, which extends the IBM-939 conversion file
v For Simplified Chinese:

IBM-1388-SAP2AFP, which extends the IBM-1388 conversion file
v For Traditional Chinese:

IBM-937-SAP2AFP, which extends the IBM-937 conversion file
v For Korean:

IBM-933-SAP2AFP, which extends the IBM-933 conversion file

In addition, InfoPrint provides these Korean resources in the /usr/lpp/psf/
sap2afp/koreanfonts directory:
v C0H0GW72.240 (dpi Korean Gothic character sets)
v C0H0GW96.240 (dpi Korean Gothic character sets)
v C0H0MW72.240 (dpi Korean Myengjo character sets)
v C0H0MW96.240 (dpi Korean Myengjo character sets)
v T1H01150 (Korean code page)
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With both dpi Korean Gothic character sets and dpi Korean Myengjo character sets
at either 7.2 point size or 9.6 point size, you can print with both box characters and
the check box on and off characters.

InfoPrint provides a Cyrillic code page that includes box characters, T1001172.CDP,
in the /usr/lpp/psf/sap2afp/cyrillic directory. It also provides page definitions
modified for Cyrillic support, P1CYR182 and P1CYR683, in the
/usr/lpp/psf/sap2afp/cyrillic directory.

To enable non-Latin character support on an InfoPrint Manager AIX server, an
administrator must do this procedure:
1. Obtain and install the fonts required for printing the script that you want to

support.
2. Create backup copies of these current files:

Script Files

Cyrillic
/usr/lpp/psf/fontlib/T1001172.CDP
/usr/lpp/psf/reslib/P1CYR182
/usr/lpp/psf/reslib/P1CYR683

3. Copy these files:

Script Source file Target file or directory

Korean All files in /sap2afp/koreanfonts /usr/lpp/psf/fontlib

Cyrillic /usr/lpp/psf/sap2afp/cyrillic/T1001172.CDP /usr/lpp/psf/fontlib/T1001172.CDP

Cyrillic /usr/lpp/psf/sap2afp/cyrillic/P1CYR182 /usr/lpp/psf/reslib/P1CYR182

Cyrillic /usr/lpp/psf/sap2afp/cyrillic/P1CYR683 /usr/lpp/psf/reslib/P1CYR683

4. Enter the script name in the userenv file at this location /usr/lpp/psf/
sap2afp/.
The possible script names are:
japanese, spchinese, tdchinese, korean, cyrillic
Each of these specified script names enable the transform to use the
defcp.tab.language and pagedef.tab.language files corresponding to that
language.

Note: language is:
Japanese

japan
Korean

korea
Simplified Chinese

spchinese
Traditional Chinese

tdchinese
Cyrillic

cyr

When you have completed this procedure, you can modify the pagedef.tab.language
or fonts.tab to specify a different set of fonts. Both these files reside in the
/usr/lpp/psf/sap2afp directory.
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Enabling non-Latin character sets on an InfoPrint Manager
Windows server

To support the printing of box characters, these customized conversion files are
provided with the sap2afp transform:
v For Japanese:

IBM-939-SAP2AFP, which extends the IBM-939 conversion file
v For Simplified Chinese:

IBM-1388-SAP2AFP, which extends the IBM-1388 conversion file
v For Traditional Chinese:

IBM-937-SAP2AFP, which extends the IBM-937 conversion file
v For Korean:

IBM-933-SAP2AFP, which extends the IBM-933 conversion file

In addition, InfoPrint provides these Korean resources in the install_path\sap2afp\
koreanfonts directory:
v C0H0GW72.240 (dpi Korean Gothic character sets)
v C0H0GW96.240 (dpi Korean Gothic character sets)
v C0H0MW72.240 (dpi Korean Myengjo character sets)
v C0H0MW96.240 (dpi Korean Myengjo character sets)
v T1H01150 (Korean code page)

With both dpi Korean Gothic character sets and dpi Korean Myengjo character sets
at either 7.2 point size or 9.6 point size, you can print with both box characters and
the check box on and off characters.

InfoPrint provides a Cyrillic code page that includes box characters, T1001172.CDP,
in the install_path\sap2afp\cyrillic directory. It also provides page definitions
modified for Cyrillic support, P1CYR182 and P1CYR683, in the
install_path\sap2afp\cyrillic directory.

To enable non-Latin character support on an InfoPrint Manager Windows server,
an administrator must do this procedure:
1. Obtain and install the fonts required for printing the script that you want to

support.
2. Create backup copies of these current files:

Script Files

Cyrillic
install_path\fontlib\T1001172.CDP
install_path\reslib\P1CYR182
install_path\reslib\P1CYR683

3. Copy these files:

Script Source file Target file or directory

Korean All files in install_path\sap2afp\koreanfonts install_path\fontlib

Cyrillic install_path\sap2afp\cyrillic\T1001172.CDP install_path\fontlib\T1001172.CDP

Cyrillic install_path\sap2afp\cyrillic\P1CYR182 install_path\reslib\P1CYR182

Cyrillic install_path\sap2afp\cyrillic\P1CYR183 install_path\reslib\P1CYR683

4. Enter the script name in the userenv file at this location install_path\sap2afp\.
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The possible script names are:
japanese, spchinese, tdchinese, korean, cyrillic
Each of these specified script names enable the transform to use the
defcp.tab.language and pagedef.tab.language files corresponding to that
language.

Note: language is:
Japanese

japan
Korean

korea
Simplified Chinese

spchinese
Traditional Chinese

tdchinese
Cyrillic

cyr

When you have completed this procedure, you can modify the pagedef.tab.language
or fonts.tab to specify a different set of fonts. Both these files reside in the
install_path\sap2afp directory.

Enabling Unicode support

The sap2afp transform supports SAP Unicode OTF and ABAP data on both AIX
and Windows operating systems. Also, SAP Unicode OTF and ABAP data is not
supported with PSF-Other destinations, due to PCL Secondary not supporting the
AFP Unicode Migration Fonts.

Before doing these configuration tasks on AIX and Windows systems, you must
first obtain and install the AFP Unicode Migration Fonts that are required for
printing:

AIX, Windows NT/2000, AS/400®, AFP Unicode Font PRPQ (5799-GJJ)

For more information about purchasing this product, see your InfoPrint Solutions
representative.

Note: SAP Systems recommends using SAP Unicode systems that output
SAPGOFU format, not the SAPGOF format. Excerpt from the official SAPGOF
specification: ’’With the development of the Unicode variant of SAPGOF (device type
SAPGOFU), the ASCII and EBCDIC variants are considered obsolete and are provided
only for the sake of compatibility. Developers of new SAPGOF converters should base their
implementation on the Unicode variant of SAPGOF.’’ Consequently, we recommend
using SAPGOFU input files in Unicode environment when invoking the SAP2AFP
transform.

Enabling Unicode support on both an InfoPrint Manager AIX
and Windows server

For the OTF input files, the detection of the environment (Unicode and
non-Unicode) and the detection of the double-byte languages in non-Unicode
environments is automatic. For the ABAP files, if the input file is a
Unicode-encoded (SAPGOFU) file, the environment automatically goes to
Unicode.
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The input file encoding is automatically detected and you do not have to edit the
contents of a syscp file to set the input encoding when both SAPGOF and
SAPGOFU files are submitted in a Unicode environment.

Table 9. Environment automatic detection

Type of the input
file

Encoding of the
input file

Environment
detection method

Additional
comments

OTF UTF-16 (BE or LE) Automatic Environment is set to
Unicode.

ASCII Automatic Environment is set
based on the code
pages used (code
page commands)

ABAP UTF-16 (BE or LE) Automatic Environment is set to
Unicode.

ASCII ’userenv’ config file
is used

The default value is
NORMAL, which
means non-Unicode.

Resources for supporting Unicode ABAP files
Specific coded fonts are available to reference the AFP migration fonts. These
coded fonts are used for the Unicode processing of the ABAP files. To map these
coded fonts for Unicode, page definitions were also created. The page definitions
are divided into 5 pairs, which map the Courier fonts, the Japanese fonts, the
Simplified Chinese fonts, the Traditional Chinese fonts, and the Korean fonts.

The resources are not part of the AFP Font Migration collection. All these
resources and their source code are available in the unicode.rc subfolder from the
sap2afp folder, where the configuration files also reside. When the Unicode
processing is required, the transform automatically searches for the resources in
that specific folder. Otherwise it continues to search in the InfoPrint Manager
fontlib and reslib folders.

The table lists the new coded fonts, page definitions and Page Printer Formatting
Aid (PPFA) source files used:

Table 10. Coded fonts, pages definitions and PPFA source files for Unicode ABAP files

File name Type

Location (subfolder
in InfoPrint

Manager) Details

XZ420U10 coded font sap2afp/unicode.rc/ Courier Normal

XZ440U10 coded font sap2afp/unicode.rc/ Courier Bold

XZJHMNU coded font sap2afp/unicode.rc/ Japanese Mincho (used for
normal text)

XZJHKGU coded font sap2afp/unicode.rc/ Japanese Gothic (used for
bold text)

XZHSM2U coded font sap2afp/unicode.rc/ Korean Myengjo (used for
normal text)

XZHKG2U coded font sap2afp/unicode.rc/ Korean Gothic (used for
bold text)

XZSSNGU coded font sap2afp/unicode.rc/ Simplified Chinese Song
(used for normal text)
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Table 10. Coded fonts, pages definitions and PPFA source files for Unicode ABAP
files (continued)

File name Type

Location (subfolder
in InfoPrint

Manager) Details

XZSKAIU coded font sap2afp/unicode.rc/ Simplified Chinese Kai
(used for bold text)

XZTSNGU coded font sap2afp/unicode.rc/ Traditional Chinese Sung
(used for normal text)

XZTKAIU coded font sap2afp/unicode.rc/ Traditional Chinese Kai
(used for bold text)

P1UNI683 page definition sap2afp/unicode.rc/ maps the Courier coded
fonts

P1UNI182 page definition sap2afp/unicode.rc/ maps the Courier coded
fonts

P1UNIJ83 page definition sap2afp/unicode.rc/ maps the Japanese coded
fonts

P1UNIJ82 page definition sap2afp/unicode.rc/ maps the Japanese coded
fonts

P1UNIK83 page definition sap2afp/unicode.rc/ maps the Korean coded
fonts

P1UNIK82 page definition sap2afp/unicode.rc/ maps the Korean coded
fonts

P1UNISC3 page definition sap2afp/unicode.rc/ maps the Simplified
Chinese coded fonts

P1UNISC2 page definition sap2afp/unicode.rc/ maps the Simplified
Chinese coded fonts

P1UNITC3 page definition sap2afp/unicode.rc/ maps the Traditional
Chinese coded fonts

P1UNITC2 page definition sap2afp/unicode.rc/ maps the Traditional
Chinese coded fonts

P1UNI683.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNI683

P1UNI182.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNI182

P1UNIJ83.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNIJ83

P1UNIJ82.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNIJ82

P1UNIK83.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNIK83

P1UNIK82.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNIK82

P1UNISC3.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNISC3

P1UNISC2.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNISC2

P1UNITC3.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNITC3

P1UNITC2.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNITC2

Setting up your SAP R/3 system to support new OTF user fonts

Use this procedure when using the sap2afp transform to print with a new font that
you have created for the job:
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1. From the R/3 main menu, access the Font window so you can create a font
family for this new, customized font, by selecting the Tools main menu and
then selecting the Word Processing → Font path. or typing /nSP73 in the
ok-Code field.

2. From the SAPscript Font Maintenance: Initial Screen window, select the Font
families option and click Change.

3. Click Create and fill in the font information on the Create/Change Font
Family window as shown in Figure 12:

4. Click Continue.
5. When the system prompts you for a Change Request Query request, click

Cancel.
6. From the SAPscript Font Maintenance: Initial Screen window, select the

System Fonts option and click Create.
7. Fill in the information from the Create System... window as shown in

Figure 13 on page 109:

Figure 12. SAPScript Font Maintenance: Create/Change Font Family window
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8. Click Continue.
9. When the system prompts you for a Change Request Query request, click

Cancel.
10. From the SAPscript Font Maintenance: Initial Screen window, select the

Printer fonts/AFM metrics option and click Change.
11. From the Create/Change... window shown in Figure 14 on page 110, select the

intended device type (ZDOCOGF) and fill in the remaining information:

Figure 13. SAPScript Font Maintenance Create System... window
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12. Click Continue.
Before you can use this new Output Text Format (OTF) font, you must define
a layout set that contains this new font to use your device type.

13. Add an entry in the fonts.tab configuration file that identifies this new OTF
font and make sure that these resources are on the InfoPrint server where
your InfoPrint actual destination is located.

Printing oversize characters on a 6400 printer with SAP R/3

InfoPrint Manager gives you the ability to resize Output Text Format (OTF) fonts
on a 6400 Printer. If your printer supports the graphics object content architecture
(GOCA) feature, you can use the 6400fonts.tab configuration file to alter the height
and width of characters printed. The SIZE= parameter lets you specify the height
of a font (in points) and have it scaled appropriately. Since there are 72 points in
an inch, 720 indicates a height of an inch. The CPI= (characters per inch) parameter
defines the horizontal width to which the 6400 printer-resident fonts should be
scaled. The smaller the number you specify, the wider the font you receive.

To make sure that a font prints one inch high, specify this line in the 6400fonts.tab
configuration file:
FONT=TIMES SIZE=720 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0

The 6400fonts.tab configuration file is located in the /usr/lpp/psf/sap2afp
directory on an InfoPrint Manager AIX server and the install_path\sap2afp folder
on an InfoPrint Manager Windows server.

Figure 14. SAPScript Font Maintenance (Create/Change) window for OTF Fonts
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To make sure that a font prints one inch wide, specify this line in the 6400fonts.tab
configuration file:
FONT=TIMES SIZE=360 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0 CPI=1

To make sure that a font prints one-half inch wide, specify this line in the
6400fonts.tab configuration file:
FONT=TIMES SIZE=360 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0 CPI=2

Once you have modified the 6400fonts.tab file appropriately, access the Print
Screen List window on the SAP R/2 graphical user interface and specify 6400 in
the Title field of the Spool request pane.

Adding box shading values to printed output
InfoPrint Manager supports both Output Text Format (OTF) shading values and
border thickness values. The BX OTF command lets you print boxes that are either
clear, solid, or contain four different levels of shading. The levels of shading are a
percentage between 0 and 100, with 0 indicating a clear box and 100 a solid box.

The InfoPrint Manager SAP transform recognizes the BX OTF command and
creates graphics object content architecture (GOCA) output if passed the -g flag.
GOCA is an AFP data architecture used to represent pictures generated by
computer. Both the ipm_submit and ipm_print commands used by the OMS (see
Part 2, “Installing and configuring InfoPrint Manager’s OMS,” on page 9) and
access method L (see Part 3, “InfoPrint Manager non-OMS support,” on page 51)
automatically pass the -g flag to the SAP transform through the
other-transform-options attribute. For more information about the
other-transform-options attribute and the sap2afp command, see the InfoPrint
Manager: Reference manual. For more information about the BX command values
required to specify box shading, see your SAP R/3 documentation.

If you use this function with an IPDS InfoPrint printer that is not enabled for
GOCA, the file prints a presentation text object content architecture (PTOCA) box
or boxes without shading and this message sequence for each box at the end of the
job:
0420-535: ERROR: One or more graphics objects were encountered.
The printer does not support this type of object.
:
:
0420-879: InfoPrint continues processing the print job: The STOP
when errors found in IMAGE and GRAPHICS data field on the
InfoPrint SMIT Error Handling Options panel is set to no.

If your installation uses older printers (for example, 3900 printers instead of
InfoPrint 4000 printers), the GOCA support can cause the printers to print at less
than rated speed. If your applications do not require GOCA support features such
as box shading, you might want to improve performance by turning off the GOCA
support. For instructions on how to turn off GOCA support on the various
platforms supported, see the following sections.

Turning off GOCA support on a Windows SAP system

If you have already installed the InfoPrint Manager SAP Client on a Windows
system and want to turn off GOCA support, access the ipmcfg file from the
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directory where you installed the SAP Client. When you click this file, it displays
the IPM Server Settings dialog. From here, you can click IPM GOCA Support to
remove the check.

Note: If you ever wish to reactivate GOCA support, just access the ipmcfg and
click the check box again.

Turning off GOCA support on an AIX SAP system

To turn off GOCA support from an AIX system running the SAP Client, use this
procedure:
1. Access either the ipm_submit (for OMS configurations) or the ipm_print file

(for non-OMS configurations) file that reside in the /usr/lpp/pd/bin directory.
2. Using your AIX editor of choice, comment out the othertoptions="other-

transform-options='-g'"; line by placing a hash mark (#) in front of the line.

Note: If you ever wish to reactivate GOCA support, just access these files again
and remove the hash mark (#) in front of the line.

Turning off GOCA support on an HP-UX or Sun Solaris SAP
system

To turn off GOCA support from either an HP-UX system or a Sun Solaris system
running the SAP Client, you must turn the support off at the InfoPrint Manager
server to which the client machine is connected. If you are connected to an
InfoPrint Manager AIX server, go to the AIX server and use this procedure:
1. Access either the ipm_submit (for OMS configurations) or the ipm_print file

(for non-OMS configurations) file that reside in the /usr/lpp/pd/bin directory.
2. Using your AIX editor of choice, comment out the othertoptions="other-

transform-options='-g'"; line by placing a hash mark (#) in front of the line.

Note: If you ever wish to reactivate GOCA support, just access these files again
and remove the hash mark (#) in front of the line.

If you are connected to an InfoPrint Manager Windows server, access the ipmcfg
file from the directory where you installed InfoPrint Manager. When you click this
file, it displays the IPM Server Settings dialog. From here, you can click IPM
GOCA Support to remove the check.

Note: If you ever wish to reactivate GOCA support, just access the ipmcfg and
click the check box again.
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Chapter 16. Using bar codes with SAP R/3

These sections describe the bar codes for printing that can be used when printing
OTF and ABAP output from InfoPrint Manager:
v “Bar codes supported by the InfoPrint SAP (sap2afp) transform”
v “Setting up your SAP R/3 system to support new OTF user bar codes” on page

114
v “Bar codes and printing from SAP R/3 through InfoPrint Manager” on page 115
v “Specifying width in SAP bar codes” on page 117.

Bar codes supported by the InfoPrint SAP (sap2afp) transform

Some SAP R/3 applications require that data is printed as a bar code. If OTF
specifies bar code data, the sap2afp transform converts it into Bar Code Object
Content Architecture™ (BCOCA™) data, which is understood directly by the control
unit of the AFP printer. This bar code data can also be converted to the Printer
Control Language (PCL) PCL4, PCL5, or PCL5c data streams. This allows InfoPrint
Manager to print to any printers that accept Printer Control Language data.

These printers support both InfoPrint Manager and BCOCA:
v 3130 Advanced Function Printer
v 3160 Advanced Function Printer
v 3900 Advanced Function Duplex Printing System, Models D01, D02
v 3900 Advanced Function Wide Duplex Printing System, Models DW1, DW2
v 3900-OW1 Advanced Function Printer
v 3900-OW3 Advanced Function Printer
v 3935 Advanced Function Printer
v 4312 Network Printer 12 (NP 12)
v 4317 Network Printer 17 (NP 17)
v 4324 Network Printer 24 (NP 24)
v 4400 Thermal Printer
v InfoPrint 20 Printer
v InfoPrint 21 Printer
v InfoPrint 32 Printer
v InfoPrint 40 Printer
v InfoPrint 45 Printer
v InfoPrint 60 Printer
v InfoPrint 62 Printer
v InfoPrint 70 Printer1

v InfoPrint 70 Plus Printer1

v InfoPrint 1120 Printer
v InfoPrint 1125 Printer
v InfoPrint 1130 Printer
v InfoPrint 1140 Printer
v InfoPrint 1145 Printer
v InfoPrint 1226 Printer
v InfoPrint 1332 Printer
v InfoPrint 1352 Printer
v InfoPrint 1372 Printer
v InfoPrint 2000-DP1 IPDS Printer
v InfoPrint 2060ES Printer
v InfoPrint 2075ES Printer
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v InfoPrint 2085 Printer
v InfoPrint 2090ES Printer
v InfoPrint 2105 Printer
v InfoPrint 2105ES Printer
v InfoPrint 3000 Printer
v InfoPrint 4000 Printer1

v InfoPrint 4100 Printer
v InfoPrint Color 100 Printer1

v InfoPrint Color 130 Plus Printer1

v InfoPrint Color 1220 Printer
v InfoPrint Color 1228 Printer
v InfoPrint Color 1354 Printer
v InfoPrint Color 1357 Printer
v LaserPrinter 4028 Models AS1 and NS1

Setting up your SAP R/3 system to support new OTF user bar codes

Use this procedure when using the sap2afp transform to print with a new bar code
that you have created for the job:
1. From the R/3 main menu, access the Font window by either taking the Word

Processing → Font path, or typing /nSP73 in the ok-Code field.
2. From the SAPscript Font Maintenance: Initial Screen window, select the System

bar codes option and click Change.
3. Click Create and fill in the bar code information on the Create/Change System

Bar Code window as shown in Figure 15:

4. Click Continue.

1. InfopPrint Manager for AIX only

Figure 15. SAPScript Font Maintenance (Create/Change) System Bar Code window
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5. When the system prompts you for a Change Request Query request, click
Cancel.

6. From the SAPscript Font Maintenance: Initial Screen window, select the Printer
bar codes option and click Change.

7. From the Create/Change... window displayed below, select the intended bar
code (ZDOCGOF) and fill in the remaining information as shown in Figure 16:

8. Click Continue.
Before you can use this new Output Text Format (OTF) bar code, you must
define a layout set that contains this new bar code to use your device type (in
this case, ZDOCGOF).

9. Add an entry in the barcode.tab configuration file that identifies this new OTF
bar code name to an actual bar code type. The barcode.tab configuration file
identifies values in this format:
BarCode=ZDOBAR Type=017 Mode=002 Flag=128

For more information about the barcode.tab configuration file and how it relates to
the Bar Code Object Content Architecture (BCOCA), see “Bar codes and printing
from SAP R/3 through InfoPrint Manager.”

Bar codes and printing from SAP R/3 through InfoPrint Manager

Table 11, Table 12 on page 116, and Table 13 on page 117 map the Bar Code Object
Content Architecture values with the SAP R/3 system values found in the
barcode.tab configuration file, which is located in the /usr/lpp/psf/sap2afp
directory on an InfoPrint AIX system and the install_path\sap2afp folder on an
InfoPrint Windows system.

Table 11. Bar code Type field values

Bar code Type field values Description

X’01’ Code 3 of 9

X’02’ MSI

Figure 16. SAPScript Font Maintenance (Create/Change) window
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Table 11. Bar code Type field values (continued)

Bar code Type field values Description

X’08’ EAN-8

X’09’ EAN-13

X’0C’ Interleaved 2 of 5

X’11’ Code 128

X’18’ POSTNET

X’1E’ PDF 417

Table 12. Bar code Mode field values

Mode Field
values

Bar code Type Meaning

1 X’01’ Present the bar code without a generated check
digit.

2 X’01’ Generate a check digit and present it with the bar
code.

1 X’02’ Present the bar code without check digits
generated by the printer.

2 X’02’ Present the bar code with generated modulo-10
check digit. This check digit is the second check
digit; the first check digit is the last byte of the
BSA data.

3 X’02’ Present the barcode with two check digits. Both
check digits are generated using the modulo-10
algorithm.

5 X’02’ Present the barcode with two check digits. The first
check digit is generated using the modulo-11
algorithm; the second using the modulo-10
algorithm. The first check digit equals the
remainder; exception condition EC-0E00 exists if
the first check-digit calculation results in a value of
10.

0 X’08’ Present an EAN-8 barcode symbol. The input data
consists of seven digits: two flag digits and five
article digits. All seven digits are encoded along
with a generated check digit.

0 X’09’ Present an EAN-13 barcode symbol. The input data
consists of twelve digits: two flag digits and ten
article digits, in that order. The first flag digit is not
encoded. The second flag digit, the article number
digits, and generated check digits are encoded. The
first flag digit is presented in HRI form at the
bottom of the left quiet zone. The first flag digit
governs the A and B number-set pattern of the
barcode and space coding of the six digits to the
left of the symbol center pattern.

1 Present the bar code without a generated check
digit. In sequence, the input data consists of a start
character, digits to be encoded, and a stop
character.

116 InfoPrint Manager: SAP R/3 Planning and Configuration Guide



Table 12. Bar code Mode field values (continued)

Mode Field
values

Bar code Type Meaning

2 X’0C’ Generate a check digit and present it with the bar
code. In sequence, the input data consists of a start
character, digits to be encoded, and a stop
character.

2 X’11’ Generate a Code 128 symbol using subset A, B, or
C as appropriate, to produce the shortest possible
bar code from the given data. The Code 128 code
page is used to interpret the bar code symbol data.
Generate a check digit and present it with the data.

0 X’18’ Present the ZIP code as 5 digits.

1 X’18’ Present the ZIP code as 9 digits.

0 X’1E’ Present a full PDF417 bar code symbol.

1 X’1E’ Present a truncated PDF417 bar code symbol, for
use in a relatively clean environment in which
damage to the symbol is unlikely. This version
omits the right row indicator and simplifies the
stop pattern into a single module width bar.

The barcode.tab configuration file can contain the FlagPDF keyword that represents
byte 5 of the BSA (Bar Code Symbol Data) from PDF417 Special-Function
Parameters. This flag is only used with PDF417 bar code types, and it controls how
the bar code data is processed by the BCOCA receiver. For more information, see
the Bar Code Object Content Architecture Reference manual.

Table 13. Bar Code Flag Values

Flag field values Meaning

128 Present without Human Readable Text (HRI)

0 Present with Human Readable Text

Specifying width in SAP bar codes

InfoPrint Manager lets you modify bar code width using the same command
syntax provided with the Page Printer Formatting Aid (PPFA) product. By
modifying the barcode.tab configuration file to use the ModWidth parameter, you
can change the width of bar codes and the wide-to-narrow ratio.

ModWidth
Specifies the width of the smallest defined bar code element, using mils
(thousandths of an inch). For bar code types that explicitly specify the
module width (for example, POSTNET and RM4SCC), this field is ignored.
The range of values allowed is 1 to 254. If ModWidth is not specified in
the barcode.tab file, the sap2afp transform uses the defaulted bar code
width.

n Specifies the width of each module, using thousandths of an inch (1/1000)
as the unit of measure.

Ratio Specifies a percent value in the form nnn. For example, 200 represents a
ration of 2.5 to 1. For most bar code symbols, the Ratio value should be
between 200 and 300. For bar code types that explicitly specify the module

Chapter 16. Using bar codes with SAP R/3 117



width (for example, POSTNET and RM4SCC), this field is ignored. If Ratio
is not specified, the default ratio for the bar code symbol is used. This
value must be a three-digit character between 100 and 500.

To shorten an existing bar code, you can specify this line in the barcode.tab file:
BarCode = BC_CD39 Type = 001 Mode = 001 Ratio = 2000 ModWidth = 10
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Part 5. Appendixes
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Appendix A. SAPconnect fax-out configuration worksheet

While configuring the SAP system for fax-out, use this worksheet to record the
values that will be needed to configure and start the InfoPrint Manager
SAPconnect daemon.

Table 14. SAPconnect configuration worksheet values

Parameter Value Used in
/etc/rc.iprsap

Used in
/var/pd/saprfc.ini

IPMLogicalDestinationName x

Logon User x

Logon Password x

Logon Client x

RFC Destination x x

Program ID x

Gateway Host x

Gateway Server x

SAP System Name x x

SAP System Number (for specific
application server)

SAP Application Server Host (for specific
application server)

SAP Message Server (for load balancing)

SAP Application Server Group (for load balancing)

© Copyright InfoPrint Solutions Company 2000, 2009 121



122 InfoPrint Manager: SAP R/3 Planning and Configuration Guide



Appendix B. Alternate access methods for submitting SAP
jobs to InfoPrint Manager

To use InfoPrint Manager as an SAP OMS you define your SAP devices to use
access method E (see Part 2, “Installing and configuring InfoPrint Manager’s
OMS,” on page 9). If you cannot use InfoPrint Manager as an SAP OMS, we
recommend defining your SAP devices to use access method L (see Part 3,
“InfoPrint Manager non-OMS support,” on page 51). There are other access
methods that can be used for submitting print jobs from SAP systems to InfoPrint
Manager. This topic describes some of those methods. These methods do not
require an InfoPrint SAP Client to be installed on your SAP system, but do not
allow SAP job attributes to be passed with the job or provide for any status
information regarding the job to be known on the SAP system. You can install and
use the SAP transform with these methods.

Defining SAP devices using access method U

From your SAP system, you can submit jobs to either an InfoPrint AIX or InfoPrint
Manager Windows server using LPD by defining your SAP device to use access
method U.

This method is intended for InfoPrint Manager users whose SAP R/3 applications
run on non-AIX systems. This method is discouraged with SAP systems running
on AIX because you must create AIX print queues to use it. For a preferred method
of submitting jobs from SAP systems to InfoPrint Manager that provides better
feedback, see either Part 2, “Installing and configuring InfoPrint Manager’s OMS,”
on page 9 or Part 3, “InfoPrint Manager non-OMS support,” on page 51.

To use access method U to send jobs to InfoPrint Manager, you need to make sure
that the LPD service is running on the InfoPrint server. Use the procedure
appropriate to your InfoPrint Manager server operating system:
v “Verifying the InfoPrint for Windows LPD service is started”
v “Verifying the LPD service is started on InfoPrint AIX” on page 124

Verifying the InfoPrint for Windows LPD service is started

To submit jobs to InfoPrint Manager through the LPD service, the InfoPrint
Manager LPD service that comes with InfoPrint Manager for Windows must be
active. Note that this service is different from the LPD Windows service that comes
with the base operating system. Use this procedure to verify that the service is
started on your InfoPrint Manager Windows server, and if necessary, to activate
the InfoPrint Manager LPD service:
1. From the Start menu, select Programs → InfoPrint Manager → Management

Console.
2. Click File→ Stop Server.
3. Access the Edit → Service Configuration... path.
4. From the Service Configuration window, make sure that the Run InfoPrint

Manager LPD service check box has been checked. Press OK to save this
change.

5. Click File →Start Server.
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6. Exit the InfoPrint Manager Management Console.

Verifying the LPD service is started on InfoPrint AIX

To submit jobs to InfoPrint Manager through LPD, you must make sure that the
AIX lpd daemon is active on your InfoPrint Manager AIX server.

To either verify that the lpd daemon is active or to start it on your InfoPrint
Manager AIX server:
1. From an AIX command line, use either smit or smitty to access the System

Management Interface Tool.
2. From the main menu, take the Print Spooling → Manage Print Server path.
3. From the Manage Print Server panel, scroll down and click Show Status of the

Print Server Subsystem.
If the lpd subsystem displays an inoperative status, return to the Manage Print
Server panel and click Start the Print Server Subsystem (lpd daemon).
If the lpd subsystem displays an active status and shows a PID value, you can
exit the SMIT interface and do not have to take any action.

4. From the Start the Print Server Subsystem panel, take the default values and
press Enter.
The system responds with a message similar to this:
0513-059 The lpd Subsystem has been started. Subsystem PID is 25550.

which indicates that the lpd daemon is now active.
5. Exit the SMIT interface.

Defining devices that use InfoPrint Manager for access
method U

To define SAP devices to use access method U, follow this procedure:
1. Make sure that you have a logical printer defined in InfoPrint Manager, which

will send jobs to your physical printer device.
2. From the R/3 main menu, access the Spool Administration window by clicking

the Tools main menu and then selecting the Tools → Administration → Spool →
Spool Administration path or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and
select the Change button.

4. Click Create and fill in this information on the Create Output Device window:

Field Explanation Example value

Output device Type the name that R/3
users need to access the
printer.

ipm1pms

Device type Select the device type that
has been defined in the R/3
system for the printer model.
For example, POST2 applies
to any PostScript printer.

POST2
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Field Explanation Example value

Spool server Select the name of the R/3
application server, which will
be the SAP R/3 spool server
(spool work process), that
transfers output across a
network link.

hrmssbx_SBX_00

Destination hosts Type the host name for the
InfoPrint server.

nwser

Host printer Type the name of the
InfoPrint Manager logical
destination.

prt1-lp

Device class Enter a space so that this
field accepts the default
value of printer, which is P,
or you can specify Standard
printer.

Access method in host spool Select the method that the
spool work process uses to
pass data to the host spool
system.

U

5. From the menu bar, click Back and the system prompts you to save the new
output device.

Once you have completed this task, you can begin submitting jobs to InfoPrint
Manager.

Submitting jobs from Windows SAP systems to InfoPrint Manager
Windows with access method C

If your SAP system runs on a Windows system, you can submit jobs to a printer
running on an InfoPrint Manager Windows server through Access Method C. To
configure your Windows SAP system to print through an InfoPrint Manager
Windows server, you must create a Windows gateway printer on that InfoPrint
Manager Windows server, and then define devices on your SAP system to use
access method C.

A Windows gateway printer is the combination of a printer driver and a port. You
can create a Windows printer using the Windows Add Printer wizard. You can see
these printers from the Windows Printers window, but you should never open and
modify them from there.

To define SAP devices to use access method C, follow this procedure:
1. Make sure that you have a logical printer defined in InfoPrint Manager that

sends jobs to your actual destination device.
2. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting the Tools → Administration →
Spool → Spool Administration path or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and
click Change.

4. Click Create and fill in this information about the Create Output Device
window:
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Field Explanation Example value

Output device
Type the name that R/3
users will need to access the
printer.

prt2

Device type
Select the device type that
has been defined in the R/3
system for the printer model.
HPLJ4 applies to a
Hewlett-Packard LaserJet 4
printer.

HPLJ4

Spool server
Select the name of the R/3
application server, which will
be the SAP R/3 spool server
(spool work process), that
transfers output across a
network link.

rt1_RT1_00

Host printer
Type the hostname of the
InfoPrint Manager Windows
server (ANAKE), followed by
the Windows shared printer
name (EDPTEST).

\\ANAKE\EDPTEST

Device class
Enter a space so that this
field accepts the default
value of printer, which is P.

Access method in host spool
Select the method that the
spool work process uses to
pass data to the host spool
system.

C

5. From the menu bar, click Back and the system prompts you to save the new
output device.

126 InfoPrint Manager: SAP R/3 Planning and Configuration Guide



Notices

This information was developed for products and services offered in the U.S.A.

InfoPrint Solutions Company may not offer the products, services, or features
discussed in this document in other countries. Consult your local InfoPrint
Solutions Company representative for information on the products and services
currently available in your area. Any reference to an InfoPrint Solutions Company
product, program, or service is not intended to state or imply that only that
InfoPrint Solutions Company product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any
InfoPrint Solutions Company intellectual property rights may be used instead.
However, it is the user’s responsibility to evaluate and verify the operation of any
non-InfoPrint Solutions Company product, program, or service.

References in this document to InfoPrint Solutions Company products, product
features, programs or services do not imply that InfoPrint Solutions Company
intends to make such products, product features, programs or services available in
all countries in which InfoPrint Solutions Company operates or does business.

InfoPrint Solutions Company may have patents or pending patent applications
covering subject matter described in this document. The furnishing of this
document does not give you any license to these patents. You can send license
inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
InfoPrint Solutions Company Intellectual Property Department in your country or
send inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INFOPRINT
SOLUTIONS COMPANY PROVIDES THIS PUBLICATION ″AS IS″ WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states
do not allow disclaimer of express or implied warranties in certain transactions,
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. InfoPrint Solutions Company may
make improvements and/or changes in the product(s) described in this publication
at any time without notice.
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Any references in this information to non-InfoPrint Solutions Company Web sites
are provided for convenience only and do not in any manner serve as an
endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this InfoPrint Solutions Company product and use of those Web
sites is at your own risk.

InfoPrint Solutions Company may use or distribute any of the information you
supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by InfoPrint Solutions Company under terms of the
InfoPrint Solutions Company Customer Agreement, InfoPrint Solutions Company
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-InfoPrint Solutions Company products was obtained
from the suppliers of those products, their published announcements or other
publicly available sources. InfoPrint Solutions Company has not tested those
products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-InfoPrint Solutions Company products. Questions on
the capabilities of non-InfoPrint Solutions Company products should be addressed
to the suppliers of those products.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
These terms are trademarks or registered trademarks of Ricoh Co., Ltd., in the
United States, other countries, or both:
v Advanced Function Presentation
v Advanced Function Printing
v AFCCU
v AFP
v Bar Code Object Content Architecture
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v BCOCA
v InfoPrint
v Infoprint
v Intelligent Printer Data Stream
v IPDS
v Mixed Object Document Content Architecture
v MO:DCA
v Ricoh

These terms are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both:
v AIX
v AS/400
v BookMaster
v IBM
v OS/2
v RS/6000

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States
and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.
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Glossary

This glossary defines technical terms and abbreviations used in InfoPrint Manager.

Special Characters

.Guidefaults file
A file created by InfoPrint in the home
directory of a person using the InfoPrint
GUI. InfoPrint uses this file to save and
reference information about the servers
you are monitoring and the windows you
are working in.

A

Access Control List (ACL)
In computer security, a collection of all
access rights for one object.

ACL Access Control List.

acl editor
A command line interface that lets you
view, add, update, and delete access
authorization records in an ACL.

action In the InfoPrint GUI, an icon that
represents an operation that you can
perform on an InfoPrint object. You drag
and drop the action onto an object to
initiate the operation for that object. For
example, using the Enable action to
enable a disabled actual destination.

actual destination
In InfoPrint, an object that represents the
output device that performs the printing
or transmission function. See email
destination, fax destination; see also physical
printer, printer device; contrast with logical
destination.

additive color system
A system that reproduces an image by
mixing (adding) appropriate quantities of
red, green, and blue light (the additive
primary colors) to create all other colors
of light, either direct or transmitted.
When the additive primaries are
superimposed on one another, they create
white light. Contrast with subtractive color
system.

administrator
In InfoPrint, the person who creates and
manages one or more components of a

printing system, such as servers and
actual destinations. By default, InfoPrint
gives administrators authorization to
perform some InfoPrint operations and to
access certain information that is not
available to the operators or job
submitters.

Adobe® Acrobat
An Adobe software program that
provides instant access to documents in
their original format, independent of
computer platform. With the Adobe
Reader, you can view, navigate, print, and
present any Portable Document Format
(.pdf) file.

Adobe PageMaker
A desktop publishing program that
produces PostScript documents.

Adobe PostScript Raster to Image Transform
(RIP) See raster image processor (RIP).

ADSM/6000
Advanced Distributed Storage Manager.

Advanced Distributed Storage Manager
(ADSM/6000)

A program that provides storage
management for archived files.

Advanced Function Common Control Unit
(AFCCU™)

An IBM RISC-based control unit with
code common to all printers that use the
AFCCU.

Advanced Function Presentation (AFP)
A set of licensed programs, together with
user applications, that use the
all-points-addressable concept to print
data on a wide variety of printers or to
display data on a wide variety of display
devices. AFP includes creating,
formatting, archiving, retrieving, viewing,
distributing, and printing information.

Advanced Function Presentation data stream
(AFP data stream)

The printer data stream used for printing
AFP data. The AFP data stream includes
composed text, page segments, electronic
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overlays, form definitions, and fonts
downloaded from the operating system to
the printer.

A presentation data stream that is
processed in AFP environments. The AFP
data stream includes MO:DCA-P-based
data streams.

Advanced Interactive Executive (AIX)
An operating system used with RS/6000
computers. The AIX operating system is
IBM’s implementation of the UNIX
operating system.

AFCCU
Advanced Function Common Control
Unit.

AFP Advanced Function Presentation.

AFP data stream
Advanced Function Presentation data
stream.

ainbe The printer input/output backend
program used by the PSF DSS to send
jobs to printer devices. Depending on the
incoming data stream of the job, the PSF
DSS might have transformed the data
stream of the job before the backend
program sending it to the printer device.

AIX Advanced Interactive Executive.

AIX-attached printer
A printer device, attached to an RS/6000
computer through the network or through
a serial or parallel port that receives jobs
from an AIX print queue.

In InfoPrint, a PSF physical printer that
represents an AIX-attached printer device.
See also direct-attached printer,
TCP/IP-attached printer,
upload-TCP/IP-attached printer.

AIX destination support system
In InfoPrint, the destination support
system that communicates with the
standard AIX print backend (piobe), or
with certain variations of the rembak
print backend, to print jobs.

AIX physical printer
In InfoPrint, the object representing a
printer device that uses the AIX
destination support system.

aliasing
In a digitized image, the creation of
diagonal lines by combining short

horizontal and vertical line segments that
approximate the path of the desired line.

all-points-addressability (APA)
The capability to address, reference, and
position text, overlays, and images at any
defined point of the printable area of the
paper or display medium.

alphameric
Synonym for alphanumeric.

alphanumeric
Pertaining to a character set containing
letters, digits, and other symbols such as
punctuation marks. Synonymous with
alphameric.

AMPV
Average monthly print volume.

analog
Pertaining to a continuous variable
sampling of information between two
points that achieves an even, smooth
transition of photographic material.

analog color proof
An off-press color proof made from
separation films.

anti-aliasing
The rendering of hard-edged objects so
that they blend smoothly into the
background. PhotoShop offers
anti-aliasing when rasterizing an EPS file.

Removing the jagged “stairstep” quality
in diagonal lines produced on a computer
screen by aliasing. This removal is
effected by creating less densely shaded
fields parallel to the diagonal line.

APA All-points-addressability.

API Application Program Interface.

Application Program Interface (API)
The call interface between a client
program and the procedures that
implement the printing system, as defined
by the specification. Clients use the API to
access servers. (P)

architecture
The set of rules and conventions that
govern the creation and control of data
types such as text, image, graphics, font,
fax, color, audio, bar code, and
multimedia.
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archiving
The transfer of digital information from
an online system onto floppy disk,
compact disc, or other media for offline
storage. The original copy is deleted from
the online system. See also retrieval.

array inkjet
An ordered collection of multiple print
heads used in an inkjet printer.

ASCII American National Standard Code for
Information Exchange. The standard code,
using a coded character set consisting of
7–bit coded characters (8 bits including a
parity check). The ASCII code is used for
information exchange among data
processing systems, data communications
systems, and associated equipment. The
ASCII character set includes control
charactes and graphic characters.

asynchronous
Pertaining to two or more processes that
do not depend upon the occurrence of
specific events, such as common timing
signals. (T)

In InfoPrint, occurring without a regular
or predictable time relationship to a
specified action. Contrast with
synchronous.

attachment type
Defines the method by which a printer
device is attached to the AIX system from
which it receives data. See AIX-attached
printer, direct-attached printer,
TCP/IP-attached printer, and
upload-TCP/IP-attached printer.

attribute
A defined characteristic of an object, such
as the number of copies required of a job,
or the document formats accepted by an
actual destination.

attribute name
A string that identifies an attribute.
Typically, in InfoPrint attribute names
consist of two or more words separated
by hyphens.

attribute value
The element of an attribute that specifies
the characteristics relating to the attribute.

authorization
In computer security, verification of the
eligibility of a user to access an object.

authorized user
A person with the appropriate
permissions to access an object or to issue
a command.

automatic recovery
A function of printer logic that permits
the printer to reprint a job if the job is
misprinted or damaged or if a component
has failed.

auxiliary sheet
In InfoPrint, an object that represents a
particular sheet of paper, blank or
otherwise, that can precede a job, separate
documents in a job, or follow a job.

auxiliary-sheet selections
A particular combination of start,
separator, and end sheets that print with
jobs on a particular printer device.

B

backend
In AIX, the program that is invoked by
the qdaemon process to run a print or
batch job. Synonymous with backend
program.

backend program
Synonym for backend.

backlog
In InfoPrint, the amount of time
calculated by InfoPrint that is required to
print all of the jobs currently in a queue.

backspace
In InfoPrint, the action used to back up
and reprint pages in a job.

bar code
A code representing characters by sets of
parallel bars of varying thickness and
separation that are read optically by
transverse scanning.

An array of parallel rectangular bars and
spaces that together represent data
elements or characters in a particular
symbology. The bars and spaces are
arranged in a predetermined pattern
following unambiguous rules defined by
the symbology.

BCOCA
Bar Code Object Content Architecture.

Bezier curves
A method of defining curves using anchor
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points, control handles, and tangent lines.
The PostScript path passes through
anchor points. Its approach direction is
along the tangent lines that are controlled
by the control handles. Many personal
computer programs use this drawing
method. Type 1 PostScript fonts are
defined using Bezier curves.

binding
The cover and materials that hold a book
together. See edition binding, perfect
binding, spiral binding, wire-o binding.

The process of applying the binding to a
book.

In InfoPrint, assigning a job to an actual
destination. See early binding, late binding.

bitmapped
Pertaining to an image formed by a
rectangular grid of pixels. Each pixel is
assigned a value to denote its color.
One-bit images are black and white; 8–bit
images have 256 colors (or grays); 24–bit
images have full color. CMYK images
have 32–bits per pixel to encode 256
levels in each of four channels. Bitmapped
images are also called raster images.

bleed An extra amount of printed image that
extends beyond the trim edge of the
sheet. Bleed ensures that no white gap
appears at the edge of the sheet.

boot To prepare a computer for operating by
loading an operating system.

BSD Berkeley Software Distribution.

BSD destination support system
In InfoPrint, the destination support
system that generates a print command
string that the shell runs to print jobs.

BSD physical printer
In InfoPrint, the object representing a
printer device that uses the BSD
destination support system.

burn In platemaking, an exposure. Burn is
named because of the extremely bright
ultraviolet lamps used to transfer images
from film to plate.

In photography, to lengthen the final
exposure time to increase the final density
of print.

C

cathode ray tube (CRT)
A vacuum tube in which a beam of
electrons can be moved to draw lines or
form characters or symbols on its
luminescent (phosphor-coated) screen.
CRTs are the heart of all modern
computer display screens. Black and
white displays have only one phosphor
scanned by one electron beam, while
color displays have RGB phosphors
scanned by three beams.

CDE Common Desktop Environment.

child See parent/child relationship.

choke In color printing, an area whose
dimensions have been reduced to avoid
overlapping another color. Contrast with
spread.

class Synonym for object class.

clean In InfoPrint, an action used to remove all
the jobs from specified servers, actual
destinations, or queues, or to remove all
the jobs submitted to specified logical
destinations.

CLI Command Line Interface.

client In InfoPrint, the component of the print
system that assembles a print request and
submits the request to a server. The client
generates the local ID numbers for each
job, submits the jobs to the servers, and
keeps track of where each user’s jobs
have been submitted.

CMR Color Management Resource.

CMY Cyan, magenta, yellow.

CMYK
Cyan, magenta, yellow, black.

collator
In some printers a special-purpose hard
drive disk array used to store RIPped files
and later transfer them to the LED print
heads for imaging.

color balance
The relative levels of cyan, magenta, and
yellow channels in an image to produce
accurate color rendition of an original
image.

color correction
The adjustment of the color balance in an
image to produce accurate color rendition
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of an original image. Color correction is
used for two- or three-spot-color jobs.

color key
A color proof similar to Cromalin, but
typically not laminated and not
necessarily accurate in color. Color keys
are used to verify that breaks or color
assignments and traps have been made
accurately.

Color management resource
Color management resource (CMR) is an
architected resource that is used to carry
all of the color management information
required to render a print file, document,
group of pages or sheets, page, or data
object with color fidelity.

Command Line Interface (CLI)
A type of user interface where commands
are specified on the command line.
Contrast with Graphical User Interface.

Common Desktop Environment (CDE)
A graphical user interface running on a
UNIX operating system.

complex attribute
In InfoPrint, an attribute that can have
multiple values with each value
containing multiple components.

constant data
Data that does not change between copies
of a document and that is merged with
variable data to produce personalized
documents. For example, a form letter
(constant data) can be merged with a
customer’s name and address (variable
data).

contextual help
A type of online help that provides
specific information about each selectable
object, menu choice, notebook tab, field,
control, and pushbutton in a window.

control strip
A strip of information that can be
attached to a print job and used to
measure registration and density.

Cromalin
The Dupont color proofing system. Four
layers (CMYK) of light-sensitive material
are exposed through final halftone
negative films, then laminated together on
an opaque backing to produce a color-
and trap-accurate final proof showing

actual halftone dot structure. Cromalin is
sometimes called an analog proof.

crop To remove unwanted areas of an image,
usually indicated by crop marks on the
original.

CRT Cathode ray tube.

CTS Cutter-trimmer-stacker.

cutter-trimmer-stacker (CTS)
A post-processing device attached to a
printer device and used for paper
handling.

cyan, magenta, yellow (CMY)
The subtractive primary colors.

cyan, magenta, yellow, black (CMYK)
The four basic colors used in offset
printing, as opposed to the three basic
colors of light: red, green, and blue.
Magenta, yellow, and cyan are the
subtractive primaries. Black is added to
provide better density and to produce a
true black.

D

daemon
A program that runs unattended to
perform a standard service. Some
daemons are triggered automatically to
perform their tasks; others operate
periodically. Daemon processes generally
provide a service that must be available at
all times to more than one task or user,
such as sending data to a printer.

DAT Digital audio tape.

data stream
All information (data and control
commands) sent over a data link.

A continuous stream of data that has a
defined format.

In InfoPrint, pertaining to the incoming
format of the job and the output format
required by the printer device. InfoPrint
transforms the incoming format into the
output format, as required. See also
document format.

DB2*/6000
DataBase 2/6000.

deadline
In InfoPrint, a queuing technique where
the next job assigned to the first position
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in the queue is the one whose deadline is
closest. Contrast with FIFO
(first-in-first-out), job-priority,
longest-job-first, and shortest-job-first.

default document
In InfoPrint, an object that represents
default attribute values for a document in
a job. Synonymous with initial value
document.

default job
In InfoPrint, an object that represents
default attribute values for a job.
Synonymous with initial value job.

default object
In InfoPrint, a general term that refers
either to a default document or a default job.
Synonymous with initial value object.

default value
A value stored in the system that is used
when no other value is specified.

delete In InfoPrint, an action used to delete
default objects, jobs, logical destinations,
actual destinations, or queues from the
server.

desktop publishing
Performing print-related activities on a
personal computer, including but not
limited to layout, design, photo
manipulation, creating fonts, editing text,
color separation, scanning, and animation.

destination
See actual destination, logical destination.

destination support system (DSS)
In InfoPrint, the programs that an actual
destination uses to communicate with the
output device. Synonymous with device
support system. See AIX destination support
system, BSD destination support system,
email destination support system, Generalized
Fax destination support system, and PSF
destination support system.

device An individual piece of equipment
(hardware) that attaches to a computer,
such as a printer device.

device address
The identification of an input or output
device by its channel and unit number.

device driver
A file that communicates with a specific
device such as a printer, disk drive, or

display. An application that sends output
to a device controls the actions of the
device through the device driver. See
printer driver.

device support system (DSS)
Synonym for destination support system.

DFS™ Distributed File Service.

digital Pertaining to data represented by digits,
sometimes with special characters and the
space character.

digital audio tape (DAT)
A high-capacity, low-cost bulk storage
system used for archiving, copying (for
backup purposes), and transferring large
files. Typical DAT units store 1.3 GB on
inexpensive cassette tapes.

digital color proof
An off-press color proof made from a
color printer attached to a computer.

digital printing
A filmless and plateless printing process
in which digital data for each page is
transferred directly to a light-sensitive
drum and then to paper for a final image.

direct-attached printer
A printer device, attached to an RS/6000
computer through the network or through
a serial or parallel port.

In InfoPrint, a PSF physical printer that
represents a direct-attached printer device.
See also AIX-attached printer,
TCP/IP-attached printer, and
upload-TCP/IP-attached printer.

disable
In InfoPrint, an action used to stop the
acceptance of jobs on destinations,
queues, or servers, or to stop writing
information to logs.

distributed print system
A computer system with the ability to
interchange print data and controls
among different computing environments
with the intent of printing the data on a
different system from the one where the
print request was generated. For example,
in host-to-LAN distributed printing, data
that is located on the host is printed on
printers attached to a local area network.

dithering
A technique of filling the gap between
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two pixels with another pixel having an
average value of the two to minimize the
difference or to add detail to smooth the
result.

document
In InfoPrint, an object representing a
grouping of data in a job. A job can
contain one or more documents. The
documents in a job can differ from each
other in some ways. For example, they
can contain different data and can have
different document formats. A document
in a job can contain printable data or a
resource that is not printable by itself. See
file-reference document, printable document,
and resource document.

document element
A portion of a document at least a single
page in size.

document format
In InfoPrint, a document format describes
the type of the data and control characters
in the document, such as line data or
PostScript. The format of the data
determines which printer devices are
capable of printing the document and
whether InfoPrint must transform the
format.

document identifier
A string that identifies a document in a
job. It consists of a job ID followed by a
period (.) and a document sequence
number. For example, 12.2. Document
sequence numbers are integers starting at
1.

Document Printing Application (DPA)
An ISO/IEC 10175 standard that
addresses those aspects of document
processing that enable users in a
distributed open systems environment to
send electronic documents to shared,
possibly geographically-dispersed
printers. InfoPrint supports the DPA
standard.

document transfer method
In InfoPrint, the transfer method describes
how documents are transferred to, or
acquired by, servers. See pipe-pull and
with-request.

document type
In InfoPrint, the document type describes
the kind of data in the document. A

printable document can only contain
printable data. A resource document can
only contain data such as fonts or form
definitions that are not printable. A file
reference document can only contain names
of files entered on separate lines.

dot The individual elements of a halftone.

dot gain
An increase in the size of a halftone dot
during printing, caused by ink spreading.
Generally, this value is known precisely,
and the scanning and filming production
process is calibrated to compensate for it.
The Cromalin proofing system simulates
this effect.

dots per inch (dpi)
A measure of data density per unit
distance. Typical values for desktop
publishing range from 200 to 300 dpi.

DPA Document Printing Application.

DPF Distributed Print Facility.

dpi Dots per inch.

drag and drop
In graphical user interfaces, a procedure
by which you perform actions and tasks.
Using the mouse, you drag (move) an
action or object icon to a new position
where you want the action or task to
occur.

DSS Destination support system.

dummy
A rough paste-up or hand-drawn
representation of the anticipated finished
product. A dummy is used for basic
design and pagination.

duplex printing
Printing on both sides of the paper.
Contrast with simplex printing (1).

Printing on both sides of the paper,
placing output images on the media in a
head-to-head format, so that the top of
one image is at the same edge as the top
of the next image. Contrast with tumble
duplex printing; see also simplex printing
(2).

E

early binding
In InfoPrint, assigning a job to an actual
destination as soon as it is accepted. Early
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binding permits InfoPrint to estimate the
time when the job will be completed.
Contrast with late binding.

edition binding
A type of book binding in which printed
sheets are folded into 16- or 32-page
signatures. Four-page endleaves are
pasted on the outside of the first and last
signature. The signatures are then collated
by machine and sewn together using
special sewing machines. Contrast with
perfect binding, spiral binding, and wire-o
binding.

electronic document
A document stored in a computer instead
of printed on paper.

electronic mail
Correspondence in the form of messages
sent between workstations over a
network. Synonymous with email.

electrophotographic
Pertaining to a type of printer technology
that creates an image on paper by
uniformly charging the photoconductor,
creating an electrostatic image on the
photoconductor, attracting negatively
charged toner to the discharged areas of
the photoconductor, and transferring and
fusing the toner to paper.

em In composition, a unit of measurement
exactly as wide and as high as the point
size of the font being set. The name is
derived from the fact that the letter M in
early typefaces was usually cast on a
square body.

email Electronic mail.

email destination
In InfoPrint, an actual destination
representing an electronic mailing system.

email destination support system
In InfoPrint, the destination support
system that supports email destinations.

embellishments
Variable data added to all copies of
assembled pages to make the unit appear
like a whole; for example, headers,
footers, a table of contents, and chapter
separations.

en In composition, exactly one-half an em.

enable
In InfoPrint, the action that makes a
destination, queue, or server able to
accept jobs, or a log able to accept
information.

end sheet
The sheet of paper, blank or otherwise,
that can follow a job. See also auxiliary
sheet.

Enhanced X-Windows
A tool designed to permit multiple
application processes to operate in
multiple windows displayed on a virtual
terminal. See X-Windows.

environment variable
Any one of a number of variables that
describe the way an operating system
runs and the devices it recognizes.

error log
A data set or file in a product or system
where error information is stored for later
access.

estimate
The professional cost analysis made by a
print shop in response to a customer’s
request for a price quotation on a print
job.

event In InfoPrint, an occurrence in the printing
system during an operation; for example,
the completion of a command.

event log
In InfoPrint, a collection of messages
about events that have occurred.

event notification
The notification that is sent by InfoPrint
for an event.

F

fax destination
In InfoPrint, an actual destination
representing a fax device.

FIFO (first-in-first-out)
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the job that has been in
the queue for the longest time. InfoPrint
processes jobs in the order in which they
are received. Contrast with deadline,
job-priority, longest-job-first, and
shortest-job-first.
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file-reference document
In InfoPrint, a file containing the names
of other files, each entered on a separate
line. Job submitters can specify this file
for printing when they specify a
document type of file-reference; InfoPrint
prints each file listed in the reference
document.

File Transfer Protocol (FTP)
In TCP/IP, the application protocol that
makes it possible to transfer data to and
from host computers and to use foreign
hosts indirectly.

finisher
A hardware device attached to a printer
that performs such operations as folding
or stapling the printed pages.

finishing
In a print shop, the final operations on a
printed product, such as stapling,
trimming, drilling, folding, embossing,
varnishing, gluing, shrink wrapping,
perforating, laminating, collating, and so
on.

flag A modifier of a command that specifies
the action of the command. A dash
usually precedes a flag. Synonymous with
option. See also keyword.

FOCA Font object content architecture.

folder In the InfoPrint GUI, an object that
represents a container for a collection of
similar objects. For example, the Retained
Jobs folder contains retained jobs.

font A family of characters of a given size and
style; for example, 9-point Helvetica.

One size and one typeface in a particular
type family, including letters, numerals,
punctuation marks, special characters,
and ligatures.

A paired character set and code page that
can be used together for printing a string
of text characters. A double-byte font can
consist of multiple pairs of character sets
and code pages.

form definition
A resource object used by InfoPrint that
defines the characteristics of the form or
printed media, which include: overlays to
be used, the paper source (for cut-sheet
printers), duplex printing, text

suppression, and the position of
composed-text data on the form.

forward space
In InfoPrint, the action used to move
ahead and skip the printing of a specified
number of pages in a job.

FPO Low-quality (sometimes photographic)
images placed in a dummy to represent
final images. Desktop publishing software
produces images as display-screen
resolution FPOs.

front panel
In the CDE, a workspace area containing
controls that represent various tasks you
can perform and workspace switches.

FTP File Transfer Protocol.

G

GCR Gray component replacement.

Generalized Fax destination support system
In InfoPrint, the destination support
system that supports generalized fax
destinations.

GIF Graphics Interchange Format.

global change
In the InfoPrint GUI, an action used to
make changes to one or more attributes of
several objects at once. You can also
perform the same action on several
objects of the same object class at the
same time; for example, disabling two or
more actual destinations at the same time.

global character
A character or set of characters used to
specify an unknown number or set of
characters in a search string. In InfoPrint,
a global character is represented by an
asterisk (*).

global ID
Global job identifier.

global job identifier
An unambiguous job identifier. In
InfoPrint, it is represented as the name of
the server managing the job followed by a
colon (:) and a generated integer. This ID
uniquely identifies the job in the InfoPrint
server.

glyph An image, usually of a character, in a
font.
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GOCA
Graphics object content architecture.

graphic character
A visual representation of a character,
other than a control character, that is
normally produced by writing, printing,
or displaying.

Graphical User Interface (GUI)
A type of user interface that takes
advantage of a high-resolution monitor
and includes a combination of graphics to
implement an object-action paradigm, the
use of pointing devices, menu bars,
overlapping windows, and icons. Contrast
with Command Line Interface.

Graphics Interchange Format (GIF)
A compressed graphics format widely
used on the Internet.

gray component replacement (GCR)
Synonym for under color removal (UCR).

gray scale
A strip of standard gray tones, ranging
from white to black, placed at the side of
the original copy during photography to
measure the tonal range and contrast
obtained.

GUI Graphical User Interface.

gutter The blank area or inner margin from the
printing area to the binding.

H

halftone
A printing method that simulates
continuous-tone shading using dots of
varying sizes laid out on a rectangular
grid. Larger dots simulate darker tones
and smaller dots simulate lighter tones.
Typical grid spacings are 85 lines per inch
(lpi) (newspaper), 133 lpi (low end), 150
lpi (midrange), and 175+ lpi (high
quality).

help In the InfoPrint GUI, an action used to
display the online help for a specific
template, object, action, button, control, or
area in an application window.

The name of a button used to access the
online help.

hold An indication determined by the job-hold

attribute that is used to keep a job in the
queue and prevent InfoPrint from
scheduling it.

hostname
The name given to an AIX system.

hot folder
A workstation directory where users copy
jobs to submit them to print.

hypertext
A way of presenting information online
with connections between one piece of
information and another. These
connections are called hypertext links. See
also hypertext link.

hypertext link
A connection between one piece of
information and another. Selecting a link
displays the target piece of information.

I

icon A graphic symbol displayed on a screen
that a user can click to invoke a function
or software application.

image Toned and untoned pels arranged in a
pattern.

image data
Rectangular arrays of raster information
that define an image.

imagesetter
A high resolution (1270–3600+ dpi)
printer that uses an Argon (green) laser to
write to film using digital imput.
Imagesetting is the step before Cromalin
proofing and platemaking.

imposition
The process of arranging pages on a press
sheet to ensure the correct order during
final cutting, folding, and binding.
Electronic imposition builds press sheets
automatically during the RIP and outputs
film formatted for immediate use in
platemaking.

InfoPrint
A solution of software and hardware
products that can supplement or replace
the offset presses and copiers in print
shops with high-quality, non-impact,
black and white or process color printers.
InfoPrint takes documents from creation
to the published, kitted, and shipped
product.
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In InfoPrint software publications,
InfoPrint Manager for AIX or any of its
components.

InfoPrint Manager for AIX
The software component of InfoPrint.
InfoPrint Manager for AIX handles the
scheduling, archiving, retrieving, and
assembly of a print job and its related
resource files. It also tracks the finishing
and packaging of the printed product.

InfoPrint Manager for AIX is based on
Palladium technology developed at
MIT/Project Athena. It conforms to the
ISO DPA and POSIX standards.

InfoPrint Network
The local area network running TCP/IP
protocol that InfoPrint uses to
communicate among servers, clients, and
output devices.

InfoPrint Select
The component of InfoPrint Manager for
AIX that lets you submit jobs from an
OS/2® or Windows workstation.

InfoPrint Submit Express
The component of InfoPrint Manager that
lets you submit jobs with a job ticket from
a Windows or Macintosh workstation.

InfoPrint 20
A black and white, large-format, cut-sheet,
workgroup laser printer with optional
duplexing and 600-dpi resolution.

InfoPrint 60
A duplex, black and white, cut-sheet
printer with 600-dpi resolution.

InfoPrint 62
A non-impact, continuous-forms printer
that runs at a maximum of 62
impressions-per-minute (depending on
forms size), and is factory set to run at
either 240 or 300 dpi on a maximum
paper size of 370.8 mm (14.6 in.).

InfoPrint 4000
A duplex, black and white,
continuous-forms printer with 600-dpi
resolution.

initial value document
Synonym for default document.

initial value job
Synonym for default job.

initial value object
Synonym for default object.

initially settable attribute
An attribute whose value can be
established when an object is created but
cannot be subsequently set or modified.
See also resettable attribute; contrast with
non-settable attribute.

input focus
The area of a window where user
interaction is possible from either the
keyboard or the mouse.

input tray
For a printer device, the container that
holds the medium upon which the printer
prints its output.

Intelligent Printer Data Stream™ (IPDS)
An all-points-addressable data stream that
enables users to position text, images, and
graphics at any defined point on a
printed page.

Information that the host sends to IPDS
printers. This information generally
contains basic formatting, error recovery,
and character data and enables the
printers to make decisions.

An architected host-to-printer data stream
that contains both data (text, image,
graphics, and bar codes) and controls
defining how the data is to be presented.
IPDS provides a device-independent
interface for controlling and managing
all-points-addressable (APA) printers.

International Organization for Standardization
(ISO) An organization of national standards

bodies from various countries established
to promote development standards to
facilitate international exchange of goods
and services, and develop cooperation in
intellectual, scientific, technological, and
economic activity.

Internet
A wide area network connecting
thousands of disparate networks in
industry, education, government, and
research. The Internet network uses
TCP/IP as the protocol for sending
information.

Internet Protocol
The set of rules that determines how to
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route data from its source to its
destination in an internet environment.

intervening jobs
In InfoPrint, the number of jobs in a
queue that are scheduled to print before
the job in question.

IOCA Image object content architecture.

IP address
The Internet Protocol address of the
server in a dotted decimal format where
each node is an integer. (For example,
9.99.9.143).

IPDS Intelligent Printer Data Stream.

ISO International Organization for
Standardization.

J

job In InfoPrint, an object that represents a
request to print or send one or more
documents together in a single session. A
job includes the data to be printed or sent
and resources such as fonts, images, and
overlays. Depending on how it was
submitted, it can also include a job ticket.
Synonymous with job bundle and print job.

job bundle
Synonym for job.

job data
The page descriptions, merge data, and
embellishments that compose a document
in a job, either directly or by reference.

job ID
A local or a global identifier that
identifies a job to a job submitter,
administrator, operator, or InfoPrint. See
local job identifier, global job identifier.

job-priority
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the one with the highest
priority. Contrast with deadline, FIFO
(first-in-first-out), longest-job-first, and
shortest-job-first.

job submitter
In InfoPrint, the person who submits jobs
for printing. Often, this person is an
application programmer who maintains
applications that generate data to be
printed.

job ticket
The customer’s hardcopy or electronic
instructions listing all the variables
describing a print job, either directly or
by reference. The print shop can add
specifications to the job ticket and can
print the job ticket.

Joint Photographic Experts Group (JPEG)
A compressed graphics format widely
used on the Internet.

JPEG Joint Photographic Experts Group.

K

kerning
In typesetting, adjusting the relative
spacing of two characters to improve their
appearance and readability. Kerning pairs
are specific sets of characters with built-in
relative spacing. Some typefaces have as
many as 100 kerning pairs.

keyword
A name or symbol that identifies a
parameter.

Part of a command operand that consists
of a specific character string, such as
DSNAME=.

kitting
In a print shop, packaging the completed
published work with attendant binders,
tabs, diskettes, and other equipment or
information, before shipping the finished
product.

L

LAN Local Area Network.

laser (light amplification by stimulated emission
of radiation)

In InfoPrint printers, a device that emits a
beam of coherent light that forms the
image on the photoconductor that is
subsequently transferred to the paper.

late binding
In InfoPrint, waiting to assign a job to an
actual destination until it is about to be
processed. Late binding permits InfoPrint
to route a job to the first suitable actual
destination that becomes available.
Contrast with early binding.

LED Light-emitting diode.
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light-emitting diode (LED)
The imaging device element for
electrophotographic print units.

lines per inch (lpi)
A measure of the density of the grid used
to space halftone dots. Typical grid
spacings are 85 lpi (newspaper), 133 lpi
(low end), 150 lpi (midrange), and 175+
lpi (high quality).

Local Area Network (LAN)
A computer network at one location that
consisting of devices connected to one
another and communicating. This
network can also be connected to a larger
network.

local ID
Local job identifier.

local job identifier
In InfoPrint, a job identifier automatically
generated by the server, identifying the
job to the person who submitted it.
InfoPrint maps a local job ID to a global
job ID.

locale The human language and character set of
information presented to a user.

In InfoPrint, the language InfoPrint uses
when sending notification and error
messages or displaying the InfoPrint
graphical user interfaces.

log A collection of messages or message
segments added to a file for accounting or
data collection purposes.

To record messages in a file.

logical destination
In InfoPrint, an object to which users
submit their jobs. The logical destination
routes jobs to one or more actual
destinations representing output devices
such as printers, electronic mail systems,
or fax machines. See also logical printer;
contrast with actual destination.

logical printer
In InfoPrint, a type of logical destination.
The logical printer routes jobs to one or
more physical printers representing
printing devices.

logical unit (LU)
A type of network accessible unit that

enables end users to gain access to
network resources and communicate with
each other.

logical unit (LU) 6.2
A type of logical unit that supports
general communication between
programs in a distributed processing
environment. LU 6.2 is characterized by
(a) a peer relationship between session
partners, (b) efficient utilization of a
session for multiple transactions, (c)
comprehensive end-to-end error
processing, and (d) a generic application
program interface (API) consisting of
structured verbs that are mapped into a
product implementation.

longest-job-first
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the longest job in the
queue. Contrast with deadline, FIFO
(first-in-first-out), job-priority, and
shortest-job-first.

lpi Lines per inch.

LU Logical unit.

M

magnetic ink character recognition (MICR)
Identification of characters printed with
ink that contains particles of magnetic
material.

mainframe processor
A functional unit that interprets and
executes instructions in a large computer
to which other computers are connected
so that they can share the facilities the
mainframe provides.

makeready
All the setup work involved in preparing
a press for a print run.

manage
In the InfoPrint GUI, the action used to
put an object into a mode where its icon
reflects changes of status.

mechanical
A camera-ready layout. The mechanical
can consist of multiple sheets or overlays
for each spot or process color used. Final
images, if not stripped in later, should be
at final size, cropped and screened to the
correct line frequency.
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medium
In InfoPrint, an object representing the
physical material upon which a job is
printed.

merge data
Data that is unique to each copy of a
document and that customizes the
document; for example, serial numbers or
mailing information. Merge data is
typically a small percentage of the total
data in the document.

message catalog
A file of all the possible messages than
can display during the processing of an
application.

MICR Magnetic ink character recognition.

Mixed Object Document Content Architecture™

(MO:DCA™)
An architected, device-independent data
stream for interchanging documents.

MO:DCA-P
Mixed Object Document Content
Architecture Presentation.

modify
In InfoPrint, an action used to modify the
values of attributes in the object attributes
notebook.

moire Undesirable interference patterns caused
by two overprinting halftone screens with
incorrect halftone dot angles.

monospaced
In typesetting, pertaining to a typeface in
which all the characters have equal
widths. Monospaced typefaces are useful
for tabulating figures.

Multiple Virtual Storage (MVS™)
An operating system developed by IBM.
The design of MVS incorporates an
addressing architecture that provides a
unique address space to each job in the
system.

MVS Multiple Virtual Storage.

N

N_UP Pertaining to the number of forms placed
together in a layout. Typical layouts are
2_UP, 4_UP, 8_UP, 16_UP, and so on.
N_UP printing is done to use the
maximum area of the print sheet.

namespace
A global name repository available to all
utilities and API procedures. The
namespace contains mappings of object
names to other related objects. For
example, the namespace provides the
mapping of a logical destination to the
server in which it is located.

Network File System (NFS)
A protocol developed by Sun
Microsystems that uses Internet Protocol
to allow a set of cooperating computers to
access each other’s file systems as if they
were local.

newline options
The different ways in which the printer
determines how lines are delimited in a
document data stream.

NFS Network File System.

non-process-runout (NPRO)
A printer function that moves the last
printed sheet to the stacker of the printer
device.

non-settable attribute
An attribute that is neither initially
settable nor resettable. The values for
these attributes are controlled by
InfoPrint. Contrast with initially settable
attribute and resettable attribute.

notification
The act of reporting the occurrence of
events.

In InfoPrint, notification of events appears
as messages in event logs or messages
sent to administrators, operators, and job
submitters. In the InfoPrint GUI,
notification of events also appears as
changes to the appearance of icons.

notification-profile
In InfoPrint, an attribute associated with
an object that contains information
designating the people to whom InfoPrint
sends notification about events for that
object, which event information it sends,
and how it sends the information.

NPRO Non-process-runout.

O

object A collection of attributes that represent a
physical or logical entity in the print
system. For example, a specific printer
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device is represented by an actual
destination (physical printer) object. An
object is identified by its object name.
Objects are grouped into classes. See also
object class.

object class
A group of objects that share a common
definition and therefore share common
properties, operations, and behavior as
defined by their attributes. For example,
all InfoPrint queue objects are in the same
object class and each queue has the same
set of queue attributes. However, the
values for those attributes can differ for
each queue in the queue object class.

Object Identifier (OID)
In architecture, a notation that assigns a
globally unambiguous identifier to an
object or a document component. The
notation is defined in international
standard ISO.IEC 8824(E).

object name
The alphanumeric term that identifies an
object.

object state
The state of an object indicates its
availability and readiness for performing
its functions. An object can be in one of a
number of states such as ready, busy, or
unknown.

OCR Optical character recognition.

octet A byte that consists of eight binary digits
(bits).

offset stacking
In certain printer devices, a function that
allows the printer to offset the printed
output pages for easy separation of the
jobs.

OID Object Identifier.

open destinations window
In the InfoPrint GUI, the action used to
open a new application window
displaying the logical and actual
destinations associated with a queue.

Open Prepress Interface (OPI)
An industry standard for replacing
low-resolution images in review
documents with high-resolution images
needed for high-quality final output.

Open Software Foundation (OSF)
A nonprofit research and development
organization created by a consortium of
companies that work together to develop
software in the open systems market.

OpenType font (OTF)
An extension of the TrueType font format
that adds:
v Support for PostScript outlines
v Better support for international

character sets
v Broader support for advanced

typographic control

open window
In the InfoPrint GUI, the action used to
open a new application window
representing one or more objects
displayed in the currently open
application window.

operation
An action performed on one or more data
items.

operator
In InfoPrint, the person responsible for
printer devices. Also, this person
performs a subset of tasks for InfoPrint
queues and actual destinations and
performs some job-related tasks.

OPI Open Prepress Interface.

optical character recognition (OCR)
Conversion of scanned text to editable
ASCII characters.

option A modifier of a command that specifies
the action of the command. A dash
usually precedes an option. Synonymous
with flag. See also keyword.

orphan logical destination
In the InfoPrint GUI, an object that
represents a logical destination that is not
associated with an existing queue.

orphan logical printer
In the InfoPrint GUI, an object that
represents a logical printer that is not
associated with an existing queue.

OSF Open Software Foundation.

overlay
A collection of constant data, such as
lines, shading, text, boxes, or logos, that is
electronically composed in the host
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processor and stored in a library, and that
can be merged with variable data during
printing.

OTF OpenType font.

P

PAC Privilege Attribute Certificate.

page definition
A resource that contains the formatting
controls for line data.

In InfoPrint, a resource that defines the
rules of transforming line data into
composed pages and text controls.

page segment
A resource that contains composed text
and images, which are prepared before
formatting and included during printing.

Palladium
A distributed print system developed at
MIT/Project Athena with participation
from Digital Equipment Corporation
(DEC), International Business Machines
(IBM), and Hewlett-Packard (HP). It is a
reference implementation for the OSI
Document Printing Architecture (DPA)
standard, ISO/IEC 10175.

pane In the Work Area of the InfoPrint
Manager Administration GUI, an area
containing a group of objects of a specific
type, such as an actual destinations pane.

parent/child relationship
In InfoPrint, servers, queues, and
destinations are related to one another in
a parent/child relationship. For example,
a server is the parent of all the queues
that reside in that server, and these
queues are its children.

pass through
In InfoPrint, referring to options
submitted with a job that are used by the
device driver, but not InfoPrint. InfoPrint
does not process or validate this
information; it passes it along to the
device driver. See printer driver.

path The route used to locate files; the storage
location of a file. A fully qualified path
lists the drive identifier (if any), directory
name, subdirectory name (if any), and file
name with the associated extension.

pause In InfoPrint, the action used to

temporarily halt the printing or
transmission of jobs on actual destinations
or the distribution of jobs from servers or
queues.

pdcreate
In InfoPrint, the command used to create
a new object and set its attributes to
specified values.

PDF Portable Document Format.

Printer description file.

pdmsg
In InfoPrint, a utility used to display
information about a message.

pdpr In InfoPrint, the command used to create
and submit a job, consisting of one or
more documents, to a server for printing
or transmission.

perfect binding
A type of book binding in which the
pages are held together with flexible
adhesive. Contrast with edition binding,
spiral binding, and wire-o binding.

permissions
In AIX, codes that determine who can
access a file and what operations they can
perform on the file.

physical printer
In InfoPrint, a type of actual destination
that represents a printer device. See also
printer device.

piobe The standard printer input/output
backend program used by AIX for
printing. See also ainbe.

pipe-pull
In InfoPrint, a document transfer method
where InfoPrint saves the documents in a
file and transfers the address of the file to
the server. InfoPrint transfers the file to
the server upon the request from the
server. This is an efficient transfer method
for large jobs and is the default transfer
method at job submission. Contrast with
with-request.

plex A document or actual destination
attribute used to define the placement of
output images on the page. See the plex
values simplex and tumble.

Portable Document Format (PDF)
An Adobe PostScript data format that can
be viewed or printed.
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Portable Operating System Interface for
Computer Environments (POSIX)

An Institute of Electrical and Electronics
Engineers (IEEE) standard for computer
operating systems.

POSIX
Portable Operating System Interface for
Computer Environments.

PostScript
Adobe’s page description language.
PostScript has become a standard for
graphic design and layout software.
PostScript files can contain both vector
and raster data. Fonts are described using
PostScript coding. Many desktop
publishing systems produce PostScript
data as their output data stream.

PostScript printer description (PPD)
A file that contains options for printing
PostScript data on various printer devices.

PPD PostScript printer description.

preflight
To assess all resources for a job before the
actual print run.

prepress
Work done in the print shop before
printing a job, such as preparing data and
art, page imposition, color retouching,
electronic editing, and page layout.

print database
The set of files on disk that provide a
permanent repository for the attributes of
all print objects, such as logical
destinations, queues, and actual
destinations.

print job
Synonym for job.

Print Quality Enhancement (PQE)
A printer facility that provides edge
smoothing along diagonal lines, fine
fidelity protection, and independent
boldness control.

Print Services Facility™ (PSF)
Any of several programs, including PSF
for AIX, PSF/MVS, PSF/VM, and
PSF/VSE, that produce printer commands
from the data sent to them.

print system
A group of one or more print servers and
one or more printing devices, which

might or might not be located in the same
geographical area. The components of a
print system are assumed to be
interconnected in some manner, providing
at least one network interface to print
clients, and acting synergistically to
supply the defined document print
service. (D)

printable document
In InfoPrint, an object that represents text
or data to be printed by a job. Contrast
with resource document.

printer description file (PDF)
A file that contains options for printing
PostScript data on a specific printer
device.

printer device
The physical output device that performs
the printing function. See also physical
printer.

printer driver
A file that describes the physical
characteristics of a printer or other
peripheral device. This file is used to
convert graphics and text into
device-specific data at the time of printing
or plotting. Synonymous with device
driver.

priority
In InfoPrint, a number assigned to a job
that determines its precedence in being
printed. Jobs with higher priority
numbers are handled before jobs with
lower priority numbers.

process color
Color made up of CMYK links simulating
a specified color. This is the traditional
method of reproducing continuous tone
color images (color separations). Because
of the nature of color inks, certain inks do
not reproduce well.

processor
In a computer, a functional unit that
interprets and executes instructions. A
processor consists of at least an
instruction control unit and an arithmetic
and logic unit. (T)

promote
In InfoPrint, the action used to move a job
to the beginning of the queue so that it
will print on the next available printer
that can handle that job.
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protocol
A set of semantic and syntactic rules that
determines the behavior of functional
units in achieving communication.

PSF Print Services Facility.

PSF destination support system
In InfoPrint, the destination support
system that communicates with PSF for
AIX to print jobs.

PSF physical printer
In InfoPrint, the object representing a
printer device that uses the PSF
destination support system.

Q

QuarkXpress
A desktop publishing system produced by
Quark, Incorporated.

queue In InfoPrint, an object that manages a
collection of jobs that are waiting to print.
A queue receives jobs from one or more
logical destinations and sends jobs to one
or more actual destinations.

A line or list formed by items waiting for
processing.

R

raster A pattern of dots defined at varying data
depths. Black and white images are
one-bit (on/off); grayscale images are
8-bit (256 levels); RGB images are 24-bit;
CMYK images are 32-bit.

raster image processor (RIP)
A processor in which a PostScript data
stream is converted into dot patterns that
are transferred to the final print medium.
InfoPrint uses an Adobe RIP to convert
PostScript to IPDS for such printers as the
InfoPrint 4000 and InfoPrint 60.

rc.pd In InfoPrint, a utility used to start the
InfoPrint servers listed in the
/etc/pd.servers file.

read-only
In InfoPrint, describes an attribute value
that cannot be set by the user but can
change based on other activity.

ready A state in which an object is ready and
able to perform tasks.

An available resource, such as a value of
the media-ready attribute. Contrast with
supported.

red, green, blue (RGB)
The colors of CRT display phosphors.
RGB images are for screen display only.
They must be converted to CMYK images
before printing.

registration
The accuracy of printing on paper relative
to the edges of the paper.

The accuracy of printing a single color
(cyan, magenta, or yellow) relative to
black.

The accuracy of printing on one side of a
page relative to printing on the reverse
side of the page.

reprographics
The process of copying or duplicating
documents or information.

requested
In InfoPrint, pertaining to the specific
values of attributes requested by a job
when it is submitted. The requested
attribute values of a job are validated
against supported attribute values for an
actual destination to determine if the
printer can handle that job. Contrast with
supported.

resettable attribute
An attribute whose value can be set or
modified after an object has been created,
assuming the object is in an appropriate
state to be modified. See also initially
settable attribute; contrast with non-settable
attribute.

resource
In AFP, a file containing a collection of
printing instructions used when printing
a job. Resources include fonts, overlays,
form definitions, page definitions, and
page segments.

resource context
In InfoPrint, an object that contains
directory path information that helps the
print system locate resources needed for
printing a job. The resources include
fonts, overlays, form definitions, page
definitions, and page segments.

resource document
In InfoPrint, an object that represents a
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resource, such as graphics or fonts, used
by a job to print a printable document.
Contrast with printable document.

resubmit
In InfoPrint, an action used to reroute
pending or retained jobs to a different
logical destination than the one through
which the job was originally submitted.

resume
In InfoPrint, the action used to resume the
printing of paused jobs or resume the
distribution of jobs from paused servers
or queues.

retained job
In InfoPrint, an object that represents a
job that is being stored in the print
system for a specified amount of time,
normally after the completion of printing
the job. A retained job does not reside in a
queue.

retention
The process of storing data after
completion of a process for a certain
length of time.

retrieval
The process of bringing digital archived
data out of storage and into online
memory for reuse. See also archiving.

RGB Red, green, blue.

RIP Raster image processor.

To convert data to dot patterns using a
raster image processor.

root user
In the AIX environment, the system user
with the most authority who can log in
and execute restricted commands, shut
down the system, and edit or delete
protected files. Synonymous with
superuser.

RPC Remote Procedure Call.

RS/6000
A family of workstations and servers
based on IBM’s POWER® architecture.
They are primarily designed for running
multi-user numerical computing
applications that use the AIX operating
system.

S

scanner
A device that converts hardcopy source
data into digital format (halftone dots) to
avoid retyping the data.

scheduler
In InfoPrint, the scheduling method that
the queue uses when assigning a job to an
actual destination.

separator sheet
The sheet of paper, blank or otherwise,
that separates documents in a job. See
also auxiliary sheet.

server In InfoPrint, the object that accepts
configuration, management, and printing
requests, performs the requested
operations, and sends responses back as a
result of the operation.

settable attribute
See initially settable attribute, resettable
attribute.

severity
An indication of how serious an error
condition is.

shell In the AIX operating system, a command
interpreter that acts as an interface
between the user and the operating
system. In InfoPrint documentation, all
shell examples use the Korn shell.

shift-out, shift-in code
Control characters used to indicate the
beginning and end of a string of
double-byte, ideographic characters.

shortest-job-first
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the shortest job in the
queue. Contrast with deadline, FIFO
(first-in-first-out), job-priority, and
longest-job-first.

shut down
In InfoPrint, the action used to halt all
server or actual destination processes
without deleting the server or actual
destination.

signature
A group of pages that are printed, folded,
cut, and bound together. Manual
placement of pages in the signature is
determined using a folding dummy.
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simplex
In InfoPrint, the value of the document or
actual destination plex attribute indicating
that output images are placed on the
media in a head-to-head format, so that
the top of one image is at the same edge
as the top of the next image. Depending
on the value of the document or actual
destination sides attribute, the document
can be printed on one or both sides of the
paper. Contrast with tumble; see also
simplex printing and duplex printing.

simplex printing
Printing on only one side of the paper.
Contrast with duplex printing (1).

Printing on one or both sides of the
paper, placing output images on the
media in a head-to-head format, so that
the top of one image is at the same edge
as the top of the next image. Contrast
with tumble duplex printing; see also duplex
printing (2).

SMIT System Management Interface Tool.

SNA Systems Network Architecture.

spiral binding
A type of book binding in which wire or
plastic coils are threaded through a series
of holes or slots in the binding edge.
Contrast with edition binding, perfect
binding, and wire-o binding.

spot color
Individual colored inks formulated to
exactly match a specified color. Spot color
is used when CMYK process color cannot
produce a reasonable facsimile of the
color or when vivid color is needed. Spot
color is also used when fluorescent or
metallic colors are needed.

spread
In color printing, an area whose
dimensions have been enlarged to
eliminate white space between it and
another color. Contrast with choke.

start sheet
The sheet of paper, blank or otherwise,
that can precede a job. See also auxiliary
sheet.

state Synonym for object state.

stripping
The process of mechanically assembling

film into plate layouts. Page imposition
takes place during stripping.

subnet mask
A bit template indicating which part of an
IP address represents the network. A 1 in
the subnet mask means that the
corresponding bit in the IP address is part
of the network address; a 0 means that it
is not. For example, if the IP address is
9.99.12.137 and the subnet mask is
255.255.255.0, the network address is
9.99.12.0.

subnetwork
Any group of nodes that have a set of
common characteristics, such as the same
network ID.

In the AIX operating system, one of a
group of multiple logical divisions of
another network, such as can be created
by TCP/IP.

subtractive color system
A system that reproduces an image by
mixing (adding) appropriate quantities of
cyan, magenta, and yellow paints on
white paper. These paints reflect certain
colors and absorb—or subtract—others.
Contrast with additive color system.

superuser
Synonym for root user.

supported
In InfoPrint, pertaining to the specific job
attribute values that the actual destination
can accept during job validation. InfoPrint
validates the requested attribute values of
the job against the supported attribute
values of the actual destination to
determine whether the actual destination
can handle that job. Contrast with
requested.

synchronous
Occurring with a regular or predictable
time relationship to a specified action.
Contrast with asynchronous.

system administrator
Synonym for administrator.

System Management Interface Tool (SMIT)
In the AIX operating system, an interface
tool for installation, maintenance,
configuration, and diagnostic tasks. SMIT
lets you perform tasks without entering
any commands.
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Systems Network Architecture (SNA)
The description of IBM’s logical structure,
formats, protocols, and operational
sequences for sending units through, and
controlling the configuration and
operation of, networks.

T

table reference character (TRC)
An optional control character in a print
data set. The TRC identifies the font used
to print the record and can be used to
select a font during printing.

Tagged Image File Format (TIFF)
A digital format for storing scanned
images. TIFF files are also referred to as
raster format files (as opposed to vector
format files). When used in desktop
publishing, TIFF files produce only a
low-resolution FPO image; the
high-resolution data remains on the hard
disk.

task help
A type of online help that provides a list
of tasks that can be completed with a
selected object. When you select a task,
the help provides step-by-step
information about how to complete the
task.

TCP/IP
Transmission Control Protocol/Internet
Protocol.

TCP/IP-attached printer
A printer device attached to an RS/6000
computer through telecommunication
lines using the TCP/IP protocol.

In InfoPrint, a PSF physical printer that
represents a TCP/IP-attached printer
device. See also AIX-attached printer,
direct-attached printer, and
upload-TCP/IP-attached printer.

template
In the InfoPrint Manager Administration
GUI, an object that represents a set of
default attribute values that has been
defined for creating a particular type of
object, such as an actual destination.

ticket See job ticket.

TIFF Tagged Image File Format.

Transmission Control Protocol/Internet Protocol
(TCP/IP)

A set of communication rules used in the
Internet and in any network that follows
the U.S. Department of Defense standards
for inter-network protocol. TCP provides
a reliable host-to-host protocol between
hosts in packet-switched communications
networks and in interconnected systems
of such networks. It assumes that the
Internet Protocol (IP) is the underlying
protocol. See also Internet Protocol.

trapping
In desktop publishing, the amount of
overlap in overprinting colors. Trapping
prevents white paper showing through
gaps caused by normal errors in
registration. On sheet-fed presses,
trapping is usually 0.25 point. See also
choke and spread.

TRC Table Reference Character.

TrueType font (TTF)
A font format based on scalable outline
technology with flexible hinting. Glyph
shapes are based on quadratic curves. The
font is described with a set of tables
contained in a TrueType Font File.

TTF TrueType font.

tumble
In InfoPrint, the value of the document or
actual destination plex attribute indicating
that output images are placed on the
media in a head-to-toe format, so that the
top of one image is at the same edge as
the bottom of the next image. The
document must be printed on both sides
of the paper. Contrast with simplex.

tumble duplex printing
Printing on both sides of the paper,
placing output images on the media in a
head-to-toe format, so that the top of one
image is at the same edge as the bottom
of the next image. Contrast with simplex
printing (2), duplex printing (2).

U

UCR Under color removal.

under color removal (UCR)
Conversion of neutral color areas to black
ink that reduces use of CMY inks,
improves trapping, and reduces setup
time. Generally, UCR is performed during
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image scanning, but some RIPs perform it
during processing. Synonymous with gray
component replacement (GCR).

unmanage
In the InfoPrint Manager Administration
GUI, the action used to put an object into
a mode where its icon does not reflect the
changes of status for the object.

upload printer
See upload-TCP/IP-attached printer.

upload-TCP/IP-attached printer
In InfoPrint, a PSF physical printer that
represents a printer device attached
through an MVS system and managed by
PSF/MVS. InfoPrint communicates with
the MVS system through the TCP/IP
network. See also AIX-attached printer,
direct-attached printer, and TCP/IP-attached
printer.

V

validate
In InfoPrint, to compare the attribute
values requested by a job with the
supported attribute values of the actual
destinations in the system and to
determine whether there is an actual
destination capable of printing or sending
the job.

value A specific characteristic of an attribute.

variable
A name used to represent a data item
whose value can change while the
program is running.

variable data
Data that can be changed between copies
of a document. For example, a form letter
(constant data) can be merged with
variable data, such as a customer’s name
and address to produce personalized
documents.

varnish
A protective layer applied to a finished
sheet, usually for photos, but sometimes
used as a design element because of its
reflective qualities. Varnishes can be
tinted.

vector An absolute coordinate point and line in
space. PostScript files can contain vector
artwork. Vector files are converted to
rasters during the RIP process.

velox A black and white photographic print
made from a halftone negative, to be used
as a proof copy.

vignette
An image with soft, fade-away edges.

Virtual Machine (VM)
An IBM licensed product that manages
the resources of a single computer so that
multiple computing systems appear to
exist.

A virtual data processing system that
appears to be at the exclusive disposal of
a particular user, but whose functions are
accomplished by sharing the resources of
a real data processing system. (T)

Virtual Storage Extended (VSE)
An IBM licensed program whose full
name is the Virtual Storage
Extended/Advanced Function. It is a
software operating system controlling the
execution of programs.

Visual Systems Management (VSM)
In AIX, a type of graphical user interface
that allows system management through
the direct manipulation of objects.

VM Virtual Machine.

VSE Virtual Storage Extended.

VSM Visual Systems Management.

W

web A roll of paper used in web or rotary
printing.

well In the InfoPrint Manager Administration
GUI, an area in a pane that contains a
group of objects related to the objects in
the pane; for example, a queues well in a
servers pane.

what you see is what you get (WYSIWYG)
Refers to the fact that the composite
image displayed on the screen at a
computer workstation has the appearance
of the final printed image.

window
A rectangular area of the screen that you
can move about, place on top of, or pull
under other windows, or reduce to an
icon.

wire-o binding
A continuous double series of wire loops
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run through punched slots along the
binding side of a booklet. Contrast with
edition binding, perfect binding, and spiral
binding.

with-request
In InfoPrint, a document transfer method
where the client transfers the documents
directly to the server. Contrast with
pipe-pull.

workstation
A terminal or microcomputer, usually one
that is connected to a mainframe or to a
network, at which a user can use
applications.

write access
A level of authorization that grants the
ability to modify data.

WYSIWYG
What you see is what you get.

X

X-Windows
A network-transparent windowing system
developed by MIT. It is the basis for
Enhanced X-Windows, which runs on the
AIX Operating System.

xerography
A dry printing process using
corona-charged photoconductive surfaces
to hold latent images that are developed
with a dry toner and then transferred to
paper and fused with heat.

Xstation
A terminal that is connected through a
network to an RS/6000 computer, from
which a user can perform command-line
functions and run X-Windows based
applications.
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